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Getting Started with Dragon 11

Dragon version 11 - What's New for administrators

This section Dragon describes the new administrator fea-
tures of Dragon Version 11.

For the latest information about Dragon, see:http://ww-
w.nuance.com/naturallyspeaking/
http://www.nuance.com

Dragon on the Web

The Nuance Web site (www.nuance.com)
gives you access to many resources, includ-
ing Frequently Asked Questions, usage tips,
customer stories, Customer Service infor-
mation, Technical Support content, and a
detailed comparison between Dragon edi-
tions.

Installing, modifying and upgrading Dragon

and Installation checklists

View information on the different ways to install, mod-
ify, and upgrade Dragon.

Setting up and dictating with Roaming User
Profiles

The Roaming feature lets users dictate with
Dragon from different network locations and
different machines without having to create
and train individual user profiles at each loca-
tion.

Using Dragon in a Citrix Presentation Server envi-
ronment

Dragon supports installation on a Citrix Presentation
Server, enabling users to dictate from workstations that
do not have Dragon installed.

Customizing Vocabularies with the Dragon
Vocabulary Tool

You use the Dragon Voctool to customize a
vocabulary by adding new words and by opti-
mizing the language model.

Adding words,commands, or vocabularies to user pro-
files

You use the nsadmin command line utility and the
Dragon Data Distribution Tool when you want to
make new words, customized vocabularies or new com-
mands available to all user profiles on a particular
Dragon installation.

Using the Convert XML to DAT tool

and the MyCommands Protection Utility

You can make your custom commands more
secure in two ways:

■ Use the Convert XML to DAT tool to con-
vert any XML files of commands to DAT for-
mat.

■ Use the MyCommands Protection Util-
ity to prevent any Dragon users from edit-
ing the commands, you can lock access to
the file.

Using Structured Commands

Dragon Professional, Medical, and Legal include an
extension to Text-and-Graphics commands that let you
to set the values of variables in text blocks based on
voice input.

Dragon 11 system requirements

Dragon 11 is compatible with Windows 7, Win-
dows Server 2008, and Citrix XenApp client
10.x and 11.x with Citrix MetaFrame Pre-
sentation Server 4.5.

http://www.nuance.com/naturallyspeaking/
http://www.nuance.com/naturallyspeaking/
http://www.nuance.com/naturallyspeaking/
http://www.nuance.com/healthcare/products/dragon_medical.asp
http://www.nuance.com/


Dragon version 11 - What's New for administrators

The following table lists details about the new features and charZnges in Dragon 11 in the following categories:

■ Accuracy and speed improvements

■ New User Interface

■ Productivity enhancements

■ Other improved features and changes

Accuracy and speed improvements

Dual-pass recognition

Dragon now automatically detects computers with multiple processors and at least 2 GB of RAM and
improves accuracy by using dual-pass recognition.

Higher audio rates improve recognition

Dragon now uses a 22 kHz sampling rate to improve audio quality and recognition accuracy. Dragon sup-
ports both 11 kHz and 22 kHz sound cards.

See "Store corrections in archive" in the Dragon Help for details.

Reduced training time for recorder-based User Profiles

Thanks to recognition improvements, the minimum reading time required to train Dragon with portable
digital recorders is reduced from 15 to 4 minutes. These improvements save time when a user creates a
new User Profile or adds a device to an existing profile.

See "About using a portable recorder" in the Dragon Help for details.

Open User Profiles dialog box optimized for Roaming

Dragon 11 provides a new default method for displaying Roaming User Profiles in the Open User Pro-
files dialog box, which enables faster display of User Profiles and grouping them into folder structures.
This setting saves time when you use the Roaming feature, and allows for easier navigation and organ-
ization at sites with a large number of Roaming User Profiles and network paths.

Users with Dragon Administrator rights can still configure Dragon to display the classic Open User Pro-
files dialog box.

The new setting shows all directories listed in the Location of User Profile, as shown in this example:



Easier access to recent profiles, shortcuts

■ The Open Recent User Profile menu is improved to show up to 10 recent User Profiles and to give
faster access for large networked Dragon installations. The menu also now includes options to select
an alternate Vocabulary or Dictation Source if they are defined for the User Profile.

■ Also, now you can create Windows Shortcuts to Roaming User Profiles.

Adding directories of Roaming User Profiles to the Acoustic and Language Model Optimizer Scheduler:

Now Dragon users with administrator privileges can schedule Acoustic and Language Model optimization
for User Profiles based on logical directory groupings, such as department or site. Group scheduling was
not possible in prior versions of Dragon because the scheduler only accepted a top-level directory for
processing User Profiles. Now administrators can create subdirectories of User Profiles and schedule
Acoustic and Language Model optimization to all profiles in the subdirectory. See "Schedule Accuracy
Tuning - Select Frequency" in the Dragon Help version 11 for details.

See the Dragon Help version 11 for more information on new ways of displaying Roaming User Profiles
and grouping profiles into folder structures.

../../../Content/create_shortcuts_users_vocs.htm
../../../Content/create_shortcuts_users_vocs.htm
../../../Content/create_shortcuts_users_vocs.htm
../../../Content/create_shortcuts_users_vocs.htm
../../../Content/create_shortcuts_users_vocs.htm
../../../Content/create_shortcuts_users_vocs.htm


New user interface

Redesigned DragonBar and menus

The DragonBar and its menus are redesigned in this release for greater ease of use and to show Text
Control, Recognition Modes, better status messaging, and more. The DragonBar also features a single
visual area for all items that change status as a user works.

Text Control Indicator

The Text Control Indicator shows the current level of dictation, selection, and formatting support. A user

either has Full Text Control (a green checkmark ) or Basic Text Control (a gray checkmark ).
Prior versions of Dragon indicated the current dictation support level with the Select-and-Say indicator

(a green ball ).

Recognition Modes

Recognition Mode indicators display next to the Text Control Indicator to identify Dragon's listening
modes - Normal, Dictation, Commands, Numbers, and Spell Mode.

Here are some other key changes:

Restructured menus

The menus are restructured to be more intuitive and provide easier access to the features a user needs
most. For example, the former NaturallySpeaking menu that contained mostly commands for User Pro-
files (formerly called user files), is now called the Profile menu and focuses more specifically on com-
mands a user can use with their User Profile. The Words menu is renamed the Vocabulary menu and has
all Vocabulary-related commands organized there. The Accuracy Center is moved from the Tools menu
to the Help menu. The following table provides a summary of the new and old menu names in Dragon
11:

Dragon 11 menu name Dragon 10 menu name

Profile NaturallySpeaking

Tools Tools

Vocabulary Words

Modes Words

Audio Sound

Help Help

Redesigned Control menu

Dragon's Control menu is clearer about how a user can display Dragon, such as Docked to Top or Bot-
tom, or Floating, and provides direct access to Dragon Options. Also, the former Close command is now
clearly labeled "Exit Dragon."

See the Dragon Help for more information on the DragonBar, the Text Control indicator, Full Text Con-
trol, Basic Text Control, Recognition modes, Restructured menus, and other changes.



Productivity enhancements

Playback options added to the Text-to-Speech Options

The Text-to-Speech tab of the Options dialog box is renamed Playback/Text-to-Speech and the following
Playback options are added:

■ options to control playback/rewind/fast forward speed (in %)

■ options to control playback/rewind/fast forward volume (in %)

See "The Options dialog box Text-to-speech tab" in the Dragon Help for details.

Other improved features and changes

Selecting a language when installing Dragon version 11

When you install Dragon 11, Dragon installs using the primary language for the product. You cannot
install Dragon using a language that is different than the primary language. For example, when you
install Dragon 11 Professional - English version, Dragon installs using the English language.

If you attempt to use the /l option with setup.exe to install Dragon 11 using a non-primary language,
the installation process uses the primary language for that edition of Dragon and ignores the /l option.

Upgrading user profiles to Dragon version 11

Dragon 11 supports upgrading user profiles from versions 9, 9.1, 9.5, 9.6, 10.0, 10.1 and 10.2. A user
cannot upgrade user profiles from earlier versions of Dragon to Dragon 11.

A user updates user profiles after Dragon 11 is installed on a computer.

After installing Dragon 11, in the Open User profile dialog box, if a user selects a user profile that needs
to be updated, Dragon displays a dialog that gives the user the option of upgrading the user profile now
(by pressing OK) or upgrading the user profile later (by pressing Cancel).

If the user selects OK, Dragon displays the User Profile Upgrade Wizard which lets the user select a des-
tination for the upgraded profiles and start the upgrade process.

When a user upgrades a user profile, if DRA data is available for the user profile, the data is processed
during the upgrade. The total amount of data that is processed is equivalent to 30 minutes of data or
less, depending on how much data is available. The upgrade process will try to use the latest 30 minutes
of data.

The User Profile Upgrade Wizard provides users with the opportunity to schedule acoustic optimization.
This allows additional DRA data beyond the initial 30 minutes, to be processed. The User Profile
Upgrade Wizard updates one user profile at a time.

If the user upgrades user profiles from Dragon version 10, and the profiles contain AUS, IND and SEA
acoustic models, the upgrade process maps the vocabularies from UK English to the appropriate dialect-
specific vocabulary.

Controlling updates to the acoustic model of a user profile

Dragon 11 includes the Save acoustic information option in the Roaming tab of the Administrative
Setting dialog.



A user selects the Save acoustic information option to make sure that their acoustic information is
saved along with their local User Profile. By saving the acoustic information, the user ensures that any
corrections they make will be available after they close and re-open the User Profile. This option also
makes sure that these corrections will be synchronized between the Local and Master Roaming User Pro-
file if the user also enables the Always copy acoustic information to network option

This option is turned on by default

If a user is dictating on a computer that is experiencing audio issues, the user can disable the Save
acoustic information option. The .usr and .sig files, created during the dictation session on a com-
puter, are not saved. When an administrator runs the ACO on the master user profile, the user profile is
not updated with the 'non-optimal' acoustic data from the dictation session.

If the Save acoustic information option is always enabled, different .usr and .sig files will exist on
each computer the user dictates on. Dragon will behave differently one each of those computers. This
will be the case until an administrator runs ACO on the master user profile.

The Save acoustic information option is only available when the Roaming feature is enabled. The
Save acoustic information option applies to Roaming User Profiles and Roaming User Profiles that
the user opens directly from the local cache (For example, in disconnected mode when the master loca-
tion is not available).

The Save acoustic information option does not apply to non-Roaming User Profiles that the user
opens when the Roaming feature is enabled.

A user can open non-Roaming User Profiles when the Roaming feature is enabled if the administrator
has enabled opening of local profiles.

The Save acoustic information option does not effect the saving of vocabularies. The user can per-
form vocabulary optimization operations, such as adding and deleting words, changing word properties,
etc. Dragon saves these changes to the local cache and then up loads the changes to the master user
profile.

See How Dragon Synchronizes Master and Local Roaming User Profiles for more information on what
happens during synchronization between Master and Local Roaming user profiles.

See Setting and selecting Roaming User Profile options for more information about options you can set
to copy acoustic data to the network.

Enabling the QuickStart feature when installing Dragon 11

Users set the QuickStart feature of Dragon after they install Dragon on a computer.

You can no longer enable the QuickStart feature when you install Dragon 11. The installation wizard no
longer includes an option for enabling this feature.

See Installing Dragon on a single machine for more information on installing Dragon.

See Additional Options for Silent Installations for more information on options you can set for a silent
installation of Dragon.

See MSI Options Specific to Dragon for more information on options you can set for an MSI installation
of Dragon.



Using two acoustic models with a user profile

If the computer that a user dictates on meets certain system requirements, Dragon 11 , will use two
acoustic models (instead of one) with a user profile. Using two acoustic models instead of one increases
recognition and dictation accuracy. Acoustic models that can be added in pairs to a user profile are Best-
Match IV models.

See Using multiple acoustic models with a user profile for more information.

New Options setting, Require "Click" to select hyperlinks

By default, in Dragon 11, a user must say "Click" and the name of a hyperlink to open it. For example,
on a Web page with a link for "Directions," a user says "click directions." This change prevents inad-
vertent selection of hyperlinks by voice. The "Require Click" option is on by default for hyperlinks in
Dragon 11.

See "Require "Click" to select hyperlinks" in the Dragon Help for details.

Administrative Settings always enabled

Dragon now keeps the Administrative Settings command available even when a User Profile is open. In
Dragon 11, when a user chooses Tools > Administrative Settings, if a User Profile is open Dragon
offers to close it so that the user can continue to the Administrative Settings dialog box. In Dragon 10,
the Administrative Settings command was greyed out and unavailable when a User Profile was open.

Using the Commands Only vocabulary and the Empty Dictation Vocabulary in Dragon 11

Dragon 11 does not include the Commands Only Vocabulary.

You cannot upgrade user profiles from Dragon versions 9 or 10 that use the Commands Only Vocabulary
to Dragon 11 unless a Commands Only vocabulary has already been installed using the Vocabulary
installer.

You cannot upgrade user profiles from editions earlier than Dragon Professional, Legal, and Medical ver-
sions 9 or 10 that use the Empty Dictation Vocabulary to Dragon 11.

No Username and password required for Accuracy Tuning and Data Collection

In Dragon 11 the Accuracy Tuning and Data Collection features no longer require a Windows username
and password to work. Scheduling Accuracy Tuning will help Dragon learn from the user and make dic-
tation more accurate, and if the user chooses to participate in the Data Collection program, the user can
help make future versions of Dragon more accurate. Remember to schedule them for a time when the
computer will be turned on, all user profiles are closed, and Dragon is not on. Make sure any Roaming
user profile data is saved to the master Roaming User Profile before the ACO runs.

See "Accuracy Tuning and Data Collection" in the Dragon Help for details.

Scheduling Accuracy optimization, Tuning, or data collection

Default schedules for Accuracy, Tuning, and Data Collection tasks are now set during the Dragon 11
installation process. The tasks are scheduled to run at the default times.

This means that these tasks are always scheduled.

A user's ability to set task schedules when they create a user profile depends on how the Let the user
choose when to run Accuracy Tuning and Data Collection option is set during a custom Dragon
installation.



If the Let the user choose when to run Accuracy Tuning and Data Collection option remains
checked (the default), after Dragon installs, users will be able to set task schedules when they create a
user profile. If the option is unchecked, users will not be able to set task schedules when they create a
user profile.

Australian, Indian, and Southeast Asian vocabularies

In Dragon 11, Australian (AUS), Indian (IND), and Southeast Asian (SEA) vocabularies are separate
“languages” with dialect-specific acoustic models and dialect-specific vocabularies.

See Using Australian, Indian and Southeast Asian in Dragon 11 for more information on updating 9.x
and 10.x user profiles that contain AUS, IND and SEA acoustic models to Dragon 11.

Teens Vocabulary is now an Acoustic Model

Dragon 10 contained a vocabulary called the Teens vocabulary. In Dragon 11, the Teens vocabulary is
now an acoustic model.

In Dragon 11, when a user selects the '13 or under' age group and selects the US English vocabulary in
the Profile Creation wizard, the Teens acoustic model is associated with the new use profile.

When you upgrade a 9.x or 10.x user profile, that uses the Teens vocabulary, to Dragon 11, the upgrade
maps the Teens vocabulary to the Teens acoustic model in Dragon 11 and the US English vocabulary.

Using multiple acoustic models with a user profile

If the computer that a user dictates on meets certain system requirements, Dragon 11 , will use two acoustic
models (instead of one) with a user profile. Using two acoustic models instead of one increases recognition and
dictation accuracy. Acoustic models that can be added in pairs to a user profile are BestMatch IV models.

If you add a dictation source to a user profile that uses two BestMatch IV models, the dictation source will be
associated with the two models.

A user profile with two BestMatch IV models uses more computer resources, including RAM, than a user profile
with one acoustic model. Dragon 11 will only use two BestMatch IV models on a multi-core computer with at
least 2 GB of RAM. Dragon 11 recognizes when it is installed on a computer that meets these system require-
ments.

Dragon 11 does not provide multiple acoustic models for the following models/regions:

■ Teens Vocabulary (11k and Bluetooth)

■ United Kingdom, Australia (Bluetooth)

■ Indian Subcontinent, Southeast Asia (11k and Bluetooth)

Acoustic Optimization for User Profiles with multiple acoustic models

If a user profile includes BestMatch IV models, you must run the Acoustic and Language Model Optimizer (ACO)
on a machine with multi-core processors. Dragon 11 will only use two BestMatch IV models on a multi-core com-
puter with at least 2 GB of RAM.



If the ACO processes a user profile that was created on a machine with multi-core processors, the optimizer
always selects the BestMatch IV models to optimize.

If a user profile is associated with BestMatch III models without accents, and you run the optimizer on a
machine that supports BestMatch IV models, if automatic acoustic model selection is enabled, the optimizer will
automatically choose a BestMatch IV model to optimize.

There are no BestMatch IV models for accents at this time

Multiple acoustic models and user profiles on single and multi-core computers

If a user creates a user profile on a multi-core machine, when the user opens the user profile on a single-core
computer, Dragon uses the first acoustic model for recognition. Dragon does not load the second acoustic
model.

If a user creates a user profile on a single-core computer, when the user opens the user profile on a multi-core
computer, Dragon uses the single acoustic model for recognition.

If a user selects BestMatch IV models for a user profile and trains the profile on a multi-core computer, when
the user opens the user profile on a single-core computer, Dragon displays the following warning message:

"Your computer has a single core processor. You have opened a user profile created on a computer with a multi-
core processor.
NaturallySpeaking will work normally on this machine but you may see some change in performance and accu-
racy."

Multiple acoustic models and upgrading user profiles

During a user profile upgrade on a single-core computer, if a user selects a BestMatch IV acoustic model instead
of a BestMatch III model, Dragon displays a message when the upgrade process begins.

See Dragon version 11 - What's New for administrators for more information on new and updated features in
Dragon 11.

Using Australian, Indian, and Southeast Asian vocabularies in Dragon 11

In Dragon 10, Service Pack 1, Australian, Indian and Southeast Asian were implemented as dialects, or
“Accents”. In Dragon 11, Australian, Indian, and Southeast Asian vocabularies are separate “languages” with
dialect-specific acoustic models and dialect-specific vocabularies.

In the Dragon 11, a user selects one of the following options in the Region section of the Profile Creation wiz-
ard.

■ Australia

■ Indian Subcontinent

■ Southeast Asia



Language Region Accent

English United

States
■ Standard

■ Australian accented
English

■ British accented
English

■ Indian accented
English

■ Inland Northern US
(Great Lakes area)

■ Southeast Asian
accented English

■ Southern US

■ Spanish accented
English

English Canada
■ Standard

■ Australian accented
English

■ British accented
English

■ Indian accented
English

■ Inland Northern US
(Great Lakes area)

■ Southeast Asian
accented English

■ Southern US

■ Spanish accented
English

English United King-

dom
■ Standard

■ Australian accented
English

■ Indian accented
English

■ Southeast Asian
accented English

n/a Australia n/a

n/a New Zealand n/a



Language Region Accent

n/a Indian Sub-

continent

n/a

n/a Southeast

Asia

n/a

Upgrading user profiles older than Version 10.0 Service Pack 1 to Dragon 11

When you upgrade Dragon 9.x user profiles and Dragon 10.0 profiles (prior to Service Pack 1) that contain AUS,
IND, and SEA acoustic models, the upgrade maps the vocabularies directly to the same models and vocab-
ularies in Dragon 11.

The following table shows the vocabulary mappings for this upgrade scenario:

Dragon 9.x Acoustic Model Dragon 11 Acoustic Model Dragon 11 Vocabulary

Australian English | Bluetooth 8

kHz

Australian English | Bluetooth

8 kHz

Australian English | Large

| General

Australian English | BestMatch Australian English | BestMatch

III/IV

Australian English | Large

| General

Indian English | Bluetooth 8 kHz Indian English | Bluetooth 8

kHz

Indian English | Large |

General

Indian English | BestMatch Indian English | BestMatch

III/IV

Indian English | Large |

General

SE Asian English | Bluetooth 8

kHz

Southeast Asian English | Blue-

tooth 8 kHz

Southeast Asian English |

Large | General

SE Asian English | BestMatch Southeast Asian English | Best-

Match III/IV

Southeast Asian English |

Large | General

UK English | BestMatch UK English | BestMatch III/IV UK English | Large | Gen-

eral

UK English | BestMatch III UK English | BestMatch III/IV UK English | Large | Gen-

eral

UK English | Bluetooth 8 kHz UK English | Bluetooth 8 kHz UK English | Large | Gen-

eral



Upgrading user profiles newer than Version 10.0 Service Pack 1 to Dragon 11

When you upgrade Dragon 10.0 SP1 or later user profiles that contain AUS, IND and SEA acoustic models as
“accent models”, the upgrade process maps the vocabularies to the appropriate dialect-specific vocabularies in
Dragon 11.

The following table shows the vocabulary mappings for this upgrade scenario:

Dragon 10 Acoustic Model Dragon 11 Acoustic Model Dragon 11 Vocabulary

UK English | Bluetooth 8 kHz |

Australian accented English

Australian English | Bluetooth

8 kHz

Australian English | Large

| General

UK English | BestMatch | Aus-

tralian accented English

Australian English | BestMatch

III/IV

Australian English | Large

| General

UK English | Bluetooth 8 kHz |

Indian accented English

Indian English | Bluetooth 8

kHz

Indian English | Large |

General

UK English | Bestmatch | Indian

accented English

Indian English | Best-

matchIII/IV

Indian English | Large |

General

UK English | Bluetooth 8 kHz |

SE Asian accented English

Southeast Asian English | Blue-

tooth 8 kHz

Southeast Asian English |

Large | General

UK English | BestMatch | SE

Asian accented English

Southeast Asian English | Best-

Match III/IV

Southeast Asian English |

Large | General

UK English | BestMatch UK English | BestMatch III/IV UK English | Large | Gen-

eral

UK English | BestMatch III UK English | BestMatch III/IV UK English | Large | Gen-

eral

UK English | Bluetooth 8 kHz UK English | Bluetooth 8 kHz UK English | Large | Gen-

eral

Note: Two-pass models are not provided for the AUS, IND, and SEA languages.

■ Teens/Kid (11k and Bluetooth)

■ UK, AUS (Bluetooth)

■ IND, SEA (11k and Bluetooth)

See Dragon version 11 - What's New for administrators for more information on Two-pass models.

See Choosing a Medical Vocabulary to Support Your Specialty for information on Dragon vocabularies and choos-
ing a vocabulary that matches your medical specialty.



Installing, modifying and upgrading Dragon

To install Dragon NaturallySpeaking or Dragon Medical:

1. Be sure your systems meet the system requirements.

2. Prepare for the installation or upgrade.

3. Install or upgrade the software by choosing the type of installation in the table and linking to the cor-
responding instructions.

4. View the Version 11 file structure and carry out other post installation tasks.

Note: When you install Dragon 11, Dragon installs using the primary language for the product. You cannot
install Dragon using a language that is different than the primary language. For example, when you install
Dragon 11 Professional - English version, Dragon installs using the English language.

If you attempt to use the /l option with setup.exe to install Dragon 11 using a non-primary language, the instal-
lation process uses the primary language for that edition of Dragon and ignores the /l option.

For information on: See:

Installation checklists Installation
checklists

System requirements System
requirements

Preparing for an installation or upgrade Preparing for
an installation
or upgrade

Installing on a single machine

This topic describes the basics steps for installing Dragon on a single machine.

It covers both a Typical/Complete installation and in a Custom installation, some-
times linking you to further detail in another topic.

Installing on a
single
machine

Installing using the Windows Installer (MSI)

Dragon includes a native Windows Installer (MSI) that lets you customize your instal-
lations as well as install across a network to multiple client machines. In addition, you
use this service to modify, repair, or remove an existing Dragon installations.

Using the Win-
dows Installer
(MSI) to
install Dragon

Upgrading from a previous version

You can upgrade to Version 11 from Dragon NaturallySpeaking Versions 9.x and 10.x.
See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New
for administrators for more information.

Upgrading
from a pre-
vious version

View Dragon Version 11 file structure and carry out post installation tasks Post Instal-
lation Tasks



Preparing for an installation or upgrade

Before installing, modifying, or upgrading Dragon NaturallySpeaking or Dragon Medical:

■ Close all open applications.

■ Turn off or disable any antivirus software; installation can sometimes trigger a false virus report.

■ Look at the supplied Installation Checklist.

Installation restrictions

■ Be sure your system meets the hardware requirements before attempting to install Dragon. See Dragon 11
system requirements

■ Administrator rights are not required to create a user profile or use the software after installation.

■ These restrictions also apply to an upgrade installation: On Windows XP Professional, Vista, and Windows 7, if
as administrator you want to create a Dragon user profile for a Windows limited user (with restricted priv-
ileges), you must log on to Windows using that limited user account, then create the Dragon user profile. If
you create a Dragon user account for a Windows limited user while logged in as a Windows administrator, the
limited user will not be able to access that user account.

■ Dragon is licensed on a “per individual” basis. You are permitted to install the software on more than one com-
puter (for example, on a desktop and a laptop computer, or on a work and a home computer), but you cannot
use the software concurrently on more than one computer.

You are permitted to create multiple user profiles, so long as each user profile is for a single individual. If
someone else wants to create or use another user profile, however, that person must purchase a separate
license for Dragon.

Volume license agreements are available.

File Structure

Upgrading from Dragon NaturallySpeaking Version 9.x or 10.x automatically relocates some NaturallySpeaking
directories and files.

For information, see Version 11 File Structure.

Installation checklist

Installation checklist

Do all of your workstations meet the recommended system requirements for Dragon? (Not applicable if you
are running Dragon on a Citrix server; see Citrix Checklist below.)

Will you install the Dragon software manually at each computer or will installation be unattended? (If the
latter, read Installing, modifying, and upgrading Dragon for information on setup or MSI command-line param-
eters. Your answers to all of the installation questions are implemented through setup parameters.)

Which features will you install on each computer?

Which vocabularies do you need to install on each computer?



Note: Installing only selected vocabularies makes a significant improvement in disk space con-
sumption and setup time. A full installation with all vocabularies uses about 2500 MB and takes
about 20 minutes, while an installation with only one vocabulary uses less than 500 MB and takes
about 5-10 minutes. See Dragon 11 system requirements for more information on disk size require-
ments.

Will you install the tutorial (recommended)?

Will you install the text-to-speech component?

Will you set up roaming user profiles? (Read Setting up and dictating with Roaming User Profiles)

If so, where will you place the user profiles?

In a shared network directory?

In multiple shared network directories? (for example, one per department or clinic)

In each user’s home directory?

Note: Placing each user’s profile in his or her home directory is not highly rec-
ommended, because this makes it more difficult for the administrator to perform oper-
ations on multiple user profiles, such as running the Acoustic and Language Model
Optimizer or upgrading user profiles to a new version.

On an Internet server running WebDAV (HTTP roaming)?

If not, what location will you designate as the backup directory for each user profile?

Where will you place the data distribution directory for distributing word lists and command
sets?

Will you be collecting data for the acoustic optimizer?

Will you restrict users from modifying commands and vocabularies?

Which default user-specific options will you set at installation time? (See the Dragon Help on
the Options dialog.)

Note: Here are some additional considerations in user profile placement. Each user profile uses at
least 25-30 MB. With default settings, acoustic optimizer data can take up to an additional 100 MB
per workstation, to a total of 500 MB in the master Roaming User Profile (more precisely, 100 MB
per dictation source per workstation, 500 MB per dictation source per master Roaming User Pro-
file). Acoustic optimizer data contains text and audio data that can be read or heard by anyone with
access to the user profiles.



Upgrade checklist

Are there user profiles that need to be upgraded from a previous version?

If so, will an administrator upgrade them or will each end user upgrade his/her own?

Citrix checklist

Will you be running Dragon on a client or a server system?

If you will be running Dragon on a Citrix client, do you fully understand the impact this will have on func-
tionality? See tech note 5543 in the Nuance knowledge base at
http://nuance.custhelp.com/app/answers/list/p/17/

If you will be running Dragon on a Citrix server:

Are all of your Citrix client systems running XP, Vista, or Windows 7?

Have you or your Citrix administrator read Using Dragon in a Citrix Presentation Server envi-
ronment?

Support Checklist

Who will be responsible for running the Acoustic and Language Model Optimizer?

Who is responsible for collecting word lists and commands?

Who is responsible for distributing word lists and commands?

Will words and commands be distributed through the data distribution directory or by some other means
(such as email)?

Who will Dragon users contact if they need help?

Dragon system requirements

During the installation process, the software checks that your system meets the following requirements. If they
are not met, Dragon will not be installed. Note that at least 1 GB of RAM is required for installation in Windows
Vista and Windows XP and at least 2 GB of RAM are required for other supported operating systems. See Oper-
ating systems and RAM, below.

Note

This edition of Dragon does not support dictation directly into Electronic Medical Record (EMR) Systems. For
EMR support, please use Dragon Medical Edition.



Processor

Minimum

Intel® Pentium® 1 GHz or equivalent AMD processor or 1.66 GHz Atom® processor (SSE2 instruction set
required).

Recommended

Intel Pentium 2.4 GHz (dual 1.8 GHz core processor) or equivalent AMD processor.

Faster processors produce faster performance.

Note

Streaming SIMD Extensions (SSE) are not supported.

Processor cache

Minimum: 512 KB

Recommended: 2 MB

Operating systems and RAM

Operating system 32-bit 64-bit
RAM

Minimum Recommended*

Windows 7 √ √ 2 GB 4 GB

Windows XP Home (SP2 or
higher)

√ X 1 GB 2 GB

Windows XP Professional
(SP2 or higher)

√ X 1 GB 2 GB

Windows Vista, including
SP1 and SP2

√ √ 1 GB 2 GB

Windows Server 2003 (SP2
or higher)

√ √ 2 GB 4 GB

Windows Server 2008, includ-
ing SP1 and SP2

√ √ 2 GB 4 GB

Note: Windows 2000, Windows 2000 Server, and Windows XP 64-bit are not supported and installation is
blocked on those systems.

Note

* If your computer has less than the recommended RAM, Dragon will install but displays a message rec-
ommending that you install additional RAM for optimum performance.

Free hard disk space

■ 2.5 GB minimum for a custom installation where you install only the program files and 1 set of user profiles.
Installations can range from 800 MB (US English Standard Edition) to 2.5 GB (US English Medical Edition).



■ 2.8 GB minimum for non-English versions.

Microphone

23. Nuance-approved noise-canceling headset microphone. For a complete listing of Dragon-compatible audio input

devices, visit http://support.nuance.com/compatibility on the Dragon Support Web pages.

Note: Dragon Edition has built-in support for the Dictaphone PowerMics. For more information, see the following

topics in the Dragon Help:

■ Using the Dictaphone PowerMic (the beige PowerMic)
Only newer beige PowerMics work with Dragon Edition on Windows Vista.

■ Using the Dictaphone PowerMic II (the black PowerMic)
PowerMic II packaging should display Vista compliance labeling. If you are unsure about the compatibility,
confirm that the firmware version is v. 2.02 or higher. Refer to http://ww-
w.nuance.com/naturallyspeaking/medical/powermic/

24. For Bluetooth microphones, Tablet PCs, and other hardware, visit http://support.nuance.com/compatibility.

Sound card

Sound card capable of supporting 22 kHz 16-bit audio recording.

Citrix

Citrix Client Citrix Server Operating system

3-
2-
-
bit

6-
4-
-
bit

Citrix ICA client 8.x or
9.x

■ Citrix MetaFrame
Presentation Server
3.0 or 4.0 (Enter-
prise and Advanced
Editions)

■ Standard Edition is
not supported

■ Windows 2000 Serv-
ice Pack 4 or higher

■ Windows XP Pro-
fessional

■ Windows XP Home
(with SP1 or SP2)

√ X

Citrix XenApp client
10.x

Citrix MetaFrame Pre-
sentation Server 4.5

Windows Server 2003 √ √

Citrix XenApp client
11.x

Citrix MetaFrame Pre-
sentation Server 4.5

Windows Server 2003 √ √

Citrix XenApp client
11.x

Citrix XenApp 5.0
server

Windows Server 2008 √ √

Note: The Smooth roaming feature is not supported on Windows Server 2008.

http://support.nuance.com/compatibility
http://www.nuance.com/naturallyspeaking/medical/powermic/
http://www.nuance.com/naturallyspeaking/medical/powermic/
http://www.nuance.com/naturallyspeaking/medical/powermic/
http://support.nuance.com/compatibility


To download the latest patches and updates for the Citrix XenApp client and the Citrix Presentation Server, visit
http://www.citrix.com.

Other requirements

■ Microsoft® Internet Explorer 6 or higher (free download available at www.microsoft.com)

■ DVD-ROM drive required for installation.

■ Speakers (optional for playback of recorded speech and text-to-speech features).

■ An Internet connection for product activation.

Storage space required for user profiles

Adequate storage space must be available for user profiles that store information about each particular user’s
speech patterns. The space needs to exist on:

■ Stand-alone installations where users work on dedicated machines.
AND

■ (Only if you have Roaming User Profiles) Central machines (sometimes servers) where Master Roaming User
Profiles are stored.

Having Roaming User Profiles lets providers run Dragon on more than one machine or device by accessing cen-
trally stored provider-specific voice and speech information, rather than requiring that the voice information be
on each machine.

These are guidelines only and not definitive specifications—actual size will vary from site to site.

For each Master Roaming User Profile (user profiles stored on the central machine), you should plan to have
this much space:

■ 25 MB for each set of Roaming User Profiles

■ 8 MB for each additional vocabulary you add for this user profile

■ 18 MB for each additional dictation source you add for this user profile

■ 500 MB for acoustic optimizer data associated with each dictation source of each user profile

To set how much data is stored:

1. On the DragonBar, select Tools > Administrative Settings.

2. When the Administrative Settings dialog box opens, check the Disk space reserved for network
archive option.

In addition, for the Local Roaming User Profile, you should plan to have the following space on each PC where
the user dictates:

■ 25 MB for each set of Roaming User Profiles

■ 8 MB for each additional vocabulary you add for this user profile

■ 18 MB for each additional dictation source you add for this user profile

■ 240 MB for acoustic optimizer data associated with each dictation source of each user profile

http://www.citrix.com/
http://www.microsoft.com/


How much acoustic optimizer data is retained locally is controlled by settings on the Data tab of the Options
dialog box:

1. To set the number of minutes of audio to retain locally, click the Archive size... button and position the
slider.

2. To turn off retaining this data locally, check the Conserve disk space required by User profile (for port-
ability) option.

For each non-Roaming User Profile, you should plan on approximately twice as much space as a Local Roaming
User Profile, because Dragon periodically makes a backup copy of the profiles and stores it on the same
machine. The product does not back up Roaming User Profiles this way as they are located on a central machine
that your Information Technology department should back up regularly.

Installing on or Upgrading to Windows Vista

Dragon NaturallySpeaking and Dragon Medical Versions 9.5 and higher are compatible with all editions of Win-
dows Vista.

Earlier version of Dragon (version 8.x, 9.0, 9.1) will not install or run on Windows Vista.

Upgrade considerations

If you upgrade a machine from a previous version of Windows to Windows Vista and that machine has Version
8.x, 9.0, or 9.1 of Dragon installed, that version of Dragon will not work after upgrading to Windows Vista.

All your user profiles from these previous versions remain intact and can be upgraded when you install Dragon
Version 10 or 11.

See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for administrators for
more information.

Roaming User Profiles in an MSI Installation on Vista

For more on carrying out an MSI installation on Windows Vista, see Modifying Roaming User Profile, Mis-
cellaneous, Schedule Settings in the INI File.

Coexistence with other Dragon products

Coexistence with previous versions of Dragon

You can have only one version of Dragon installed on your system.

Note: Running Version 9.x or 10.x concurrently with Version 11 is not supported.

Coexistence with Dragon SDK Client Edition

You can install Dragon SDK Client Edition 10 on the same machine where Dragon 11 is ed. In addition, Dragon
and Dragon SDK Client Edition can share vocabularies and user profiles.

You can run only one product at the same time. For example, if you are running Dragon, you cannot run any of
the Dragon SDK Client tools or samples.

Note: Dragon 11 can coexist with Dragon SDK Client Edition Version 9.x.

Run Dragon SDK Client Edition 9.x on a computer with Dragon 11

You must have administrator privileges to perform the following step. In Windows Vista, make sure to elevate
the command prompt.



At a command prompt, type the following command:

C:\Program Files\Nuance\Dragon SDK Client Edition9.x\Program\natspeak.exe /fixguids

Run Dragon 11 on a computer with Dragon SDK Client Edition version 9.x

You must have administrator privileges to perform the following step. In Windows Vista, make sure to elevate
the command prompt.

At a command prompt, type the following command:

C:\Program Files\Nuance\NaturallySpeaking11\Program\natspeak.exe /fixguids



Installing Dragon on a single machine

This topic presents the basic steps for installing Dragon NaturallySpeaking or Dragon Medical on a single
machine.

For a complete step-by-step procedure of installing Dragon on a single machine, please see the Dragon
Getting Started Guide, available in printed form, or the Dragon User Guide version 11, available on the DVD in
\documentation\enx\UG11.pdf.

Notes:

■ In Dragon 11, you enable the QuickStart feature after you install Dragon, not during the installation process.

■ You must have Windows Administrator rights to install or uninstall Dragon or Dragon Medical on Windows XP,
Windows Vista, or Windows 7. For more on how Administrator rights impact creating Dragon user profiles,
refer to Preparing for an installation or upgrade

■ When you install Dragon 11, Dragon installs using the primary language for the product. You cannot install
Dragon using a language that is different than the primary language. For example, when you install Dragon 11
Professional - English version, Dragon installs using the English language.
If you attempt to use the /l option with setup.exe to install Dragon 11 using a non-primary language, the
installation process uses the primary language for that edition of Dragon and ignores the /l option.

Installing on Windows Vista

For information about installing the product on Windows Vista, refer to Installing or Upgrading to Windows
Vista.

Installing Dragon on a single machine

To install Dragon NaturallySpeaking or Dragon Medical:

1. Insert the first Dragon DVD into your DVD drive.

If the installation does not start automatically, use the Windows Explorer to find and double-click setup.exe
on the DVD.

When you start the installation on Windows Vista, you might see a message saying A program needs your
permission to continue. Click Continue to start the installation.

2. After the Windows Installer begins, it installs software packages (if they are not already installed):
Visual C++ 9.0 Runtime for Dragon

3. After the installation Wizard begins, click Next to proceed to the License Agreement. Read the text of the
agreement and select I accept..., then click Next again.

4. Enter your customer information—User Name and Organization—then the Serial Number supplied to
your Dragon installation.

5. Choose your installation directory. If there are no previous versions of Dragon on your system, the default
directory is:
C:\Program Files\Nuance\NaturallySpeaking11

For a list of directories created by the installation, see Dragon version 11 file structure.



6. Choose your Setup Type:
If you decide not to install some Dragon components by selecting Custom installation, you can install them
later by running the Setup program again and choosingModify.

■ Typical/Complete: Installs all options and user profiles and requires the most disk space.

■ Custom: Lets you select options and user profiles to install. Customizing your installation options can
greatly reduce the disk space required. 

In the Professional and Medical editions, you can modify the following settings during a custom instal-
lation. These settings are applied to all user profiles created with this installation of Dragon, including user
profiles created from Windows XP limited accounts:

■ Modify the application's settings for all users displays the Options dialog box at the end of
the installation. The Options dialog box lets you change the product's standard behavior:

■ Change hot key settings

■ Customize how text is formatted

■ Choose initial microphone settings

■ Set how often your user profiles are backed up

■ Set where you can dictate commands, such as in web pages or other windows

■ Modify the administrative settings displays the Administrative settings dialog box at the end
of the installation. The Administrative settings dialog box lets you:

■ Set up the Roaming feature

■ Set the backup location of your user profiles

■ Restrict users from modifying commands and vocabularies

■ Modify the Auto-Formatting options for all users displays the Auto-Formatting dialog box at
the end of the installation. In this dialog box, you can choose ways that text should be automatically
formatted (such as postal codes in US or UK format) and the number of spaces after a period.

7. Continue following the on-screen instructions. The setup program will install the files for Dragon on your com-
puter.

8. After you click Finish and the installation is complete, if you did a Custom installation one or more of the fol-
lowing windows opens immediately:

■ If you checked off Modify the application's settings for all users, the Options dialog box opens. For
more information on the Options dialog box, see the main Dragon Help file.

■ If you checkedModify the administrative settings, the Administrative Settings dialog box opens.
For more information on setting administrative settings under the Roaming, Miscellaneous, and Sched-
uled Tasks tabs:

■ See Administrative Settings: Roaming tab

■ See Administrative Settings: Miscellaneous

■ See Administrative Settings: Scheduled Tasks

■ If you checkedModify the Auto-formatting options for all users on the Custom Setup page, the
Auto-Formatting dialog box opens. For more information on the Auto-Formatting dialog box, see the
main Dragon Help file.



9. After you click Finish, if you are prompted to restart your computer, restart it now. Otherwise, skip to the
next step.

10. Start the product by selecting Start > All Programs > Dragon NaturallySpeaking 11 > Dragon Nat-
urallySpeaking 11. The DragonBar appears on your desktop.

Activating Dragon

The first time you start Dragon, you will be prompted to activate your copy of Dragon. If you do not activate the
software, Dragon will stop working after you start the product fives times.

For more information on activation, please see the Dragon User Guide version 11.



Sample custom installation of Dragon Medical

This topic shows an example of a typical custom installation of Dragon Medical for the Roaming environment.

Note: This is an example only and is provided to give administrators an overview of a typical installation and
the kind of decisions you have to make. Though the example provides recommendations it is not meant as a sub-
stitute for your own planning.

For more information, see:

1. Installation checklists

2. Installing Dragon on a single machine

3. Step-by-Step Command Line Installation

4. Overview of Pushing Client Installation from Server

Preparing for the Roaming feature

1. Create network storage location for Master Roaming User Profiles. For example, you can create a shared
drive that all Dragon users will have read/write access to. In this example, we'll name this shared folder
Dragon.

2. In the shared Dragon folder, you can create 2 sub-folders; Dragon Profiles and Data Directory.

■ Dragon Profiles is the location for the master copies of the user profiles. (For planning pur-
poses allow for 500 MB per user profile.)

■ Data Directory is the location for custom commands and word lists that automatically update
the user profiles by use of the Data Directory Tool.

For more information, see Setting up the Roaming feature.

Install Dragon Medical

 To install Dragon NaturallySpeaking or Dragon Medical:

1. Insert the first Dragon DVD into your DVD drive or if installing from network drive, click on setup.exe.

2. When you have the option, choose Custom installation. For example:

Custom lets you select options and user profiles to install. Customizing your installation options can greatly
reduce the disk space required. See Choosing Medical Vocabulary to Support Your Specialty for more infor-
mation.

Click Next to continue.

3. On the Additional options screen, select all three options. For example:



Click Next to continue.

Setting the Dragon Options

When the installation is complete, the three customization dialog boxes will open. The first to open is the
Options dialog box.

Corrections tab:

You use this tab to control how the correction feature and spelling features work.

In this example:

■ Check Enable double-click to correct. Selecting this checkbox gives the user a way to correct with the
mouse.

■ Maximize the number of choices that can appear in the Correction menu by setting it to 9.



The Commands tab:

You use this tab to set options that control how Dragon interprets commands. Unless otherwise indicated, chang-
ing these options only affects the current user; any other users keep their existing settings.

The following example shows the default settings:



The View tab:

You use the View tab to control the behavior and appearance of the DragonBar and the Results Box.

In this example, change Auto-hide delay from Never Hide to 5 seconds.



The Hot Keys tab:

You use the Hot keys tab to specify hot key assignments.

If your users will be using Dragon on a Notebook, then click Microphone on/off and hit the F10 key to change
the hotkey.



The PowerMic I and II tabs:

If you are using Dragon and you are using a Dictaphone PowerMic for dictation, the Options dialog box displays
the PowerMic I and II tabs. Dragon has built-in support for PowerMic or PowerMic II microphones. You can use
the PowerMic II microphone buttons to perform predefined actions (described in the table below) or program
the buttons to take custom actions.

The following example shows the default settings for the PowerMic II:



The Playback/Text-to-Speech tab:

You use the Playback/Text-to-speech tab to adjust the attributes of text-to-speech and playback.

In this example, increase the Speed slider slightly. The default value is a little too slow. For example:



The Miscellaneous tab:

You use this tab to set miscellaneous options.

In this example

Leave the Have the microphone on but asleep option unchecked unless the user cannot or does not want to
use their hands to turn the microphone on and off.

Check Automatically save the profile changes to automatically save the user's profiles when Dragon is
closed.

For example:



The Dictation Box tab:

On the Dictation tab, you can define how the Dictation Box operates.

You access the Dictation tab by selecting Tools > Dictation Box from the Dragon menu.

For more information on the Dictation Box, see the Using the Dictation Box topic in Dragon help file.

The following example shows the default settings for the Dictation Box:



The Data tab:

You use the Data tab to instruct Dragon to store corrections in an archive, conserve disk pace for better port-
ability of user profiles, and control how Dragon adapts training, saves recorded dictation, and backs up user pro-
files.

In this example:

■ Set the Save recorded dictation with document option to Never. You may want to set this option in most
cases when using Dragon Medical and definitely when working in AP or EMR applications that only use a text
editor to populate a database.

■ Set the Automatically back up user profile every "n" saves to nothing if your users are using the Roam-
ing feature. When you have a Roaming User Profile, the Master Roaming User Profile most likely resides on a
server that should be backed up every night.

For example:



Setting the Administrative Options: Roaming User Profiles

The second dialog to open at the end of the installation is the Administrative Settings dialog box. This section
describes the Roaming tab of the Administrative options dialog box

You use the Roaming tab of the Administrative Settings dialog box to set up the Roaming feature. You must
set up the Roaming feature on each computer where you want users to dictate with a Roaming User Profile. For
more information, see Administrative Settings: Roaming tab.

In this example:

■ Select Enable to activate the Roaming feature and the Roaming User Profile options.

■ Click the Add button. You use the Roaming User Network Location dialog box to define the network loca-
tion of the master Roaming User Profiles. The location you pick must be accessible to all computers on the net-
work that you want available for dictation with Dragon. In this example, we'll use the network storage
location we initially created. For example:





■ The Administrative Settings dialog box also contains several options that you can choose from to indicate
how you want a Roaming User Profile to function at each Roaming User Profile location.

In addition to the default settings, also enable the Access network at user profile open/close only and
Always copy acoustic information to network options. For example:



Click OK to continue.

■ You will be prompted to create the default directory if it does not already exists, when you see the following
message, always click Yes:



Setting the Administrative Options: Miscellaneous options

When the installation is complete, the three customization dialog boxes will open. The second to open is the
Administrative Settings dialog box. This section describes the Miscellaneous tab of the Administrative options
dialog box

In this example, click Change... to set the location of the Data Distribution Location to the network direc-
tory that you created at the beginning.

Also make sure to deselect the Check for product updates at startup option to disable Dragon from auto-
matically checking the Nuance web site for product updates if you want to control which updates your users can
get.

Setting the Administrative Options: Scheduled Tasks 

When the installation is complete, the three customization dialog boxes will open. The second to open is the
Administrative Settings dialog box. This section describes the Scheduled Tasks tab of the Administrative
options dialog box

The following example shows the default settings for the Scheduled Tasks tab:



For more information, see the Dragon Help file.

Setting Auto-Formatting Options

The third dialog to open at the end of the installation is the Auto-Formatting dialog box. For example, this ver-
sion of the Auto-Formatting dialog box displays when you are using a non-medical Vocabulary:



When you are using a medical Vocabulary, the Auto-Formatting dialog box displays multiple tabs (General, Cap-
italization, Numbers, Units, and Dates, Abbreviations, and Miscellaneous):

■ General Tab—Controls general settings like how number, dates and times, and common number related
abbreviations are formatted. Also on this tab is the option to spell out (expand) English contractions.

■ Capitalization Tab—Controls how Dragon capitalizes dictated words, including medical terms.

■ Numbers, Units, and Dates Tab—Contains rules for formatting numbers and units of measure, including
rules specific to medical topics.

■ Abbreviations Tab—Controls how medical-specific abbreviations are formatted.

■ Miscellaneous Tab—Contains miscellaneous formatting rules.

1. Set the Auto-Formatting options.

2. Click Apply to save your changes and leave the Auto-Formatting dialog box open.

3. Click OK to save your changes in the current tab, close the Auto-Formatting dialog box, and have the
changes take effect. Your changes do not take effect until after you close the dialog box.

Nuance recommends that you review these tabs to make appropriate choices for your site.





Post Installation Tasks

Once you have installed or upgraded Dragon, you might want to carry out some of these tasks before you pro-
ceed:

■ Cleaning up after uninstalling Dragon

■ Viewing the Version 11 File Structure

■ Turning off Dragon's use of Microsoft Active Accessibility Service

■ Choosing Medical Vocabulary to Support Your Specialty (Dragon Medical only)

Cleaning up after uninstalling Dragon

The following files will remain on your machine after you uninstall Dragon NaturallySpeaking or Dragon Medical
:

C:\Windows\Speech

■ VText.dll

■ Vdict.dll

■ WrapSAPI.dll

■ XTel.dll

■ Xcommand.dll

■ Xlisten.dll

■ Xvoice.dll

■ spchtel.dll

■ speech.cnt

■ speech.dll

■ speech.hlp

■ vcauto.tlb

■ vcmd.exe

■ vcmshl.dll

■ vtxtauto.tlb

Dragon installed these files for Microsoft SAPI4 support. If you do not have other speech applications that
require SAPI4, you can safely remove these files manually. If have installed other speech applications that
require SAPI4 support, you may need to re-install those applications if you remove the files.

Dragon version 11 file structure

Upgrading from Dragon NaturallySpeaking version 9.x or 10.x to version 11 will automatically relocate some
Dragon NaturallySpeaking directories and files.



Note: The following directory structures and file locations assume an installation to a default location.

V9.0/V9.1 Windows 2000/XP Pro/XP Home/Windows Server 2003 directory structure

The V9.0/V9.1 directory structure before upgrading to V11:

C:\Program Files\Nuance\NaturallySpeaking9
\Help
\Program
\Tutorial (optional)
C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking9\
\Custom
\Data
\Data\Training
\Users
C:\Documents and Settings\<username>\Application Data\Nuance\NaturallySpeaking9\
\Results

V9.5 Windows 2000/XP Pro/XP Home/Windows Server 2003 directory structure

The V9.5 directory structure on Windows 2000/XP Pro/XP Home/Windows 2000 Advanced Server/Windows
Server 2003 before upgrading to V11:

C:\Program Files\Nuance\NaturallySpeaking9
\Ereg
\Help
\Program
\Tutorial (optional)
C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking9\
\Custom
\Data
\Data\Training
\Users
C:\Documents and Settings\<username>\Application Data\Nuance\NaturallySpeaking9\
\Results

V9.5 Windows Vista directory structure

The V9.5 directory structure on Windows Vista before upgrading to V11:

C:\Program Files\Nuance\NaturallySpeaking9
\Ereg
\Help
\Program
\Tutorial (optional)
C:\ProgramData\Nuance\NaturallySpeaking9\
\Custom
\Data
\Data\Training
\Users
C:\Users\<username>\AppData\Roaming\Nuance\NaturallySpeaking9\
\Results



V10 Windows 2000/XP Pro/XP Home/Windows Server 2003 directory structure

The V10 directory structure on Windows 2000/XP Pro/XP Home/Windows 2000 Advanced Server/Windows
Server 2003 before upgrading to V11:

C:\Program Files\Nuance\NaturallySpeaking10
\Ereg
\Help
\Program
\Tutorial (optional)
C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\
\Custom
\Data
\Data\Training
\Users
C:\Documents and Settings\<username>\Application Data\N-
uance\NaturallySpeaking10\
\Results

V10 Windows Vista directory structure

The V10 directory structure on Windows Vista before upgrading to V11:

C:\Program Files\Nuance\NaturallySpeaking10
\Ereg
\Help
\Program
\Tutorial (optional)
C:\ProgramData\Nuance\NaturallySpeaking10\
\Custom
\Data
\Data\Training
\Users
C:\Users\<username>\AppData\Roaming\Nuance\NaturallySpeaking10\
\Results

V11 Windows XP Pro/XP Home/Windows Server 2003 directory structure

The V11 directory structure on Windows XP Pro/XP Home/Windows Server 2003:

C:\Program Files\Nuance\NaturallySpeaking11
\Ereg
\Help
\Program
\Tutorial (optional)
C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking11\
\Custom
\Data
\Data\Training
\Users
\RoamingUsers
C:\Documents and Settings\<username>\Application



Data\Nuance\NaturallySpeaking11\
\results

V11 Windows Vista directory structure

The V11 directory structure on Windows Vista:

C:\Program Files\Nuance\NaturallySpeaking11
\Ereg
\Help
\Program
\Tutorial (optional)
C:\ProgramData\Nuance\NaturallySpeaking11\
\Custom
\Data
\Data\Training
\Users
C:\Users\<username>\AppData\Roaming\Nuance\NaturallySpeaking11\
\results

Turning off Dragon's use of Microsoft Active Accessibility Service

Dragon NaturallySpeaking and Dragon Medical use Microsoft Active Accessibility Service to let you control cer-
tain menus and dialog boxes by voice. Without Microsoft Active Accessibility Service, you would be unable to
use Dragon to select menu commands and dialog box controls with your voice.

If you don't need to control the menus and dialog boxes by voice, you can speed up Dragon performance by turn-
ing off Microsoft Active Accessibility Services.

To turn off Active Accessibility Services in Dragon for all applications

1. Open the Options dialog box by selecting Tools > Options on the DragonBar.

2. Click the Miscellaneous tab.

3. Clear the Voice enable menus and dialog controls box if it is selected.

4. Click OK. You will need to exit and re-start Dragon for this change to take effect.

To turn off Active Accessibility in Dragon for specific applications

1. Exit Dragon.

2. Open nssystem.ini in a text editor. By default, nssystem.ini is located in

C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking11

3. Under [MSAA Modules Disabled], add a line similar to the following for each application where you want to
disable the use of Active Accessibility Services:

<executable_name>=1

4. Save and close nssystem.ini.

5. Re-start Dragon.

For example, to disable Dragon use of Active Accessibility Services in Microsoft Word and Microsoft Excel, you
would add the following lines to nssystem.ini:



[MSAA Modules Disabled]
winword.exe=1
excel.exe=1

Note: If you do not know the name of an application's executable file, you can start the application from the
Windows Start menu and then use the Windows Task Manager to view the list of current Windows applications.
The executable names are listed under Image Name on the Processes tab. You can also right-click the appli-
cation's icon and select the shortcut tab—the Target field will provide the name of the executable.

Choosing a Medical Vocabulary to Support Your Specialty

If you are using Dragon Medical, you should know which medical vocabulary supports your specialty, so that
you can readily select the correct vocabulary from the list provided.

See Using Australian, Indian and Southeast Asian vocabularies in Dragon 11 for information on upgrading user
profiles that contain Australian, Indian, or Southeast Asian acoustic models to Dragon 11.

The following table correlates Medical specialties with US English and UK English Dragon Medical vocabularies.

US and UK English Dragon Medical

Specialties and the Vocabularies That Support Them

Note: Specialities and Medical Vocabularies marked with a (1) are not available in the Dragon Medical Small
Practice Edition.

Note: The Physical Medicine and Rehabilitation and the Speech and Language Pathology vocabularies not avail-
able in UK English are marked with a (2).

Specialty Medical Vocabulary to Choose

Addiction Psychiatry Addiction Psychiatry

Adolescent Medicine Family Medicine, Internal Medicine, or Pediatrics

Allergy and Immunology Allergy and Immunology

Anesthesiology Anesthesiology

Bariatric Surgery Surgery

Behavioral Health Psychiatry

Blood Banking/Transfusion Medicine Pathology 1

Breast Surgery Surgery

Cardiac Surgery Cardiac Surgery

Cardiology Cardiology

Cardiothoracic Surgery Surgery



Cardiovascular Disease Internal Medicine

Chemical Pathology Pathology 1

Child and Adolescent Psychiatry Psychiatry

Child Abuse Pediatrics Pediatrics

Clinical Cardiac Electrophysiology Cardiology

Critical Care Medicine Anesthesiology or Internal Medicine

Dentistry Dentistry

Dermatology Dermatology

Dermatopathology Pathology 1

Developmental-Behavioral Pediatrics Pediatrics

Diagnostic Radiology Radiology 1

ENT ENT

Ear, Nose, and Throat ENT

EEG Psychiatry

Emergency Medicine Emergency Medicine

EMG Examinations Neurology

Endocrinology Endocrinology Diabetes and Metabolism

Epidemiology Epidemiology

Family Medicine Family Medicine

Fetal Medicine Fetal Medicine

Forensic Pathology Pathology 1

Forensic Psychiatry Psychiatry

Gastroenterology Gastroenterology

General Medicine General Medicine

Geriatric Medicine Geriatric Medicine or Family Medicine

Geriatric Psychiatry Psychiatry

Hand Surgery Hand Surgery or Plastic Surgery

Hematology Hematology



Hospice and Palliative Medicine Pain Medicine, Emergency Medicine, Family Medicine, Inter-

nal Medicine, Pediatrics, or Physical Medicine and Rehabil-

itation 2

Infectious Disease Infectious Disease

Internal Medicine Internal Medicine

Interventional Cardiology Internal Medicine

Medical Education and Writing Medical Education and Writing

Medical Microbiology Pathology 1

Medical Oncology Internal Medicine

Medical Toxicology Emergency Medicine, Pediatrics

Mental Health Addiction Psychiatry, Endocrinology Diabetes and Metab-

olism, Psychiatry, or Psychology

Midwifery Midwifery

Neonatal and Perinatal Medicine Neonatal and Perinatal Medicine

Nephrology Nephrology

Neurodevelopmental Disabilities Pediatrics

Neurology Neurology

Neuromuscular Medicine Physical Medicine and Rehabilitation 2

Neuropathology Pathology 1

Neuropsychology Psychiatry, Neurology

Neurosurgery Neurosurgery

Neurotology ENT

Nuclear Medicine Nuclear Medicine

Nuclear Radiology Radiology 1

Nursing Nursing

Obstetrics and Gynecology Obstetrics and Gynecology

Oncology Oncology

Ophthalmology Ophthalmology

Oral and Facial Surgery Oral and Facial Surgery

Orthopaedic Surgery Orthopaedic Surgery



Osteopathy Osteopathy

Otolaryngology ENT

Pain Medicine Pain Medicine

Pathology Pathology 1

Pediatric Cardiology Pediatric Cardiology

Pediatric Critical Care Medicine Pediatrics

Pediatric Dentistry Pediatric Dentistry

Pediatric Dermatology Dermatology

Pediatric Emergency Medicine Emergency Medicine or Pediatrics

Pediatric Endocrinology Pediatrics

Pediatric ENT Pediatrics

Pediatric Gastroenterology Pediatric Gastroenterology

Pediatric Hematology-Oncology Pediatrics

Pediatric Infectious Diseases Pediatrics

Pediatric Nephrology Pediatrics

Pediatric Otolaryngology ENT

Pediatric Pathology Pathology 1

Pediatric Pulmonology Pediatrics

Pediatric Rehabilitation Medicine Physical Medicine and Rehabilitation 2

Pediatric Rheumatology Pediatrics

Pediatric Surgery Surgery

Pediatric Transplant Hepatology Pediatrics

Pediatric Urology Urology

Pediatrics Pediatrics

Physical Medicine and Rehabilitation Physical Medicine and Rehabilitation 2

Plastic Surgery Plastic Surgery

Plastic Surgery within Head and Neck ENT

Podiatry Podiatry



Proctology Colon and Rectal Surgery

Psychiatry Psychiatry or Addiction Psychiatry

Psychology Psychology

Pulmonary Disease Pulmonary Disease

Radiation Oncology Radiology 1

Radiation Therapy Radiation Therapy

Radiologic Physics Radiology 1

Radiology Radiology 1 or Nuclear Medicine

Rheumatology Rheumatology

Sleep Lab Sleep Lab

Sleep Medicine Family Medicine or ENT

Speech and Language Pathology Speech and Language Pathology 1, 2

Spinal Cord Injury Medicine Physical Medicine and Rehabilitation 2

Sports Medicine Emergency Medicine, Family Medicine, or Physical Medicine

and Rehabilitation

Surgery Surgery

Thoracic Surgery Thoracic Surgery

Transplant Hepatology Internal Medicine

Trauma Surgery Surgery

Undersea and Hyperbaric Medicine Emergency Medicine

Urology Urology

Vascular Surgery Vascular Surgery

Vascular and Interventional Radiology Vascular and Interventional Radiology 1

Enhancing the privacy of patient data

When a user dictates using Dragon Medical, Dragon automatically saves all audio and transcribed text in Dragon
Recorded Audio (.DRA) files. If the user corrects any of the dictated text, Dragon automatically stores these cor-
rections in .enwv files. Both these files are saved in the background.

These automatically created .DRA and .enwv files are used by Dragon to optimize the user profile. For exam-
ple, Dragon uses these files when a user runs the Acoustic and Language Model Optimizer.



Dragon encrypts these automatically created .DRA and .enwv files before storing them in the local or Roaming
User Profile directories to ensure they do not become a back door into patient data and violate the patient's pri-
vacy. These files are also encrypted when a user dictates into a supported application like Microsoft Word or an
Electronic Medical Record (EMR) application.

Due to the restrictions mandated by the HIPAA regulations, these encrypted .DRA and .enwv files can only be
opened by Dragon Medical for its internal use. For example, they cannot be accessed by the non-Medical ver-
sions of Dragon, the Dragon NaturallySpeaking SDK Client Edition (DSC), or the Dragon NaturallySpeaking SDK
Server Edition (DSS). In addition, any encrypted .DRA and .enwv files automatically created by Dragon, can-
not be opened in DragonPad.

Note: Dragon Medical does not encrypt .DRA files explicitly saved by a user. For example, if a user saves
recorded dictation when saving a document (for example, in Word, WordPerfect, or DragonPad), these saved
.DRA files are unencrypted. The user who created these files has the responsibility of saving these files in a
secure location.

Note: Nuance does not guarantee that the file encryption provided in Dragon will ensure total HIPAA compli-
ance. Other security measures are required for full compliance.

Security Considerations

As long as other adequate security protections are in place to protect patient data, you can avoid saving excess
patient data by choosing to:

■ Turn off encryption of patient data (not recommended)

■ Turn off creation of .DRA files and set options to conserve disk space, resulting in fewer saved files

■ Turn off creation of unencrypted .nwv files

Turning on/off encryption of patient data

It is possible to turn off the encryption of these background speech recognition files by un-checking the Encrypt
Patient Health Information check box in the Miscellaneous tab of the Administrative Settings Dialogue.

Nuance can not guarantee HIPAA compliance when this feature is turned off.

For more information, see the Miscellaneous tab of the Administrative Settings dialog box.

Turning on/off creation of .dra patient data files

You can choose to turn off creation of the .DRA files containing patient data to further protect the patient's pri-
vacy when other security measure are in place, by:

■ Turning off data collection, which sends data to Nuance for future product improvements. The check box to
enable/disable data collection is on the Scheduled Tasks tab of the Administrative Settings dialog box.
For more information, see:

■ About Data Collection and Other Scheduled Tasks

__and

■ Checking settings to conserve disk space, which automatically stops creating files that require large amounts
of storage space:

1. On the DragonBar, select Tools > Options and click the Data tab.

2. Check the Conserve disk space required by user profiles (for portability) option. For more information on
the Data tab of the Options dialog box, refer to the main Dragon Help file's topic on the Data tab in the
Options dialog box.



Turning on/off creation of unencrypted text correction .nwv archive files

To further ensure privacy, any user can turn of creation of archive files that might contain patient data:

1. On the DragonBar, select Tools > Options and click the Data tab.

2. Uncheck the Store correction in archive option. For more information on the Data tab of the Options dialog
box, refer to the main Dragon Help file's topic on the Data tab in the Options dialog box.



Upgrading Dragon NaturallySpeaking or Dragon Medical

You take the following steps to upgrade a user profile from Version 9.x or 10.x to Version 11 of Dragon:

■ Prepare to upgrade:

o Based on the version you are upgrading from, determine how you will proceed (seeWhat you should
know before upgrading from a previous version)

o If you are upgrading to Windows Vista, see Installing on or Upgrading to Windows Vista

■ Carry out one of these procedures:

■ Upgrade multiple user profiles (see Upgrading multiple user profiles)

■ Upgrade Roaming User Profiles (see Upgrading Roaming User Profiles )

■ Upgrade user profiles with custom or customized vocabularies (see Upgrading User profiles with Cus-
tom and Customized Vocabularies )

You can work with the User Profile Upgrade Wizard (see Upgrading multiple user profiles)

See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for administrators for
more information.

What you should know before upgrading from a previous version

You can upgrade to Dragon Version 11 from Dragon NaturallySpeaking or Dragon Medical Versions 9.x or 10.x.
You upgrade to Version 11 by following the installation instructions for Version 11, but you should first be sure
to:

■ Uninstall the previous version, when it is required for the version you are upgrading from.

■ Retain your existing user profiles, to be updated after the installation completes.

■ Check that it is possible to upgrade from your existing edition to the edition you are installing.

See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for administrators for
more information.

Upgrading from Version 9.x

The Version 11 installation will install in the Version 9.x directories and overwrite the files in those directories.

Upgrading from Version 10.x

Uninstall Dragon version 10.x before installing Dragon version 11.

Edition considerations

You must upgrade to the same edition or higher and to the same language.

For example, if you started with Version 9.1 German/English and you upgrade to Version 11 English only, your
Version 9.1 German user profiles will not be upgraded. Upgrading to Version 11 German/English will upgrade
both your German and English user profiles. After upgrading, you can install other Version 11 languages.



Note: When you install Dragon 11, Dragon installs using the primary language for the product. You cannot
install Dragon using a language that is different than the primary language. For example, when you install
Dragon 11 Professional - English version, Dragon installs using the English language.

If you attempt to use the /l option with setup.exe to install Dragon 11 using a non-primary language, the instal-
lation process uses the primary language for that edition of Dragon and ignores the /l option.

Installing on or Upgrading to Windows Vista

Dragon NaturallySpeaking and Dragon Medical Versions 9.5 and higher are compatible with all editions of Win-
dows Vista.

Earlier version of Dragon (version 8.x, 9.0, 9.1) will not install or run on Windows Vista.

Upgrade considerations

If you upgrade a machine from a previous version of Windows to Windows Vista and that machine has Version
8.x, 9.0, or 9.1 of Dragon installed, that version of Dragon will not work after upgrading to Windows Vista.

All your user profiles from these previous versions remain intact and can be upgraded when you install Dragon
Version 10 or 11.

See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for administrators for
more information.

Roaming User Profiles in an MSI Installation on Vista

For more on carrying out an MSI installation on Windows Vista, see Modifying Roaming User Profile, Mis-
cellaneous, Schedule Settings in the INI File.

Upgrading multiple user profiles

If you choose not to upgrade your user profiles and vocabularies during the upgrade, you can do so at a later
time by running the Version 11 Upgrade Profiles Tool by selecting Start > Programs > Dragon Nat-
urallySpeaking 11 > Dragon NaturallySpeaking Tools > Upgrade Users.

The User Profile Upgrade Wizard opens.

The User Profile Upgrade Wizard guides you through the process of upgrading user profiles from Dragon Ver-
sions 9.x and 10.x. See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for
administrators for more information.

The wizard cannot upgrade user profiles created by versions of Dragon prior to Version 9.

User Profile Upgrade Wizard: Select User Profiles to Upgrade

On the Select User Profiles to Upgrade page, you see these elements:

User Profile to upgrade

Lists the location and name of all the user profiles that the wizard will upgrade. Modify the list of user profiles to
include all user profiles that you want to upgrade. The wizard starts by including all the user profiles in the cur-
rent folder as candidates to upgrade. You add user profiles to the list by clicking the Add button and browsing
for additional user profiles in other locations. You remove user profiles from the list by selecting them and click-
ing the Remove button. Once adjust the list of user profiles to show only the ones you want to upgrade, click
Next.

Note: If you have roaming users in your network, see Upgrading Roaming User Profiles: Overview



Old Location

The user profiles on this page of the wizard.

User name

Displays the names of all the user profiles that the wizard will upgrade.

Number of User Profiles to upgrade

Displays the total number of user profiles the wizard will upgrade.

Add button

Opens a Browse for Folder window that you can browse in to locate additional user profiles for the wizard to
upgrade.

Remove button

Deletes the user profile you select from the User Profile Upgrade Wizard.

Once you have made a selection, click Next.

User Profile Upgrade Wizard: Choose Destination page

As the User Profile Upgrade Wizard modifies your user profiles to work with Dragon Version 11 , the wiz-
ard can move a copy of the upgraded profile to another location without modifying the old profile. This allows
you to use the old user profiles if you need them again. This also makes the user profiles compatible with oper-
ating systems, like Windows XP, that store all user data in the Documents and Settings folder.

Destination for upgraded user profiles

Click the Browse button or select a new destination from the list if you want to choose a destination other than
the suggested destination.

Advanced

Click the Advanced button to open the Advanced Options dialog box where you can change how the wizard
upgrades the user profile.

User Profile Upgrade Wizard: Advanced Options dialog box

The Advanced Options dialog box lets you make finer adjustments to how the wizard upgrades the user pro-
file. This page contains the following information and allows you to make the following changes:

User Profile to upgrade

This list box contains the following information about each user profile at the current location:

User

Name of the user profile.

Old Location

Location of the current (not yet upgraded) user profiles.



Vocabulary

The original vocabulary of the user profile.

Acoustic Model

The audio input device and associated language/voice model assigned to the user profile.

New Location

When you click on the Location line in the User Profile to upgrade list box, this text box becomes available.
Initially it displays the location that the wizard recommends or that you chose on the Choose Destination
page.You can click Browse and choose a new location.

New Base Vocabulary

When you click on the Vocabulary line in the User Profile to upgrade list box, this text box becomes avail-
able. Initially it displays the current vocabulary of the user profile or the one that the User Profile Upgrade
Wizard will assign to the upgraded user profile if the old vocabulary is no longer supported by Dragon. If the
current vocabulary is supported, the message <Unable to upgrade> appears.

You can select a new base vocabulary from the drop-down list if it contains other vocabularies.

New Acoustic Model

When you click on an Acoustic model line in the User Profile to upgrade list box, this text box becomes
available. Initially, it displays the current language (such as US English), language model, and accent of the
user profile. You can choose a new acoustic model from the drop-down list.

After you have modified the user profile information for each user profile in the list box, click OK to return to
the wizard, and click Next to proceed.

User Profile Upgrade Wizard: Upgrade User Profiles page

On the Upgrade Profiles page, click Begin to start the upgrade process. Expect the wizard to take approx-
imately 5 minutes to upgrade each user profile.

When the process is complete, click Finish.

If the User Profile Upgrade wizard ran automatically in response to you starting the product after installing
an upgrade, the Open User Profile window opens and displays a list of the user profiles you can choose from
to begin dictation.



Upgrading Roaming User Profiles: Overview

This section describes how to upgrade Roaming User Profiles from Dragon NaturallySpeaking or Dragon Medical
Version 9.x or 10.x to Version 11.

When you use the Roaming feature, each Dragon user profile has a master Roaming User Profile that can be
opened from multiple networked computers where Dragon is installed. These master Roaming User Profiles are
stored on a network location made accessible to your Dragon users. 

When a master Roaming User Profile is opened from that central network location, Dragon transfers a copy of
that profile to the Local Roaming User Profile on the local computer.

Since the Local Roaming User Profile is a copy of the user profile data taken from the master Roaming User Pro-
file, you cannot directly upgrade the Local Roaming User Profile when you upgrade the local Dragon installation
from Version 9.x or 10.x to Version 11.

Notes:

■ Upgrading a set of Version 9.x or 10.x master Roaming User Profiles to Version 11 leaves the Version 9.x or
10.x master Roaming User Profiles unchanged. Leaving the Version 9.x or 10.x profiles intact allows the users
in your network to run Dragon Version 9.x or 10.x while you plan your upgrade.

■ Plan to upgrade the master Roaming User Profiles at a time when they are not being opened by end users, for
example during the night or on a weekend.

■ Even though the Dragon 11 User Profile Upgrade Wizard supports both mapped drives and UNC paths,
Nuance strongly recommends that you upgrade your Master Roaming User Profiles on a drive on a machine
where Dragon 11 is locally installed. Nuance does not recommend that you upgrade your Master Roaming
User Profiles across a network to either a mapped drive or UNC path; upgrading over a network will take an
undetermined length of time. In addition, the User Profile Upgrade Wizard does not support upgrading user
profiles over an HTTP connection.

Step 1: Preparing to upgrade Roaming User Profiles

To upgrade your Master Roaming User Profiles from a previous version of Dragon, Nuance recommends that
you install Dragon 11 directly on the network machine where the version 9.x or 10.x Master Roaming User Pro-
files are located and upgrade those Master Roaming User Profiles directly to Dragon 11 Master Roaming User
Profiles.

If you are unable to install Dragon where your version 9.x or 10.x Master Roaming User Profiles are located,
Nuance recommends that you:

■ Install Dragon 11 on a separate machine where you will perform the upgrades.

■ Copy the version 9.x or 10.x Master Roaming User Profiles from their network location to the machine where
Dragon 11 is installed.

■ Upgrade the version 9.x or 10.x Master Roaming User Profiles on the machine where Dragon 11 is installed.

■ Copy the upgraded version 11 Master Roaming User Profiles to a network accessible directory on the original
network location.

For more information, see Preparing to upgrade Roaming User Profiles.

Step 2: Upgrading the user profiles

As administrator you must separately upgrade the master Roaming User Profiles to Version 11 using the Ver-
sion 11 User Profile Upgrade Wizard.



After you upgrade the version 9.x or 10.x Master Roaming User Profiles, you can then proceed to upgrade end-
user systems that deploy the Roaming feature.

For more information, see Upgrading master Roaming User Profiles

Step 3: Upgrade the end-user systems

After you have upgraded the master Roaming User Profiles, you can then proceed to upgrade end-user systems
that deploy the Roaming feature.

For more information, see Upgrading end-user systems.

See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for administrators for
more information.

Preparing to upgrade Roaming User Profiles

Step 1: Install Dragon 11 on the machine where you will perform the upgrades of your version 9.x

or 10.x Master Roaming User Profiles

Nuance recommends that you install Dragon 11 on the machine where the version 9.x or 10.x Master Roaming
User Profiles are located. If that is not possible, Nuance recommends that you install Dragon 11 on a separate
machine where you will perform the upgrades.

For more information on installing, see Installing on a single machine.

Notes:

■ If you are unable to install Dragon where your version 9.x or 10.x Master Roaming User Profiles are located,
Nuance recommends that you install Dragon 11 on a separate machine where you will perform the upgrades.
For more information, see Upgrading Roaming User Profiles: Overview.

Step 2: On the version 9.x or 10.x end-user systems that use the Roaming feature

On the end-user systems where the users dictate using the version 9.x or 10.x Roaming feature, save and close
any open user profiles on each Dragon Version 9.x or 10.x system that uses the Roaming feature.

Note: If there is no time when all of your Roaming User Profiles are unused (for example, if you are supporting
a hospital where some physicians use Dragon during a night shift), you can upgrade different groups of Roaming
User Profiles at different times.

Step 3: On the central network location that stores the version 9.x or 10.x Master Roaming User Profiles:

1. (Optional) Back up the master Roaming User Profiles to a separate location, either by using any system
backup utility that is implemented at your facility or by using the Dragon The Manage User Profiles dialog.

Note: You are not required to back up the Roaming User Profiles because when you upgrade, your Version
9.x or 10.x user profiles are retained in a directory separate from your Version 11 user profiles.

2. Create a new directory on the shared network drive that should store the upgraded Dragon 11 Master Roam-
ing User Profiles. Although you can store the upgraded Version 11 user profiles in the same location as the cur-
rent user profiles — this would make two versions of each user profile visible to the end user and lead to
confusion — Nuance recommend that you create a location that differs from the location that stores the cur-
rent (version 9.x or 10.x) user profiles.



Step 4: Copy the version 9.x or 10.x Master Roaming User Profiles from the previous network loca-

tion to the machine where Dragon 11 is installed.

If you installed Dragon 11 on the machine where the version 9.x or 10.x Master Roaming User Profiles are
located, then proceed to Step 5 below.

If you installed Dragon 11 on a machine other than where the version 9.x or 10.x Master Roaming User Profiles
are located, then do the following on the machine where Dragon 11 is installed:

1. Create a directory on the local machine that will hold all the Master Roaming User Profiles you plan to
upgrade.

2. Copy the version 9.x or 10.x Master Roaming User Profiles from the network location to the directory you just
created.

Step 5: On the administrator system from where you will upgrade the version 9.x or 10.x Master Roaming User Pro-

files to version 11:

1. Start Dragon Version 11 and make sure the Roaming feature is turned off.

To turn off the Roaming feature:

a. Close any open user profiles.

b. Click Administrative Settings on the DragonBar Tools menu. This action displays the Admin-
istrative Settings dialog box.

c. On the Roaming tab, make sure Enable is not selected.

2. Close Dragon.

3. Follow the instructions in the next section, Upgrading master Roaming User Profiles.

See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for administrators for
more information.

Upgrading master Roaming User Profiles

As administrator you must separately upgrade the master Roaming User Profiles to Version 11 using the Ver-
sion 11 User Profile Upgrade Wizard on the version 9.x or 10.x Master Roaming User Profiles. See "Upgrad-
ing user profiles to Dragon version 11" in Dragon version 11 - What's New for administrators for more
information.

Before proceeding with this section, make sure you have followed the procedure described in Preparing to
upgrade Roaming User Profiles.

After you have upgraded the version 9.x or 10.x Master Roaming User Profiles and optionally copied them back
to their network location, you can then proceed to upgrade your end-user systems that use the Roaming fea-
ture. For more information, see Upgrading end-user systems.

Step 1: Upgrade the version 9.x or 10.x Master Roaming User Profiles using the User Profile

Upgrade Wizard

On the machine where both your version 9.x or 10.x Master Roaming User Profiles and Dragon 11 are installed:

1. Select Start > Programs > Dragon NaturallySpeaking 11 > Dragon NaturallySpeaking Tools >
Upgrade Users.

Note: If you did not turn off the Roaming feature in the Administrative Settings dialog box before



attempting to start the User Upgrade Wizard, you receive an error message stating that you cannot
upgrade a Roaming User Profile. If you receive the message, go back to the Administrative Settings dialog
and be sure the Enabled check box is not checked.

2. On the Select User Profiles to Upgrade page, click Add... to select the location of the version 9.x or 10.x
Master Roaming User Profiles. The Select User Profiles to Upgrade page now displays a list of user pro-
files in the selected directory. For example:

You can continue to use the Add... button to add user profiles from other local locations or use the Remove
button to remove specific user profiles. Click Next to continue.

3. On the Choose Destination page, in the Destination for upgraded user profiles text box, choose the
local location you previously created that will contain the upgraded Version 11 master Roaming User Profiles.
If you do not see the location you want, you can click the Browse button, find the correct location, and click
Next. For example:



4. The Upgrade User Profiles page displays the number of user profiles that the wizard is prepared to
upgrade.

5. Click Begin to start the upgrade process. The upgrade process can take 2-3 minutes or more per user profile,
depending on the speed of your system and your network. You can click Stop at any time to interrupt this
process.

The upgrade process creates new master Roaming User Profiles in the destination you selected.

6. Click Finish to complete the upgrading process and exit the User Profile Upgrade Wizard.

Note: The User Profile Upgrade Wizardrenames each Version 11 master Roaming User Profile as follows:
<name> (v11).
For example, a Version 10.x Master Roaming User Profile named roaminguser1 will be copied and named roam-
inguser1 (v11) when upgraded to Version 11. The Version 10.x Master Roaming User Profile named roam-
inguser1 remains unchanged.

Having the user profiles renamed like this could cause some confusion for the users in your network who are dic-
tating with Roaming User Profiles. If, for example, you chose to locate your Version 9.x or 10.x Roaming User
Profiles and your upgraded Version 11 Roaming User Profiles in the same network directory, the Open User
Profile dialog box would display both the old and the Version 11 master Roaming User Profiles.

Step 2: Clean up network locations of Version 9.x or 10.x master Roaming User Profiles (optional) 

When the User Profile Upgrade Wizardmodifies the Version 9.x or 10.x master Roaming User Profiles to
work with Dragon Version 11, it makes a copy of the upgraded user profile first, leaving the original Version 9.x



or 10.x user profiles unchanged. This allows you to return and use the old user profiles in case you need them
again.

As administrator, you can optionally rename or remove the Version 9.x or 10.x master Roaming User Profiles
through the Manage User Profiles dialog box.

Step 3: Copy the upgraded version 11 Master Roaming User Profiles back to their network location

(Optional)

If you were unable to install Dragon where your version 9.x or 10.x Master Roaming User Profiles were located
and you copied your version 9.x or 10.x Master Roaming User Profiles to a another machine where Dragon 11
was installed, you must now copy the upgraded version 11 Master Roaming User Profiles back to the new net-
work accessible directory that you created on their original network location.

You can skip this step if you installed Dragon 11 on the machine where the version 9.x or 10.x Master Roaming
User Profiles are located and upgraded those Master Roaming User Profiles directly to Dragon 11 Master Roam-
ing User Profiles.

Step 4: Upgrade your end-user systems from Dragon V9 or V10 to Version 11

After you have upgraded the master Roaming User Profiles, you can then proceed to upgrade your end-user sys-
tems where users dictate and where the Roaming feature is enabled. For more information, see Upgrading end-
user systems.

Upgrading end-user systems to Dragon 11

After you have upgraded the master Roaming User Profiles, you can then proceed to upgrade the end-user sys-
tems that use the Roaming feature.

Before proceeding with this section, make sure you have followed the procedure described in Upgrading master
Roaming User Profiles.

Step 1: Upgrade Version 9.x or 10.x systems where users will dictate with the Version 11 Roaming

feature

Since the User Profile Upgrade Wizard leaves your Version 9.x or 10.x master Roaming User Profiles
unchanged and in their original network location, your Version 9.x or 10.x systems can continue to use the
Roaming feature until you upgrade those installations to Version 11.

To upgrade a Version 9.x or 10.x system where users use Roaming User Profiles to dictate to Version 11, follow
the installation instructions under Installing Dragon on a single machine .

Notes:

■ When prompted, choose to remove the Version 9.x or 10.x Dragon installation. If you choose not to remove
the previous installation, you cannot continue to upgrade.

Step 2: Enable the Roaming feature on upgraded end user systems and try opening a Roaming User

Profile

When you upgrade a Dragon to Version 11, the Roaming feature is turned off by default.

To turn on the Roaming feature on the upgrade machines:

1. Start Dragon.

2. If a user profile opens, close it.



3. Click Administrative Settings on the DragonBar Tools menu. This displays the Administrative Set-
tings dialog box.

4. On the Roaming tab, select Enable.

5. The Network Directories list will display the network location of the Version 9.x or 10.x master Roaming
User Profiles.

If you created a new network directory for your Version 11 master Roaming User Profiles, you can either click
the Add button to add the new network location or select a listed directory and then click Edit to change the
path to the new location. When you have finished, click OK to close the Administrative Settings dialog box.
You should also remove any unused Version 9.x or 10.x master Roaming User Profile directory to avoid con-
fusion.

6. Select Profile > Open User Profile on the DragonBar. This action displays the Open User Profile
dialog box. If you allow users to select both non-roaming local and Roaming User Profiles, make sure they
select the correct location (the Version 11 Roaming User Profile location) from the Location of user profile
field.

7. Select a user profile and click Open.

Note: If the Roaming User Profiles have not already been upgraded and stored in the new master Roaming User
Profile directory, when you click Open, the User profile needs to be upgraded dialog box appears. Since
you cannot upgrade Roaming User Profiles locally, you should click Cancel here and return to Upgrading
master Roaming User Profiles. If you click OK instead of Cancel, you receive a message stating You cannot
upgrade a roaming user because you cannot upgrade Roaming User Profiles on a workstation that has Roam-
ing feature enabled.

Upgrading multiple user profiles

If you choose not to upgrade your user profiles and vocabularies during the upgrade, you can do so at a later
time by running the Version 11 Upgrade Profiles Tool by selecting Start > Programs > Dragon Nat-
urallySpeaking 11 > Dragon NaturallySpeaking Tools > Upgrade Users.

The User Profile Upgrade Wizard opens.

The User Profile Upgrade Wizard guides you through the process of upgrading user profiles from Dragon Ver-
sions 9.x and 10.x. See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for
administrators for more information.

The wizard cannot upgrade user profiles created by versions of Dragon prior to Version 9.

User Profile Upgrade Wizard: Select User Profiles to Upgrade

On the Select User Profiles to Upgrade page, you see these elements:

User Profile to upgrade

Lists the location and name of all the user profiles that the wizard will upgrade. Modify the list of user profiles to
include all user profiles that you want to upgrade. The wizard starts by including all the user profiles in the cur-
rent folder as candidates to upgrade. You add user profiles to the list by clicking the Add button and browsing
for additional user profiles in other locations. You remove user profiles from the list by selecting them and click-
ing the Remove button. Once adjust the list of user profiles to show only the ones you want to upgrade, click
Next.

Note: If you have roaming users in your network, see Upgrading Roaming User Profiles: Overview



Old Location

The user profiles on this page of the wizard.

User name

Displays the names of all the user profiles that the wizard will upgrade.

Number of User Profiles to upgrade

Displays the total number of user profiles the wizard will upgrade.

Add button

Opens a Browse for Folder window that you can browse in to locate additional user profiles for the wizard to
upgrade.

Remove button

Deletes the user profile you select from the User Profile Upgrade Wizard.

Once you have made a selection, click Next.

User Profile Upgrade Wizard: Choose Destination page

As the User Profile Upgrade Wizard modifies your user profiles to work with Dragon Version 11 , the wiz-
ard can move a copy of the upgraded profile to another location without modifying the old profile. This allows
you to use the old user profiles if you need them again. This also makes the user profiles compatible with oper-
ating systems, like Windows XP, that store all user data in the Documents and Settings folder.

Destination for upgraded user profiles

Click the Browse button or select a new destination from the list if you want to choose a destination other than
the suggested destination.

Advanced

Click the Advanced button to open the Advanced Options dialog box where you can change how the wizard
upgrades the user profile.

User Profile Upgrade Wizard: Advanced Options dialog box

The Advanced Options dialog box lets you make finer adjustments to how the wizard upgrades the user pro-
file. This page contains the following information and allows you to make the following changes:

User Profile to upgrade

This list box contains the following information about each user profile at the current location:

User

Name of the user profile.

Old Location

Location of the current (not yet upgraded) user profiles.



Vocabulary

The original vocabulary of the user profile.

Acoustic Model

The audio input device and associated language/voice model assigned to the user profile.

New Location

When you click on the Location line in the User Profile to upgrade list box, this text box becomes available.
Initially it displays the location that the wizard recommends or that you chose on the Choose Destination
page.You can click Browse and choose a new location.

New Base Vocabulary

When you click on the Vocabulary line in the User Profile to upgrade list box, this text box becomes avail-
able. Initially it displays the current vocabulary of the user profile or the one that the User Profile Upgrade
Wizard will assign to the upgraded user profile if the old vocabulary is no longer supported by Dragon. If the
current vocabulary is supported, the message <Unable to upgrade> appears.

You can select a new base vocabulary from the drop-down list if it contains other vocabularies.

New Acoustic Model

When you click on an Acoustic model line in the User Profile to upgrade list box, this text box becomes
available. Initially, it displays the current language (such as US English), language model, and accent of the
user profile. You can choose a new acoustic model from the drop-down list.

After you have modified the user profile information for each user profile in the list box, click OK to return to
the wizard, and click Next to proceed.

User Profile Upgrade Wizard: Upgrade User Profiles page

On the Upgrade Profiles page, click Begin to start the upgrade process. Expect the wizard to take approx-
imately 5 minutes to upgrade each user profile.

When the process is complete, click Finish.

If the User Profile Upgrade wizard ran automatically in response to you starting the product after installing
an upgrade, the Open User Profile window opens and displays a list of the user profiles you can choose from
to begin dictation.

Upgrading user profiles with Vocabularies Created by Third Parties

Vocabularies Created by a Third Party (rather than by Nuance)

Note: Any installation can use vocabularies that are not provided by Nuance, but created by a third
party specifically for a particular installation.

Upgrading User profiles with Vocabularies Created by Third Parties

When you upgrade a user profile whose base vocabulary was created by a third party, all custom words and
other changes to that vocabulary will be maintained but the vocabulary's base type will be changed. For exam-
ple, Version 9.x or 10.x user profiles who used US English | Large | Nuance vocabulary with a topic ID of
9005 are upgraded to use the General—Large vocabulary; that upgraded user profile's vocabulary also con-
tains all customizations in the Version 9.x or 10.x vocabulary.



See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for administrators for
more information.

Once the user profile is upgraded, you can continue to modify the vocabulary using the Voctool.

To further modify and re-distribute customizations to vocabularies created by third parties, you can follow the
steps outlined below on your Version 11 user profiles.

Step 1: Export any custom words added to the custom vocabulary

If you added any additional custom words to the vocabulary created by a third party, you must first export
those words. To export custom words:

1. On the DragonBar menu, select Vocabulary > Export custom word and phrase list This action displays
the Export Custom Words dialog box.

2. Enter the path and name of the file containing the custom words to add to the vocabulary that you want to
create, or use Save in list to find a location for the file you want to create.

Step 2: Upgrade a user profile with a customized vocabulary

To upgrade Version 9.x or 10.x user profiles with a vocabulary created by a third party:

1. Run the User Profile Upgrade Wizard. To run the wizard, select Dragon NaturallySpeaking 11>
Dragon NaturallySpeaking Tools > Upgrade Users.

2. In the User Profile Upgrade Wizard, select a Version 9.x or 10.x user profile that uses a vocabulary
created by a third party.

3. Click Next and follow the on-screen prompts.

The User Profile Upgrade Wizard displays the original vocabulary deployed to create the user profile and
lets you choose a Version 11 base vocabulary that the User Profile Upgrade Wizard should assign to the
upgraded user profile.

Step 3: Import custom words to the upgraded user profile

If you exported words in Step 1, you now must import those words. To import a word list:

1. On the DragonBar, click Vocabulary > Import list of words or phrases This displays the Add Words
fromWord Lists wizard.

2. Click Next to add the file you created in Step 1.

Step 4: Export the customized vocabulary

You can share vocabularies among different user profiles by first exporting a vocabulary from one user profile
and then importing it to a new user profile. Use the following procedure to export a vocabulary. To export a
vocabulary:

1. Create a folder in which to save the exported vocabulary files.

2. Open the upgraded Version 9.x or 10.x user profile that uses the customized vocabulary.

3. On the DragonBar, select Vocabulary > Manage Vocabularies or say "Manage Vocabularies."

4. In the Manage Vocabularies dialog box, select the vocabulary you want to export and then export it.

5. Locate and open the target folder, enter a name for the exported vocabulary in the File Name box, and then
save it.



6. In the Manage Vocabularies dialog box, click or say "Close" to save and close it.

Note: Exporting a vocabulary creates a copy of the four files that make up the vocabulary in the new location.
You can access these files via the Data Distribution Tool or the nsadmin tool to create new custom base
vocabularies.

Step 5: Use nsadmin or the Data Distribution tool to copy the exported vocabulary

Using the nsadmin command line or the Data Distribution Tool, you can import the vocabulary your created
in Step 2 as a base vocabulary on any Dragon installation.

Once you add a base vocabulary to a Dragon installation, you can then use the new vocabulary to create new
user profiles or add a new vocabulary to the an existing user profile.

When you run nsadmin or the Data Distribution Tool to import the exported vocabulary to your Dragon
installation, be sure to give the new vocabulary the same name and topic ID that the Version 9.x or 10.x cus-
tomized vocabulary had.

For example, if your Version 9.x or 10.x customized vocabulary was named US English | Large | Nuance
topic ID 9005, you would use nsadmin or the Data Distribution Tool to create a new base vocabulary with
that same name and topic ID number.



Overview of Installing Dragon using the Windows installer (MSI)

Dragon NaturallySpeaking and Dragon Medical include a native Windows Installer (MSI) that lets you customize
your installations as well as install across a network to multiple client machines. In addition, you use this serv-
ice to modify, repair, or remove any existing installations.

Although you have several choices when deciding how you want to install Dragon NaturallySpeaking or Dragon
Medical on the command line, Nuance recommends that you follow the approach presented initially in this doc-
ument.

Note: Administrative installations are not supported for Dragon Medical Small Practice Edition.

You can use this procedure to install the software on one machine at a time or combine it with Systems Man-
agement Server (SMS) or Windows Active Directory Service to install the software across a network to multiple
client machines. Also, if you have already installed the product, you use this process to upgrade, modify, repair,
or remove any existing installations.

Before You Begin

To ensure a smooth installation, before you proceed, you should gather the following information regarding
your network and Dragon settings.

■ Preferred settings for Dragon options, including any PowerMic or PowerMic II button actions to be pro-
grammed. Usually set in the Options dialog box of Dragon.

■ Preferred settings for Dragon Auto-Formatting options to be applied to the recognized text. Usually set in the
Auto-Formatting dialog box of Dragon.

■ Path to and/or mapped drive of the location where Roaming User Profiles are stored or are going to be stored,
normally set in the Network Settings sub-dialog of the Roaming tab in the Administrative Settings
dialog box.

■ Information about your http or https connection to the Roaming User Profiles storage location, if applicable,
normally set in the Http Settings or Https Settings sub-dialog of the Administrative Settings dialog
box.

■ Preferred settings for collecting dictation data to be sent back to Nuance Communications for improving the
future accuracy of Dragon, normally set under the Scheduled Tasks tab of the Administrative Settings
dialog.

■ Install a third-party indexing/search software before you install Dragon; if no third-party indexing/search is
installed, when you try to set Dragon options, the Enable Desktop Search commands check box will not
be available for selection. Dragon supports Google Desktop and Microsoft Vista Search.

Finding the MSI Installer on the DVD

The compiledMSI file is located on your installation DVD. The files for each edition are named:

■ Dragon NaturallySpeaking (all editions) or Dragon Medical: Dragon NaturallySpeaking 11.msi

■ SDK Client Edition (DSC): Dragon SDK Client Edition 10.msi

■ SDK Server Edition (DSS): Dragon SDK Server Edition 10.msi



You can double click on one of these .msi files to start the InstallShield Wizard; however, to instead take advan-
tage of available command line options, you can pass the file name as the application to install to the msiex-
ec.exe command using the /i option:

msiexec.exe /i "Dragon NaturallySpeaking11.msi"

Entering Command Lines

Unless otherwise noted:

■ All command line options are case-insensitive (unless otherwise noted) and can be combined.

■ No options require special values based on the values of other options.

■ In the examples, user-supplied information is displayed between angle brackets. Do not use angle brackets
(<,>) as part of the command line.

■ Do not use quotation marks unless you are explicitly instructed to.

■ Strings of path names with spaces in them must be in quotation marks that are escaped by a backslash before
each quotation mark (\").

■ Whenever you set an option to an .ini file, you must give the full path to that .ini file.

■ All msiexec.exe command-line options you pass with /v must be prefaced with a forward slash (/) only.

Windows Vista Notes

Dragon setup is designed so thatmsiexec.exe can be run from an elevated command prompt in Windows
Vista.

To launch an elevated command prompt in Windows Vista:

1. Click the Windows Start key

2. Type cmd in the search field

3. Press Ctrl+Shift+Enter. This action displays a User Account Control dialog box stating thatWindows
needs your permission to continue.

4. Click Continue or hit Alt+C to confirm the elevation prompt. This displays an elevated command prompt.

Alternatively, to run the command window as an administrator, you can select Start > All Programs > Acces-
sories > Command Prompt (without releasing the mouse), then right click Command Prompt and select
Run As. Choose an Administrator user and enter the authentication information requested.

Overview of the Network Installation of Dragon from a Server

Overview of Pushing Client Installation from a Server

You can install the Dragon runtime in a network environment, in other words, push the software application out
to client computers without having to install it separately on each client system. Dragon includes a native Win-
dows Installer (MSI) that lets you both install across a network to multiple client machines and customize your
installations. Several servers support this type of network installation:

■ Windows Server 2003

■ Windows Server 2008



■ System Management Server (SMS)

■ Active Directory Services

The administrator carrying out the installation creates an image of the installation program on the server and
then configures the server to automatically push the application onto the client systems. You can also configure
network installations to modify, repair, or remove an existing installation.

Support for SMS and Windows 2003 Server with Active Directory

Systems Management Server (SMS) provides a mechanism for pushing application installations out from the
server to client systems. SMS supports using the Windows Installer (MSI) to push client installations on clients
using all versions of Windows, from Windows XP to Windows 7. SMS requires that a client application be
installed on all client machines.

For information about Windows Installer technology, see the Microsoft document Scenarios and Procedures for
SMS 2003: Planning and Deployment available at http://ww-
w.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-9BC1807-
13F7E&displaylang=en.

Active Directory Services is a feature of Windows Server 2003, and Windows Server 2008. The Group Policy
component of Active Directory Services includes a Software Installation snap-in that lets an administrator
create a network installation. Administrators can use this feature to install software to Windows XP, Windows
Vista, and Windows 7 clients.

Dragon supports the Active Directory Services Assign to Computers installation option. This option successfully
installs the software when the computer is rebooted. You (as administrator) can delay installation on Windows
XP or Vista clients by enabling logon optimization for group policy; for this type of installation, an entry for the
installation can be viewed in the event log after the first reboot. The installation is then performed on the sec-
ond reboot. The installation takes place silently, and the software is installed for all users on the computer.

Overview of Alternative Ways to Carry Out Administrative Installation

Dragon NaturallySpeaking and Dragon Medical include a native Windows Installer (MSI) that lets you install
across a network to multiple client machines and customize your installation in the process. In addition, you can
use this service to modify, repair, or remove any existing installations. You can use any of the following com-
mand line approaches to installing Dragon over a network:

Note: MSI installations are not supported for Dragon Medical Small Practice Edition.

■ Carrying Out an Administrative Installation with .bat File

■ Configuring Installation of Product Updates

■ Citrix Overview

■ Creating Custom Installation Using Microsoft Custom Install Wizard

Once you have installed the server image, you can configure your installation, then use SMS or a similar prod-
uct to install Dragon. If the product you use to push the installation out to a server requires it, you can install
Dragon with msiexec (see Step-by-Step Command Line Installation with msiexec.exe) instead of setup.exe.

Modifying Roaming User Profile, Miscellaneous, Schedule Settings in the INI File

Suppose you have a large installation that involves several departments. Three departments require one group
of configure settings and two others require modifications. After you complete the installation on the three

http://www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-9BC180713F7E&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-9BC180713F7E&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-9BC180713F7E&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-9BC180713F7E&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-9BC180713F7E&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-9BC180713F7E&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-9BC180713F7E&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-9BC180713F7E&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-9BC180713F7E&amp;displaylang=en


departments requiring the same configuration, you might want to edit your configuration files before using them
on the additional two departments.

To edit the settings, you can use the natspeak command again. You can either return to the machine where you
carried out the initial installation to use natspeak or install the configuration from the first three departments on
the first machine in the two departments with different settings. Modify the settings using:

■ natspeak /setdefaultoptions

■ natspeak /setdefaultformattingoptions

■ natspeak /setdefaultadministrativeoptions

Then copy the new nsdefaults.ini file and roamingdef.ini files to a location accessible from all the client
machines to have the alternative configuration. For example, if you want these files to be accessible to the MSI
installer from a mapped network drive. copy the files to that location before installing to the client PCs.

Or, if the Roaming User Profile network settings are not changing, you can edit any of the other Roaming User
Profile, Miscellaneous, and Scheduled Tasks settings of your configuration by rerunning Dragon with any com-
mand listed above. (You cannot make changes to the roamingdef.ini file, where the network settings reside.)
Lists of the options in the nsdefaults.ini and roamingdef.ini files are provided in the tables that follow:

Caution: Be sure to use the full path to the file if you set an option to an .ini file name.

Editing Roaming User Profile Options in nsdefaults.ini File

Several Roaming User Profile options are listed in the nsdefaults.ini file. These are the same options you can set
from the Roaming tab of the Administrative Settings dialog box. You can either find and modify these options in
the nsdefaults.ini file that Dragon created during an initial installation or copy the file from an existing instal-
lation.

Options Description UI equivalent

(in Roaming tab)

Roaming User On=0
(or 1)

Turns on the Roaming feature.

Default 0 = Off

Enable

Roaming User Local
Cache Directory="<
existing directory>"

Sets the location of the local copy of the Roaming User
Profile.

The default location is: Documents and Settings\All
Users\Application Data\Nuance\Dragon Nat-
urallySpeaking11\RoamingUsers\.

Local directory (for
cache)

Roaming User
Restrict Local User
Access=1 (or 0)

Permits non-Roaming User Profiles to be opened when
the Roaming feature is active. Default of 1 restricts
access to Roaming User Profiles only, preventing non-
roaming (local) users from dictating by accident.

Allow non-Roaming
User Profiles to be
opened

Roaming User Save
Acoustics=0 (or 1)

When set to 1 (by default), when a user dictates on a
computer, acoustic adaptation that occurred as Dragon
'adapted' to the user's voice, is saved. Acoustic opti-

Save acoustic infor-
mation



mization on the master user profile applies the acoustic
adaptation data from dictation to the acoustic model for
the profile.

When set to 0, the .usr and .sig files created during dic-
tation are not saved. Acoustic optimization on the
master user profile does not apply the acoustic adap-
tation data from dictation to the acoustic model for the
profile.

See Dragon version 11 - What's New for administrators
for more information.

Open User Large Col-
lection=0 (or 1)

When set to 0, Dragon 11 only displays the classic ver-
sion of the Open User Profile dialog box (from Dragon
10.1 and earlier versions). Dragon 11 does not display
the new version of the dialog that shows a tree-view of
groups of user profiles.

When set to 1, Dragon 11 only displays the new version
of the Open User Profile dialog box.

See Dragon version 11 - What's New for administrators
for more information.

Display Classic
Open User Profiles
dialog

Roaming User Copy
Dragon Log=0 (or 1)

Copies the dragon.log file from the local Roaming
User Profile location to the master Roaming User Pro-
file location at the same time that the program syn-
chronizes the local and the master Roaming User
Profiles. Default 0 = Off

Copy Dragon Log to
Network

Roaming User Lim-
ited Network Traf-
fic=0 (or 1)

Transfers local Roaming User Profile changes to the
master Roaming User Profile to synchronize the local
and themaster Roaming User Profile only when you
open or close the user profile. This includes the changes
a user makes locally from the Options dialog box.

For more information, see the Dragon Administrator
Guide Help file topic on Synchronizing Master and Local
Roaming User Profiles. Excessive network slowdowns
can be alleviated by checking this option because it lim-
its multiple interim synchronizations of local and
master Roaming User Profiles. Default 0 = Off.

Access network at
user profile
open/close only

Roaming User
Always Break
Lock=0 (or 1)

Ask before breaking locks on network user profiles (rec-
ommended).

A network lock prevents opening a Roaming User Pro-
file that is already open. Network problems can cause a
lock to become "stuck" and not release even after open-
ing the user profile is complete. Default of 0 produces a
prompt that states the user profile is locked and asks
you to override the lock. A setting of 1 does not
produce the prompt, but breaks the lock automatically.

Ask before break-
ing locks on net-
work user profiles
(recommended for
UNC and mapped
drives)



Roaming User Max
Container Size=500
MB

Controls the maximum size for each container directory

in the master Roaming User profile directory. Defaults
to 500 MB, max of 10000 MB.

Disk space
reserved for net-
work archive

ASW Override=0 (or
1)

(ASW is short for Audio Setup Wizard.) Runs a Volume
and Quality Check on the microphone each time you
open a Roaming User Profile. This setting affects all
users.

Turn this option on if your users experience reduced
accuracy because of differences in the microphone,
sound card, and ambient sound levels at different loca-
tions. Default 0 = off. Nuance recommends you set this
option to 1.

Set audio levels on
each machine

Roaming ASW Over-
ride=0 (or 1)

Runs a Volume and Quality Check on the microphone
each time you open a Roaming User Profile. Set to 1 if
the Roaming feature is enabled and ASW Override is
1. ASW Override and Roaming ASW Override
should always have the same setting.

Set audio levels on
each machine

Roaming User Do
Not Copy Dra
Files=0 (or 1)

Prevents making files that contain acoustic data from
the latest dictation session available to the Acoustic
Optimizer when the program synchronizes the local
andmaster Roaming User Profiles.

You use this option to prevent the transfer of acoustic
optimization data to local user profiles.

Conserve archive
size on network

Roaming User Incor-
porate Voc Delta=0
(or 1)

When the vocdelta.dat file reaches 90% of its max-
imum size (500 KB), incorporates the contents of the
local vocdelta.dat file into the master Roaming User
Profiles (acoustic model for the user profile), without
running the Acoustic and Language Model Opti-
mizer. After it incorporates the contents of the file into
the master Roaming User Profile, it clears that data
from the local user profile, where new data is culled
from subsequent dictation. If the data is being incor-
porated when you open a roaming user profile, the proc-
ess can be time consuming. Default 0 = off.

Merge contents of
vocdelta.dat into
network user pro-
file when file is full

Roaming User Copy
Acoustic Always=0
(or 1)

Copies the user profile’s acoustic information to the
master Roaming User Profile location when you don’t
want to run the Acoustic and Language Model Opti-
mizer on the master Roaming User Profiles. The local
Roaming User Profile acoustic information is stored in:
Documents and Settings\All Users\Application
Data\Nuance\NaturallySpeaking11\RoamingUsers\
<display name>\<username>\current\voice

The <display name> is the name you defined for the
master Roaming User Profile location. You can have
multiple network storage locations. The <username>

Always copy acous-
tic information to
network



contains the names of an individual master Roaming
User Profile.

Default 0 = off.

If you chose not to copy the user profile’s acoustic information to the network,
corrections you make on one machine are not available on other machines used
by that particular Roaming User Profile until you run the Acoustic and Lan-
guage Model Optimizer on the master Roaming User Profile location and the
local andmaster Roaming User Profile synchronize. When this option is set to 1
(on), the latest acoustic information is always available and automatically syn-
chronized when the master Roaming User Profile is opened from another loca-
tion. The transfer of acoustic information is not limited by setting the Disk
space reserved for network archive option.

Editing Miscellaneous and Scheduled Task Settings in nsdefaults.ini File

Of the settings in the nsdefaults.ini file retrieved from the Administrative Settings dialog box, several settings
are from the Miscellaneous and Scheduled Tasks tabs of the dialog box. You can modify the following settings in
the nsdefaults.ini file:

Options Description

AO Archive Time Limit Maximum audio archive
size in minutes. The same
option in the options.ini
file for a particular user
contains the size of the
current audio archive for
that user.

Default max is 3600000
minutes.

Archive Size dialog box,
displaying the range of
audio archive sizes

Disable command changes
for restricted users=0 (or
1)

Turns on or off the option
that lets non-admin-
istrative users add or
modify commands.

Do not allow restricted
users to add or modify
commands

Disable vocabulary
changes for restricted
users=0 (or 1)

Turns on or off the option
that lets non-admin-
istrative users modify
vocabularies.

Do not allow restricted
users to modify vocab-
ularies

Global Enable Pause
Results=0
(or 1)

Turns on or off rec-
ognition when the
speaker pauses.

Record wave data
between utterances

Custom Directory=<full
path>

Sets the location of the
Data Distribution direc-
tory used by the Data Dis-
tribution Tool or the
nsadmin command.

Data Distribution location



Current Status Ctfmngr=0
(or 1)

Turns on or off Windows
advanced text services.
Turning off these services
prevents conflict between
them and Dragon.

Disable Windows
advanced text services

No Dictation=0 or 1 When No Dictation is on
(set to 1) the user cannot
dictate, but can only cor-
rect dictation; used to des-
ignate a user as a
transcriptionist.

Correction Only Mode

Global MyCommands Mac-
roRecorder=0 or 1

Allows or does not allow
the user to modify Macro
Recorder commands. The
user should still be able
to dictate with those com-
mands, even when not
allowed to modify them.

Disable use of Macro
Recorder commands

Global MyCommands 
StepByStep Scripting=0
or 1

Allows or does not allow
the user to modify Step-
by-Step commands. The
user should still be able
to dictate with those com-
mands, even when not
allowed to modify them.

Disable use of Step-by-
Step commands

Global MyCommands VBA
Scripting=0 or 1

Allows or does not allow
the user to modify
Advanced Scripting com-
mands. The user should
still be able to dictate
with those commands,
even when not allowed to
modify them.

Disable use of
Advanced Scripting com-
mands

enx ACO uses Auto Accent
AM selection=0 or 1.

When set to 1, the Acous-
tic Optimizer engine can
automatically select an
acoustic model that it
believes is more suited to
your speech. To avoid
having this switch occur,
set the option to 0.

In Dragon 11, special con-
ditions apply if you run
the Acoustic Optimizer on
a user profile that has
two acoustic models. See

Disable automatic acous-
tic model selection in
Acoustic Optimizer



Using multiple acoustic
models with a user profile
for more information.

Encrypt Patient
Health Information=0 or 1

When set to 1, Dragon
automatically encrypts
interim files it auto-
matically creates, to
avoid the possibility of
those files being inad-
vertently accessed by
unauthorized personnel.

Encrypt patient health
information

Data Collector
Batch Mode=0 or 1

When set to 1, turns on a
process that auto-
matically collects data to
help improve speech rec-
ognition in the future. The
process sends the data to
Nuance over the Internet,
but does not send any per-
sonal information - it col-
lects recorded dictation
and the corresponding
text. Collecting data for
Nuance is optional.

Enable scheduled Data
Collection

Allow Users to Opti-
mize=0 or 1

When set to 1, turns on a
process that auto-
matically runs an opti-
mization process on
speech recognition for the
currently open user pro-
file.

Enable scheduled Accu-
racy Tuning

Allow Users to Configure
Tasks=0 or 1

Turning this option on lets
users set the schedule for
accuracy tuning and data
collection tasks. Other-
wise, these tasks take
place on a default sched-
ule.

Let the user choose when
to run Accuracy Tuning
and Data Collection



Understanding Network and Connection Settings in roamingdef.ini File

Although you cannot edit the roamingdef.ini file because it is encrypted, you should know that the following
information is in the file. You can modify these settings through the Administrative Settings dialog only. For
more information on values for each option, refer to the Dragon Administrator Guide Help file available through
the product menu:

Options UI Element/Description

[<Network Settings>] Display Name assigned to the network directory where Roam-
ing User Profiles are stored, in the Network Directories box.

location Address. Path to a network directory, web server, or secure
web server where Roaming User Profiles are stored.

HTTP Settings

type Authentication Type.

authscheme=1 Indicates authentication is required.

queryforuserpassword Prompt for user and password check box.

authuser <domain>\<username> required to log in.

authpassword Actual password required to log in.

followredirects Follow Redirects. Never, Always, or Same Scheme Only.

keepalive Keep Connection Alive check box.

locktimeout Lock under Timeouts. Number of seconds after timeout
expires to lock the connection.

connectiontimeout Connection under Timeouts. Number of seconds after timeout
expires to close the connection.

con-
nectiontimeoutinactivity

Type under Timeouts. Set if you selected Inactivity option.

con-
nectiontimeoutabsolute

Type under Timeouts. Set if you selected Absolute option.

firewall Firewall and Proxy Servers. Set if a firewall is configured.

proxy Use Proxy Server check box. Set if checked.

proxyserver Network Location. URL to the web server.

firewalltype Type. Type of firewall represented by a number.

firewallhost Server. Name of server for the firewall.

firewallport=1080 Port. Port used by the proxy server or firewall. 1080 is the
default.

firewalluser Username. Login name of the admin user who can access the



firewall.

firewallpassword Password. Password to log in to the firewall.

firewalldata Firewall Data or Proxy Authorization. Special authentication
string for firewall or proxy server, if applicable.

SSL Settings (HTTPS)

sslcertstore Certificate store text box with no label. Name of the cer-
tificate.

sslcertstorepassword Certificate Store Password.

sslcertstoretype Certificate Store Type, indicated by numeric designation.

useopenssl Using OpenSSL check box.

opensslcipherlist Cipher List.

opensslcafile Certificate Authority File.

opensslcadir CA Directory.

tls1

ssl3

ssl2

pct1

SSL Enabled Protocols

Carrying Out an Administrative Installation with .bat File

A straightforward way to install Dragon from the command line to a server is to carry out an administrative
installation using a .bat file.

Caution: Only advanced users should attempt any type of administrative Installation.

Note: A script for carrying out a full administrative installation, including installation of Visual C++ Runtime for
Dragon, is provided in the admininstall.bat file at the top of the directory structure on the DVD. The script pro-
vided includes a bare minimum of the options available, so you might want to read through the Installation
using the Dragon command line to find out about other options you might use.

Understanding the script in admininstall.bat

Below are some of the lines from the script in the admininstall.bat file, a batch file that un-compresses setup
files into a network location for installation using SMS or another service. Since any system to be installed
might be a 32-bit system or a 64-bit system, the batch file places a different vcruntime on the server for each
type of system.

To run the batch file, you enter admininstall.bat and follow it with three arguments: the locations of the vcrun-
time source file for 32-bit systems, the vcruntime source file for 64-bit systems, and the Dragon .msi file, in
that order. Both 32-bit and 64-bit vcruntime files must be available for the .bat file to run.

Near the top of the batch file, you see the lines that check the parameters entered and if the parameters passed
are not acceptable, execute a routine that handles that situation:



:rem //Check and analyze input parameters

if .%1.==.. goto bad_args

if .%2.==.. goto bad_args

if .%3.==.. goto bad_args

If the arguments you pass when you enter the command are acceptable, the batch file sets the NETWORK_
VCRUNTIME_DIR variable to the first argument, the NETWORK_VCRUNTIME_X64_DIR to the second and NET-
WORK_DNS_DIR to the third:

set NETWORK_VCRUNTIME_DIR=%1%

set NETWORK_VCRUNTIME_X64_DIR=%2%

set NETWORK_DNS_DIR=%3%

Notice that there are two VCRUNTIME variables. The first is for a 32-bit system and the second for a 64-bit sys-
tem. The script needs both to carry out all the action.

In the next section of the batch file, you see the lines that install Visual C++ Runtime for Dragon, which must be
installed before you can install Dragon. The batch file first installs 32-bit machine vcruntime and displays mes-
sages as it progresses:

echo Installing Visual C++ Runtime for Dragon NaturallySpeaking...

To install Visual C++ Runtime for Dragon, the script uses the full path to vcruntime.exe and passes it several
options:

■ /a to indicate it is an administrative installation (to a server)

■ /L option followed by the language ID

■ /v option followed by a series of MSI installation options all enclosed in quotation marks, including:

o TARGETDIR to indicate where to put the image resulting from an administrative installation

o /qb to display only a basic GUI

o /L to indicate the types of messages to log and the file to log them in

ISSetupPrerequisites\VCRuntime\vcruntime.exe /a /l1033

/v"TARGETDIR=%NETWORK_VCRUNTIME_DIR% /qb /L*v %TEMP%\admininstall.log"

Note: An administrative installation should always use the TARGETDIR option instead of the INSTALLDIR option.

The batch file then installs 64-bit vcruntime using the full path to vcruntime_x64.exe and passes it the same
options:

echo Installing Visual C++ Runtime for Dragon NaturallySpeaking 64bit (x64)...

ISSetupPrerequisites\VCRuntime\vcruntime_x64.exe /a /l1033

/v"TARGETDIR=%NETWORK_VCRUNTIME_X64_DIR% /qb /L*v %TEMP%\admininstall.log"

If you have Version 10, rather than Version 10.x or 11, you have only the 32-bit version and need to use a dif-
ferent path:



ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-ADE12FB7DEC5}\vcruntime.exe

/a /l1033

/v"TARGETDIR=%NETWORK_VCRUNTIME_DIR% /qb /L*v %TEMP%\admininstall.log"

When the installation of Visual C++ Runtime succeeds or fails, the batch file displays the appropriate message.

Finally, the log file installs Dragon, using a single line of code that calls the setup.exe command and passes it:

■ /a option — Indicates administrative install

■ /s option for a silent no-GUI installation

■ /v option to indicate msiexec options follow, enclosed in quotation marks

The msiexec options with /v include /qb for display of a basic GUI during the process, the TARGETDIR setting,
and a /L with a series of log file options, including the name and location for the log file:

echo Installing Dragon NaturallySpeaking...

setup.exe /a /s /v"/qb TARGETDIR=%NETWORK_DNS_DIR%

/L*v %TEMP%\admininstall.log"

When the installation of Dragon succeeds or fails, the batch file displays an appropriate message. The
remainder of the file handles errors and cases where bad arguments are passed on the command line.

Modifying admininstall.bat

You can modify the admininstall.bat file by adding to and changing the options you pass for installation Visual
C++ Runtime, then Dragon. You can add more options and/or modify the options shown here. For more on
installation options, refer to Installation using the Dragon command line or these summaries:

■ MSI Options Specific to Dragon

■ MSI Options for Installing Dragon Features/Advanced Options

■ Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties

■ MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

Install Dragon on an initial Machine and choose the default settings

Before you proceed, you should be familiar with installing the product on a single machine from the DVD. For
more information, see Installing, modifying and upgrading Dragon.

The initial installation is used to set default values for the Administrative, User and Auto-Formatting options.
These options can then be used to install on other machines using the same values.

Even if you are installing from a server, you should run through the initial installation below first. For more infor-
mation on installing from a server, proceed to Overview of the Network Installation of Dragon from a Server.

Caution: If you want to set any administrative settings, be sure you have Windows administrator privileges.
Administrator rights are not required to create a user profile or use the software after installation.

Before you begin:

■ Install any pending Windows updates and reboot the machine when you are finished.

■ Close all open applications.



■ Turn off or disable antivirus software; the installation process can sometimes trigger a false virus report.

Note: An alternative to this approach is to use msiexec.exe to install Dragon, covered under Step-by-Step Com-
mand Line Installation with msiexec.exe.

Extracting MSI/MST Files from the Dragon setup.exe

Some minor release of Dragon, Service Pack 1 of Dragon 10 for example, do not include a .MSI file, they are
supplied with a setup,exe.

You can carry out an administrative installation using setup.exe, as follows:

■ Create a server image of Dragon files for later installing clients. You create the image by executing setup.exe
and passing it the /a option and a Dragon-specific option that extracts MST and MSI files from the Dragon
setup.exe file provided.

■ Use the options to extract the MSI/MST Files from the Dragon setup.exe.

Extracting MSI/MST Files from setup.exe

The following setup.exe options are designed to extract .msi/.mst files for Windows Installer-oriented dis-
tributions.

Note: When you install Dragon 11, Dragon installs using the primary language for the product. You cannot
install Dragon using a language that is different than the primary language. For example, when you install
Dragon 11 Professional - English version, Dragon installs using the English language.

If you attempt to use the /l option with setup.exe to install Dragon 11 using a non-primary language, the instal-
lation process uses the primary language for that edition of Dragon and ignores the /l option.

These options do not install any files, but rather extract an installable set of files into the server directory you
specify.

Option Description

/a Administrative installation. Instructs setup.exe to perform an
administrative installation to a network for use by a workgroup
instead of a normal installation. This option is required when try-
ing to extract the .msi files.

An administrative installation installs a source image of the
application onto the network. The image is similar to a source
image on a CD or DVD. Users in the workgroup who have
access can then install the product over the network from this
source image.

/v"<msiexec options
>"

Passes msiexec options to Windows Installer. See table of
msiexec options for details. This option is required when trying
to extract the .msi files.

EXTRACT-
FILES="c:\xyz"

For installing Version 10 Service Pack 1 only. Indicates the direc-
tory where the extracted .msi/.mst files are to be written. Long
path names containing spaces need to be in quotation marks
escaped by having a backslash precede each quotation mark
(\"). This property is required to extract the .msi files. If the
directory you specify does not exist, the installer creates it.



Here is a sample command line to extractmsi files from a sin-
gle executable:

setup.exe /a /s /v"EXTRACTFILES=c:\temp\msifiles"

TAR-
GETDIR=”C:\xyz”

Use with administrative installations only. Indicates the full path
to where to install the image of Dragon.

Using .MSI/.MST Files for Custom Installations Example

Using .MST files you can tailor the MSI installation without changing the setup.exe file that Nuance provides.

Note: When you install Dragon 11, Dragon installs using the primary language for the product. You cannot
install Dragon using a language that is different than the primary language. For example, when you install
Dragon 11 Professional - English version, Dragon installs using the English language.

If you attempt to use the /l option with setup.exe to install Dragon 11 using a non-primary language, the instal-
lation process uses the primary language for that edition of Dragon and ignores the /l option.

Step1: Running setup.exe to Extract .MSI and .MST Files

The following sample command line extracts the Dragon NaturallySpeaking 10.msi and the .MST file used for
installing Dragon :

setup.exe /a /s /v"EXTRACTFILES=c:\temp\MSIfiles /qn"

Caution: The first time you try any command line, you should not run it in Silent mode, because if you have neg-
lected to provide required information, you then receive a GUI prompt for that information.

Next, you specify the extracted .MSI and .MST files in a command line to install Dragon . The next two exam-
ples show how these files are used running first setup.exe, then msiexec.exe.

Step 2: Passing MST File to setup.exe to Install Dragon

This sample command line launches setup and installs Dragon into the C:\Dragon directory:

setup /a /s /v"INSTALLDIR=\"C:\<full_path>\Dragon\" /qn

Alternative Step2: Passing MST File to msiexec.exe to Dragon

Before actually use the MST file you extracted in the previous step to install Dragon on the command line with
msiexec.exe, you must install Visual C++ Runtime for Dragon, as outlined here.

1. Find the ISSetupPrerequisites/VCRuntime directory on the product DVD and open it. In the directory you find
the vcruntime.exe and vcruntime_x64.exe files. (If you are installing Version 10 rather than Version 10.x or 11,
look in the ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-ADE12FB7DEC5} directory instead.)

2. Copy the vcruntime files to your server or to another accessible location. These .exe files install Visual C++
Runtime for Dragon. Run vcruntime.exe on each 32-bit machine where you intend to install Dragon and vcrun-
time_x64.exe on each 64-bit machine.



Caution: Do not attempt to extract the .msi file from either vcruntime.exe or vcruntime_x64.exe. Installing the
Visual C++ Runtime for Dragon as part of an msiexec.exe command line installation of Dragon is not rec-
ommended and not supported.

3. After you have installed Visual C++ Runtime for Dragon, enter a command line like the following, which dem-
onstrates how to use the .msi file you extracted earlier with setup.exe to do an administrative installation of the
SDK Client Edition:

msiexec /a "D:\Dragon SDK Client Edition 10.msi" /l*v %TEMP%\dgnsetup.log /q

The /q option runs the installation in Quiet mode.

For more on using the Microsoft Windows Installer, refer to http://msdn2.microsoft.com/en-us/li-
brary/Aa372866.

Installation using the Dragon installation process

Perform the following steps to use the user interface of the Dragon installation process:

1. Insert the product DVD in the DVD drive. If the installation does not start, run setup.exe from the DVD.

2. Choose the Custom installation with appropriate languages and vocabularies.

3. Choose the Custom installation with appropriate vocabularies.

4. Choose the following check boxes under Additional options to have additional dialog boxes pop up at the end
of the installation, where you can make changes that affect all users dictating on this computer.

■ Modify the application's settings for all user profiles - Displays the Options dialog box at the end
of the installation.

■ Modify the administrative settings - Displays the Administrative Settings dialog box at the end of
the installation, where you set up the Roaming feature, where to backup your user profiles, and
who can modify commands/vocabularies.

■ Auto-Formatting options - Displays the Auto-Formatting dialog box at the end of the installation,
where you apply uniform formatting to all documents dictated at this installation; for example,
formats for dates, times, and phone numbers.

4. When the Options dialog box appears, select the default options that should apply to all client installations and
click OK. This dialog box is where you set up all the options under the various tabs (Correction, Command,
and so on). In Dragon Medical, you can also program custom actions into the buttons on the PowerMic I and
PowerMic II microphones.

Note: Settings under the Playback/Text-to-Speech tab are not saved. To include Text-to-Speech as a feature
of your installation, work with options in Summary: MSI Options for Installing Dragon Features/Advanced
Options.

Note: At least one supported third-party indexing/search software should be installed on the system before
you install Dragon, or the Enable Desktop Search commands check box will not only be unchecked, but will
not be available to be checked. Dragon supports Google Desktop and Microsoft Vista Search.

5. When the Auto-Formatting dialog box appears, select Auto-Formatting options to apply to all client instal-
lations and click OK.

6. When the Administrative Settings dialog box appears, if you want to set up Roaming User Profiles, set the
options under Roaming User Profile (to set the HTTP or HTTPS settings under the HTTP Settings or HTTPS Set-
tings button, you must have either http:// or https:// in front of the network directory path); whether you

http://msdn2.microsoft.com/en-us/library/Aa372866
http://msdn2.microsoft.com/en-us/library/Aa372866
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have Roaming User Profiles or not, set the options under Miscellaneous and Scheduled Tasks tabs and click
Apply for each; then, when you have set all the settings, click OK.

7. Dragon has saved the configuration you created with running natspeak.exe in the nsdefaults.ini and roam-
ingdef.ini files (the roamingdef.ini file is created only if you set up Roaming User Profiles). You can find these
.ini files under
C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking11\.
These .ini files are now considered customized files, because they now they contain the custom settings that
will be applied to each of the DNS client installations you deploy. Retrieve the nsdefaults.ini and roam-
ingdef.ini files and copy them to a directory where you can access them from the other client machines. (If
you did not run natspeak.exe on the command line, you do not find a roamingdef.ini file; in that case, you can
use a roaming.ini file from an existing installation whose settings you’d like to replicate. If you did not change
the Network Settings, you do not need a roamingdef.ini or roaming.ini file at all.)

You are now ready to install the same configuration you just established here onto other machines.

Notes:

■ If you are installing Dragon on more than one client machine and over a network, you can use the same .ini
files with the MSI Installer (msiexec). You also use SMS Server or another server-based program that pushes
the installation out to several clients at once. Even if you are installing from a server, you should run through
the initial installation before you carry out the administrative installation. Then, for more information on
installing from a server, proceed to Overview of Pushing Client Installation from Server.

■ When you install Dragon 11, Dragon installs using the primary language for the product. You cannot install
Dragon using a language that is different than the primary language. For example, when you install Dragon 11
Professional - English version, Dragon installs using the English language. If you attempt to use the /l option
with setup.exe to install Dragon 11 using a non-primary language, the installation process uses the primary
language for that edition of Dragon and ignores the /l option.

Install the Same Configuration on Additional Machines

Note: If you chose Enable Desktop Search Commands on the Commands tab during the initial installation, you
must install Google Desktop or Microsoft Vista Search before you install Dragon; otherwise, that option does not
take effect..

1. Be sure you can access the .ini files you created in the previous procedure from the computer you will be
installing on or copy the files to a local path on the client machine where you are about to install Dragon.

2. Be sure you have the Dragon serial number (or the group serial number, if you are installing Dragon to mul-
tiple computers on a network).

3. Be sure all mapped drives you plan to use are mapped on individual client machines where you are dis-
tributing the installation.

4. Install any pending Windows updates and reboot the machine.

5. Open a command line window (Start > Run cmd).

6. Insert the product DVD in the DVD drive and search the DVD for the path where the Dragon setup.exe is
located.

7. On the computer where you are installing Dragon, to install the same configuration you created during the ini-
tial installation, enter the following on the command line (using the customized nsdefaults.ini file) of a single
client. You pass the Dragon serial number for the SERIALNUMBER option and the full path to the nsdefaults.ini
file using the DEFAULTSINI option (this line assumes no Roaming User Profiles):

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##



INSTALLDIR=\"C:\<full_path>\Dragon11\"
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

/L*v C:\Logs\logfile.log

Note: The full path for the DEFAULTSINI setting uses escaped out quotation marks (preceded by a backslash)
only when there are spaces in the full path.

Caution: The first time you test any installation, you should pass /q rather than /qn so that if you have neg-
lected to provide information about a setting that does not have a default, you receive a GUI prompt for that
information.

8. If you entered a network address in the Network Directories box and set up HTTP or HTTPS settings in the
Roaming tab of the Administrative Settings dialog during the initial installation, those settings are transferred
to your client machines only if you include the ROAMINGUSERINI option, set to roamingdef.ini:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR=\"C:\<full_path>\Dragon11\"
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"

/L*v C:\Logs\logfile.log

You include the bolded portion of the above command lines so that if something goes wrong during the instal-
lation, you receive messages about it. You pass /L and a series of sub-options followed by a log file name to
have the installation log errors and other messages related to the process. (You can send the log file to tech-
nical support should any issues arise.)

Note: You can also use the /qn option to install the product in Quiet mode, where no GUI or other messages
appear. Another option, the /passive mode, runs the entire installation unattended, but displays a progress
bar. However, the first time you run any installation command line, you should not use the /qn option,
because turning off the GUI also turns off any messages that help you determine any problems with that com-
mand line. To use the /qn option, add it to the end of the command line:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR=\"C:\<full_path>\Dragon11\" DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
/L*v C:\Logs\logfile.log /qn

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR=\"C:\<full_path>\Dragon11\" DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\" /L*v C:\Logs\logfile.log /qn

Creating Custom Installation Using Microsoft Custom Install Wizard

If you are installing Dragon on a network, you can create a custom installation program using a set of tools
available from Microsoft.

1. Download and install the tools

2. Run the wizard

You are then ready to use the custom installer to install the product.



Installing the Microsoft Custom Installation Wizard

The Microsoft Custom Installation Wizard is part of the Microsoft Office Resource Kit Tools. To install the Custom
Installation Wizard:

1. Download the Office Resource Kit Tools (OrkTools.exe) from: http://ww-
w.microsoft.com/office/orkarchive/xpddl.htm. The OrkTools.exe self-extracting executable (EXE) file installs
the core Office XP Resource Kit tools on your computer through a single Setup program.

2. After downloading OrkTools.exe, to install the tools, you either double-click the executable or select Start >
Programs > Microsoft Office Tools > Microsoft Office XP Resource Kit Tools.

After you install the tool, you use its Custom Installation Wizard to create your custom installation. For details
on using the wizard, proceed to Modifying setup Properties for Custom Installation.

Modifying setup Properties for Custom Installation

The following explains how to modify setup properties for a custom installation of Dragon. This example shows
how to add to the installer configuration one of the many MSI options you can set for installing Dragon, the SERI-
ALNUMBER property. (You can add any options available to MSI on the command line.)

1. Start the Microsoft Custom Installation Wizard by choosing Start > Programs > Microsoft Office Tools > Micro-
soft Office XP Resource Kit Tools, and then click Custom Installation Wizard. The Custom Installation Wizard
screen displays:

2. Click Next.

3. On the Open the MSI File page of the wizard, shown below, select the .MSI file you want to use to create a cus-
tom installation. The compiled .MSI file is located on your installation CD. The files are named:

http://www.microsoft.com/office/orkarchive/xpddl.htm
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http://www.microsoft.com/office/orkarchive/xpddl.htm


■ Dragon NaturallySpeaking or Dragon Medical: Dragon NaturallySpeaking 11.msi

■ Dragon SDK Client Edition (DSC): Dragon SDK Client Edition10.msi

■ Dragon SDK Server Edition (DSS): Dragon SDK Server Edition10.msi

4. The following example uses Dragon NaturallySpeaking 10.msi.

5. Click Next.

6. Click Yes when you see the following message:

7. On the Open the MST File page of the wizard, select Create a new MST file.

8. Click Next to continue.

9. On the Select MST File to Save page of the wizard, select a file name and path for the MST file you are cre-
ating:



10. Click Next.

11. On the Specify a Default Path and Organization page, select the default path for the installation. By default,
Dragon installs in \Program Files\Nuance\NaturallySpeaking11.



12. Click Next.

13. On the Remove Previous Versions page, keep the default selections and click Next. This page applies only to
Microsoft Office and does not affect the Dragon installation.

14. Click Next to keep all the defaults when you come to the Set Features Installation States page, where you
select particular components to install. The illustration here shows some of the Medical vocabularies you



might choose:

15. On the next several pages of the wizard, click Next on each, and proceed until you reach the Modify Setup
Properties page. All the pages in between apply only to Microsoft Office or do not affect the Dragon SDK Client
Edition installation.

■ Customize Default Application Settings page

■ Change Office User Settings page

■ Add/Remove Files page

■ Add/Remove Registry Entries page

■ Add, Modify, or Remove Shortcuts page

■ Identify Additional Servers page

■ Specify Office Security Settings page

■ Add Installations and Run Programs page



16. Use the Modify Setup Properties page, shown below, to add, modify, and set the MSI options of your custom
installation.

17. Click the Add... button to display the Add/Modify Property Value dialog box, where you modify the MSI instal-
lation options. In this example, we add and set the SERIALNUMBER option.

18. In the following Add/Modify Property Value page, enter the new property name SERIALNUMBER and a valid
serial number, then click OK:

19. 19. Note that the Modify Setup Properties page re-displays with the updated information. For example:



20. Continue adding or modifying other MSI options that apply for your environment. Once you are done, click
Next.

21. On the Save Changes page, click Finish.

22. 22. When the Custom Installation Wizard page appears, click Exit. This screen displays the location of Win-
dows Installer transform (.MST file) that you created.

After you save changes, you can use the resulting .MST file to manage an installation through a Group Policy in
Active Directory Services.

You are now ready to use the custom installer you created to install the product.

Installing the Citrix Client Update using MSI installer

Dragon includes support for deploying and running Dragon on a Citrix server.

To install with Citrix, be sure you install Visual C++ Runtime for Dragon and publish it as an application in Citrix
before you install Dragon. You can use the Visual C++ Runtime for Dragon installation portion of the admin-
install.bat file to carry out the installation and there are no special options for Citrix.

If you intend to dictate from the Citrix client, before you run Dragon for the first time from that client, you must
run the Citrix Client Update.

You can use the native Windows Installer (MSI) included with Dragon to install the Citrix Client Update during an
MSI installation. The compiled Citrix Client Update.MSI file (vddnspatch.msi) is located on your installation CD.
There are no options for vddnspatch.msi.



See the Dragon Administrator’s Guide Help file for more information on installing and using Dragon on a Citrix
server.

Installation using the Dragon command line

When you install Dragon 11, Dragon installs using the primary language for the product. You cannot install
Dragon using a language that is different than the primary language. For example, when you install Dragon 11
Professional - English version, Dragon installs using the English language.

If you attempt to use the /l option with setup.exe to install Dragon 11 using a non-primary language, the instal-
lation process uses the primary language for that edition of Dragon and ignores the /l option.

Perform the following steps to use the Dragon command line:

1. Open a command line window (Start > Run and enter cmd).

2. Insert the product DVD in the DVD drive, search the DVD for the path where the Dragon setup.exe is located,
and switch directories to the path on the product DVD where the Dragon setup.exe is located.

3. Enter the following command line to install Dragon on this initial machine (ignore any errors you receive
regarding the serial number, as it is not required for this in initial installation, unless you plan to dictate
later):

setup.exe /s /v"INSTALLDIR=c:\Dragon11 /L*v C:\Logs\logfile.log /qn"

The /s option sets the silent option for the every .exe that setup.exe provides a wrapper for, including the vcrun-
time.exe service that setup.exe automatically installs for you, so that no GUI pops up. By contrast the /qn
inside the quotation marks after /v sets the silent option for the Dragon installation.

The /v option introduces any series of msiexec.exe options you want to pass to the Windows installer, all
enclosed in quotation marks after the /v, with no space allowed between the /v and the opening quotation mark.
Among the options inside the quotation marks are:

■ INSTALLDIR — Indicates the full path to where you want Dragon installed

■ /L*v — (either upper or lowercase) Indicates the log file where messages about the installation should be
written

■ /qn — (Quiet mode—also called Silent mode—no GUI) Turns off the Dragon GUI

Caution: The first time you test any installation, you should not run it in Silent mode, because if you have neg-
lected to provide information about a setting that does not have a default, you receive a GUI prompt for that
information. You should initially pass the /L*v option because it runs the entire installation GUI. When the Wel-
come dialog appears, you can stop and look into the log file., where you can search for Command line to verify
that all command line parameters are being incorporated. The line you find will have this format:

MSI (c) (##:##)[##:##:##:###] Command Line: <OPTION>=<value> <OPTION>=<value> ...

The above command line is to install the primary language of the Dragon product.

Logging errors and other messages

Sub-options for /L indicate the types of messages to send to the log:



Sub-option Type of Message to Log

i Status messages

w Nonfatal warnings

e All error messages

a Start up actions

r Action-specific records

u User requests

c Initial UI parameters

m Out-of-memory or fatal exit information

o Out-of-disk-space messages

p Terminal properties

v Verbose output

x Extra debugging info (Windows Server 2000 only)

+ Append to existing log file

* Wildcard. Log all info except v and x options

*vx Log all info including v and x options

Running natspeak.exe to Set Options

When the installation completes, you then set up the configuration on this initial machine by running natspeak
up to three times, in the steps that follow. All steps are optional; by skipping a step, you are choosing to accept
the default values for the options applicable for associated options.

1. On a workstation PC where Dragon is installed, close Dragon if it is running.

2. From the Windows Start menu, select All Programs > Accessories > Command Prompt to open the Command
Prompt window.

3. Switch to the Program directory. The default is:
C:\Program Files\Nuance\NaturallySpeaking11\Program

4. Enter the following natspeak command:
natspeak.exe /setdefaultsoptions



5. When the Options dialog box appears, select the default options that should apply to all client installations and
click OK. This dialog box is where you set up all the options under the various tabs (Correction, Command,
and so on). In Dragon Medical, you can also program custom actions into the buttons on the PowerMic I and
PowerMic II microphones.

Note: Settings under the Playback/Text-to-Speech tab are not saved. To include Text-to-Speech as a feature
of your installation, work with options in Summary: MSI Options for Installing Dragon Features/Advanced
Options.

Note: At least one supported third-party indexing/search software should be installed on the system before
you install Dragon, or the Enable Desktop Search commands check box will not only be unchecked, but will
not be available to be checked. Dragon supports Google Desktop and Microsoft Vista Search.

6. Enter another natspeak command:
natspeak.exe /setdefaultformattingoptions

7. When the Auto-Formatting dialog box appears, select Auto-Formatting options to apply to all client instal-
lations and click OK.
For example (Dragon Medical):



8. Enter a final natspeak command:
natspeak.exe /setdefaultadministrativeoptions

9. When the dialog box appears, if you want to set up Roaming User Profiles, set the options under Roaming
User Profile (to set the HTTP or HTTPS settings under the HTTP Settings or HTTPS Settings button, you must
have either http:// or https:// in front of the network directory path); whether you have Roaming User Pro-
files or not, set the options under Miscellaneous and Scheduled Tasks tabs and click Apply for each; then,
when you have set all the settings, click OK.

10. Dragon has saved the configuration you created with running natspeak.exe in the nsdefaults.ini and roam-
ingdef.ini files (the roamingdef.ini file is created only if you set up Roaming User Profiles). You can find these
.ini files under C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking11\.

Note: If you do not find the nsdefaults.ini file in the sub-folders under All Users, navigate to All



Users.WINDOWS, or administrator, or any other Documents and Settings sub-folders for other users on this
workstation until you locate the nsdefaults.ini file. It’s possible that the workstation was configured so that a
different “user” folder is the default for application data for Nuance and other applications.

These .ini files are now considered customized files, because they now they contain the custom settings that
will be applied to each of the DNS client installations you deploy. Retrieve the nsdefaults.ini and roam-
ingdef.ini files and copy them to a directory where you can access them from the other client machines. (If
you did not run natspeak.exe on the command line, you do not find a roamingdef.ini file; in that case, you can
use a roaming.ini file from an existing installation whose settings you’d like to replicate. If you did not change
the Network Settings, you do not need a roamingdef.ini or roaming.ini file at all.)

11. When you have located the nsdefaults.ini file, verify that your option settings have been changed. Double-
click the nsdefaults.ini file to open it in a text editor. You should see values defined for the options you
changed.

Example: If the Capitalize ‘allergy’ and ‘allergies’ as ‘ALLERGY’ and ‘ALLERGIES’ option has been turned on,
the nsdefaults.ini file contains this statement:

12. Include the newly created nsdefaults.ini file in your MSI package to distribute the file to all user workstations
where Dragon is installed.

For more on natspeak.exe command line options, refer to natspeak Command Line Switches.

You are now ready to install the same configuration you just established here onto other machines.

Note: If you are installing Dragon on more than one client machine and over a network, you can use the same
.ini files with the MSI Installer (msiexec). You also use SMS Server or another server-based program that
pushes the installation out to several clients at once. Even if you are installing from a server, you should run
through the initial installation before you carry out the administrative installation. Then, for more information
on installing from a server, proceed to Overview of Pushing Client Installation from Server.

Natspeak.exe command line reference

You can use command line options to modify the way that Dragon NaturallySpeaking or Dragon Medical starts
up.

These switches are used in the following syntax:

natspeak /switch

where /switch is one or more switches from table below (each switch is a single word without spaces or
hyphens):

Switch Function

/diagnose Runs Dragon in diagnostic mode to output info to Dragon.log file and exits.

/user
<user>

Automatically loads the user profile.

/topic
<topic>

Automatically loads the topic (Professional/Medical/Legal editions only).



Switch Function

/quick Runs Dragon in QuickStart mode, a mode that starts Dragon without loading a user profile or any speech models on startup
of your computer.

/SetDefault
Options

Options Displays the Options dialog box at the end of the installation.

/SetDefault
Administrative

Options Displays the Administrative settings dialog box at the end of the installation.

/SetDefault
Formattings

Options Displays Auto-Formatting dialog box at the end of the installation.

Other Actions You Can Take on Command Line

Here are other (optional) actions you can take on the command line as part of a silent installation:

Note: In Dragon 11, you enable the QuickStart feature after you install Dragon, not during the installation proc-
ess.

Additional Options for Silent Installations

■ Modifying the Default Installation Directory

■ Configuring Installation of Product Updates

■ Suppressing Reboot of Machine After Installation

■ Installing Same Roaming User Profile Configuration on Additional Machine(s)

Additional Options with Extensive Settings for Silent Installations

■ Revising Day/Time of Scheduled Tasks (Optional)

■ Configuring Local or On-Demand Install of Vocabularies/Text-to-Speech (Optional)

Modifying Default Installation Directory

If you want to set an installation directory other than the default, pass INSTALLDIR="<full path to install>" on
the command line (note that the quotation marks are required only if you have spaces in the path):

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

INSTALLDIR=\"C:\<full_path>\Dragon11\" /L*v C:\Logs\logfile.log /qn"

Note: If the installation directory does not have spaces, note how the INSTALLDIR directory is designated in the
command line:

setup.exe /v"INSTALLDIR=C:\Dragon11 ADDLOCAL=ALL"

If the installation directory has space(s), it is surrounded in quotation marks that are escaped out by having
backslashes precede them (shown in bold):



setup.exe /v"INSTALLDIR=\"C:\NaturallySpeaking11\" ADDLOCAL=ALL"

Caution: The first time you try any installation, you should not run it in Silent mode, because if you have neg-
lected to provide information about a setting that does not have a default, you receive a GUI prompt for that
information.

Configuring Installation of Product Updates

If you want the individual client machine to download product updates to Dragon over the web, you would set
the PRODUCTUPDATEFLAG option to 1 (option checks the check box). If you prefer to install the updates on the
severs and later distribute them to client machines, set this option to 0 (unchecks the check box). If your enter-
prise does not install service packs provided by Nuance, Nuance recommends you set this flag to -1:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

INSTALLDIR=\"C:\<full_path>\Dragon11\"

PRODUCTUPDATEFLAG=-1 /L*v C:\Logs\logfile.log /qn"

Suppressing Reboot of Machine After Installation

To suppress rebooting of the machine after installation of Dragon completes, you can pass Microsoft's REBOOT
option set to ReallySuppress. Using this option also suppresses the reboot sometimes required by the instal-
lation of Visual C++ Runtime for Dragon, which setup.exe installs in the background. Using this option is highly
recommended if you are executing a silent installation (But if system updates are pending, rebooting is required
for DNS to work normally.

REBOOT=ReallySuppress

The altered command line would look like this:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

INSTALLDIR=\"C:\<full_path>\Dragon11\" /qn

PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress

/L*v C:\Logs\logfile.log /qn"

Installing the same Roaming User Profile Configuration on Additional Machine(s)

Use the roamingdef.ini file you created during the initial installation as the input for the ROAMINGUSERINI
option in this format (be sure to use the full path to the file when you pass the option):

ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"

The default is empty (no .ini file will be used). Include the ROAMINGUSERINI option in the installation command
line:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

INSTALLDIR=\"C:\<full_path>\Dragon11\"



ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"

/L*v C:\Logs\logfile.log /qn"

The example above assumes that the full path has spaces in it, so it has escaped out quotation marks around
the option value. After you have completed the installation, verify that all options are correctly set on the client
machine.

Revising Day/Time of Scheduled Tasks (Optional)

This section describes how to modify the schedule for Dragon tasks to later take place on each dictation client
machine by passing particular options in a command line installation. This section is a continuation of Instal-
lation using the Dragon command line. When you finish this section, you might want to proceed to Configuring
Local or On-Demand Install of Vocabularies/Text-to-Speech (Optional).

Note: You take the following actions on the client machine to install Dragon on client PCs, not on the machine
where you installed the initial installation and configured default option settings for users.

You can include an additional option on the command line to indicate you want on any or all of the following
tasks carried out on a particular schedule:

■ Acoustic model optimization (ACO) — This task optimizes the acoustic files used to recognize words that the
user trains and speaks. You can set a particular date and time for this optimization to occur. When a speaker
is new to Dragon, you might want to run the optimization more often, after the speaker has worked with
Dragon for a while.

■ Language model optimization (LMO) — This task optimizes the language model (vocabulary files) used to help
recognize words that the user speaks. The model incorporates data from the user’s speech into the language
model he or she is using, ultimately customizing the model for that user profile.

■ Data Collection (DC) — This task automatically collects data that helps improve Dragon’s ability to recognize
speech. You can choose to allow this data to be sent back to Nuance over the Internet on a particular schedule
or choose not to send the data. This process does not collect your personal information.

You turn on/off the above tasks and set the schedule for those you turn on by passing an option called PERIODIC
_TASK to the MSI installer. You set PERIODIC_TASK to a string containing short acronyms for the types of tasks,
aco | lmo | dc, separated by vertical bars. If you do not pass the acronym for the feature, that feature is set to
its default.

After the acronyms for the tasks to schedule, the string for PERIODIC_TASK should include the administrator
login and password, then the schedules that correspond to the acronyms, in the order that they occur in the
string. The schedules use three-letter weekday abbreviations and 24-hour time with two digits for the hour and
two for the minute, separated by a colon. The two schedules are separated by vertical bars and presented in the
same order as their corresponding acronyms. While the acronyms for the tasks are separated from each other
by vertical bars, semicolons separate the group of tasks from the admin user name, password, and group of
schedules.

For instance, to retain the default schedule for data collection and modify schedules for acoustic model opti-
mization to Mondays at 1 AM and language model optimization to Mondays at 6 AM, you would set PERIODIC_
TASK as follows:

PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"

An installation command line including this task setting option might look like the following:



setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

INSTALLDIR=\"C:\<full_path>\Dragon11\"

ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"

PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"

/L*v C:\Logs\logfile.log /qn"

For more information on the PERIODIC_TASK option, refer to MSI Options for Roaming User Profile, Tuning, and
Data Collection Setup.

Configuring Local or On-Demand Install of Vocabularies/Text-to-Speech (Optional)

This section describes how to enable Roaming User Profiles in a command line installation and is a continuation
of Installation using the Dragon command line.

Note: You take the following actions on the client machine where you want to install Dragon, not on the
machine where you carry out the initial installation.

Installing only particular vocabularies locally, others on-demand

When you install Dragon or Dragon Medical on a client machine as outlined in Installation using the Dragon com-
mand line, by default you install all the available vocabularies locally.

If you do not want all of those vocabularies to be installed locally, but to instead have them installed only
if/when a user attempts to deploy a particular vocabulary, you can indicate that fact on the installation com-
mand line by adding the ADDLOCAL option and setting it to the names of the vocabularies to install locally. For
example, say you want to do a partial installation of Dragon Medical and you only want to install the General
Medical vocabulary and the Radiology vocabulary, you set ADDLOCAL to NatSpeak,ENUMedical,ENURadiology
and the command line would appear as follows (NatSpeak must be in the setting of ADDLOCAL, unless you set
ADDLOCAL to ALL; otherwise, the installation fails):

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

INSTALLDIR=\"C:\<full_path>\Dragon11\" PRODUCTUPDATEFLAG=-1

REBOOT=ReallySuppress ADDLOCAL=NatSpeak,ENUMedical,ENURadiology

/L*v C:\Logs\logfile.log /qn"

Note: There must not be any spaces between the arguments specified for ADDLOCAL.

If you want other vocabularies to be available, you set ADDLOCAL to ALL and set the ADVERTISE property to a
list of additional vocabularies. The command line might look like the following:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

INSTALLDIR=\"C:\<full_path>\Dragon11\"

PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress ADDLOCAL=ALL

ADVERTISE=ENUCardiology,ENUEmergency,ENUGastroenterology

/L*v C:\Logs\logfile.log /qn"

Separate the features/vocabularies for ADDLOCAL with commas, but do not put spaces in the list. The names
you must use for the vocabularies consist of a prefix for the language, then the name of the vocabulary, such as



ENU for English and Cardiology to form ENUCardiology. For a list of the exact names for features/vocabularies
you can assign to ADDLOCAL or ADVERTISE on the command line, refer to MSI Options for Installing Dragon Fea-
tures/Advanced Options.

Installing Text-to-Speech feature

To install Text-to-Speech locally, you would include the feature in the list of features for ADDLOCAL; for
instance, you would add TTSENX for Text-to-Speech in English:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

INSTALLDIR=\"C:\<full_path>\Dragon11\"

PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress

ADDLOCAL=TTSENX,NatSpeak,ENUMedical

/L*v C:\Logs\logfile.log /qn"

Links to Summaries of MSI Options

For more information, see these summary topics:

■ MSI Options Specific to Dragon.

■ Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties

■ MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

Upgrading Your Dragon Installation from the Command Line

There are two command line upgrade scenarios:

■ Major Upgrade—Upgrading from Version 9, 9.x, 10, or 10.x to Version 11

■ Minor Upgrade—Upgrading from Version 10 and 10.x to a higher Version 10.x

All of these types of upgrades can either display the GUI or be silent (not display the GUI), except the minor
upgrade, which does not support the silent option. Upgrades to Version 11 are only supported for Version 9.x
and 10.x.

You will not be able to upgrade user profiles with the command line installation. For more information on upgrad-
ing Roaming User Profiles, see the section below. If your user profiles are not Roaming User Profiles, you run
the User Profile Upgrade Wizard after installation completes.

Upgrading Roaming User Profiles

Before you upgrade, if you have Roaming User Profiles, you must upgrade Roaming User Profiles in the Roam-
ing User Profile directory. Then you can upgrade Dragon on the client machines and the Roaming User Profiles
become available as soon as the upgrade is complete.

See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for administrators for
more information.

Background on Roaming User Profiles

Before you upgrade Roaming User Profiles from Dragon NaturallySpeaking or Dragon Medical Version 9.x or
10.x to Version 11, you need to recall some basics about how the Roaming feature works: Each Dragon user has
a master Roaming User Profile that can be opened from any networked computer where Dragon is installed. The



master Roaming User Profiles are stored on a network location. When a master Roaming User Profile is opened
from that central network location, Dragon transfers a copy of that user profile to the Local Roaming User Pro-
file on the computer where the user is dictating.

Recommended Approach

Since the Local Roaming User Profile is a copy of the user data taken from the master Roaming User Profile, it
does not make any sense to directly upgrade the Local Roaming User Profile when you upgrade the local Dragon
installation.

Instead, you should install Dragon 11 directly on the network machine where the Version 9.x or 10.x Master
Roaming User Profiles are located and upgrade those Master Roaming User Profiles directly. After you have
upgraded the master Roaming User Profiles, you can then proceed to upgrade end-user systems that deploy the
Roaming feature.

Notes:

■ Even though the Dragon 11 User Profile Upgrade Wizard supports both mapped drives and UNC paths,
Nuance strongly recommends that you upgrade your Master Roaming User Profiles on a drive on a machine
where Dragon 11 is locally installed. Nuance does not recommend that you upgrade your Master Roaming
User Profiles across a network to either a mapped drive or UNC path; upgrading over a network will take a
undetermined length of time. In addition, the User Profile Upgrade Wizard does not support upgrading
user profiles over an HTTP connection.

■ Upgrading master Roaming User Profiles to Version 11 leaves the 9.x or 10.x master Roaming User Profiles
unchanged, so that the users in your network can run Dragon Version 9.x or 10.1 while you plan your
upgrade.

Step-by-Step Process for Upgrading Roaming User Profiles

1. Plan to upgrade the master Roaming User Profiles at a time when they are not being opened by end users, for
example during the night or on a weekend. Nuance recommends that you back-up your user profiles before
upgrading them.

2. Install Dragon 11 on the machine where the Version 10.x Master Roaming User Profiles are located. If that is
not possible, Nuance recommends that you install Dragon 11 on a separate machine where you will perform
the upgrades.

OR

If you are unable to install Dragon where your Version 10.x Master Roaming User Profiles are located, Nuance
recommends that you:

■ Install Dragon 11 on a separate machine where you will perform the upgrades.

■ Copy Version 10.x Master Roaming User Profiles from their network location to the machine
where Dragon 11 is installed.

■ Upgrade the Version 10.x Master Roaming User Profiles on the machine where Dragon 11 is
installed.

■ Copy the upgraded Version 11 Master Roaming User Profiles to a network accessible directory on
the original network location.

Note: In Dragon version 10.x or earlier, if during the upgrade installation you are prompted to
Upgrade existing user profiles to work with this installation, you can ignore the option, as it does



not affect Roaming User Profiles. You manually run the User Profile Upgrade Wizard later.

3. On the end-user systems where the users dictate, save and close any open user profiles on each Dragon Ver-
sion 10.x system that uses the Roaming feature.

Note: If there is no time when all of your Roaming User Profiles are not used (for example, if you are sup-
porting a hospital where physicians use Dragon during a night shift), you can upgrade different groups of
Roaming User Profiles at different times.

4. On the central network location that stores Version 10.x master Roaming User Profiles, back up the master
Roaming User Profiles to a separate location by using any system backup utility that is implemented at your
facility.

5. On the central network location that stores Version 10.x master Roaming User Profiles, create a new direc-
tory to store the upgraded Dragon 11 Master Roaming User Profiles. Note: Always be sure your upgraded user
profiles are in a location different from that of current user profiles, because if end users see two versions of
each user profile when they try to open a user profile, they will be confused. Nuance recommends that you
keep user profiles from each version in distinct locations.

6. If you did not install Dragon 11 on the machine where the Version 10.x Master Roaming User Profiles are
located, create a directory on the local machine where Dragon 11 is installed to hold all the Master Roaming
User Profiles you plan to upgrade and copy the Version 10.x Master Roaming User Profiles from the network
location to this directory.

7. On the administrator system from where you will upgrade the Master Roaming profiles to Version 11, start
Dragon Version 11 and make sure the Roaming feature is turned off.
To turn off the Roaming feature:

■ Close any open user profiles.

■ Click Tools > Administrative Settings on the menu to display the Administrative Settings dialog box.

■ On the Roaming tab, make sure Enable is not selected.

8. Close Dragon.

9. On the machine where both your Version 10.x Master Roaming profiles and Dragon 11 are installed, select
Start > Programs > Dragon NaturallySpeaking 11 > Dragon NaturallySpeaking Tools > Upgrade
Users. The User Profile Upgrade Wizard opens.

Note: If you did not turn off the Roaming feature in the Administrative Settings dialog box before attempting
to start the User Upgrade Wizard, you receive an error message stating that you cannot upgrade a Roaming
User Profile. If you receive the message, go back to the Administrative Settings dialog and make sure the
Enabled check box is not checked.

10. On the Select User Profiles to Upgrade page, click Add... to select the location of the Version 10.x Master
Roaming User Profiles. The Select User Profiles to Upgrade page now displays a list of user profiles in the
selected directory:



You can continue to use the Add... button to add user profiles from other local locations or use the Remove
button to remove specific user profiles. Click Next to continue.

11. On the Choose Destination page, in the Destination for upgraded user profiles text box, choose the
local location you previously created that will contain the upgrade Version 11 master Roaming User Profiles.
If you do not see the location you want, you can click the Browse button, find the correct location, and click



Next.

12. The Upgrade User Profiles page displays the number of user profiles that the wizard is prepared to
upgrade.

13. Click Begin to start the upgrade process. The upgrade process can take 2-3 minutes or more per user profile,
depending on the speed of your system and your network. You can click Stop at any time to interrupt this
process. The upgrade process creates new master Roaming User Profiles in the destination you selected.

14. Click Finish to complete the upgrading process and exit the User Profile Upgrade Wizard.

Note: The User Profile Upgrade Wizard renames each Version 11 master Roaming User Profile as follows:
<name> (v11). For example, a Version 10.x Master Roaming User Profile named roaminguser1 will be copied
and named roaminguser1 (v11) when upgraded to Version 11. Dragon does not change the Version 10.x
Master Roaming User Profile named roaminguser1.

15. (Optional) If you were unable to install Dragon where your original Master Roaming User Profiles were
located and you copied those user profiles to another machine where Dragon 11 was installed, copy the
upgraded Version 11 Master Roaming User Profiles back to the new network-accessible directory that you
created to store them.

16. Since the User Profile Upgrade Wizard leaves your Version 10.x master Roaming User Profiles unchanged
and in their original network location, your Version 10.x systems can continue to use the Roaming feature
until you upgrade those installations to Version 11 following the steps under "Major and Minor Upgrades:
Silent Upgrade", being sure to have the configuration include having the Roaming feature enabled and the cor-
rect path to the upgraded Roaming User Profiles in the Network Directories settings.

17. Run Dragon on the end-user system and open a user profile.



See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for administrators for
more information.

Major and Minor Upgrades: Silent Upgrade

To upgrade from Dragon Version 10.x to Dragon Version 11, you can use either msiexec.exe or setup.exe. You
can carry out this installation with a GUI or silently. The procedure presented here shows how to upgrade
silently using msiexec.exe.

Overview of Silent Upgrade

If your environment requires that you perform a silent installation and use msiexec.exe, rather than setup.exe,
take these high-level actions in this order:

■ Uninstall the older version of Dragon.

■ Version 10 only: Uninstall the older version of Visual C++ Runtime for Dragon.

■ Install the new version of Visual C++ Runtime for Dragon. Note that there are two versions of vcruntime.exe,
one for 32-bit Windows and another for 64-bit Windows. Use the appropriate version for your enterprise.

■ For major upgrades only: Perform an initial installation of the new version of Dragon on a single machine and
establish the configuration you want to use by calling natspeak.exe on the command line and passing it these
options:

o o /setdefaultoptions

o o /setdefaultformattingoptions

o o /setdefaultadministrativeoptions

When you run the Dragon command line installation silently, the msiexec.exe installer automatically retains
user profiles from the previous version. Later individual users can upgrade their local (but not Roaming User)
profiles when they start Dragon. (For updating Roaming User Profiles, see Before You Upgrade.)

GUIDs for uninstalling

The table below lists GUIDs that you pass to the /x option of msiexec for each version of Dragon and Visual C++
Runtime for Dragon:

Prod & Vers. GUID to pass with /x option

DNS V11 {EFFA53BC-8C04-2E21-3D90-A13B1697B0CA}

DNS V10 and 10.x {E7712E53-7A7F-46EB-AA13-70D5987D30F2}

DNS V9 and 9.x {DDDD90B2-80F2-413A-8A8E-38C5076A7DBA}

VC-Runtime 32-bit {4A5A427F-BA39-4BF0-9A47-9999FBE60C9F}

VC-Runtime 64-bit {4A5A427F-BA39-4BF0-9A47-7777FBE60C9F}

Step-by-Step Upgrade Process

You must follow these steps to set options for your users:

1. If you are upgrading from a previous version of Dragon, copy the nsdefaults.ini and roamingdef.ini files to a
central location so they can accessed later.

2. Open a command line window (Start > Run and enter cmd).



3. Uninstall Dragon Version 10.x with msiexec.exe by passing the installer the /x option followed by the old ver-
sion’s GUID and the /qn option to turn off any GUI.

The correct GUID for each Version you can upgrade to Version 11 on the command line is shown in the adja-
cent table and the example below uses the Version 9.x GUID:

msiexec /x {DDDD90B2-80F2-413A-8A8E-38C5076A7DBA}

/L*v "C:\updatelog.log" /qn

msiexec automatically retains user profiles when you use the silent option.

Caution: The first time you try any upgrade, you should not run it in Silent mode, because if you have neg-
lected to provide required information, you then receive a GUI prompt for that information.

4. For upgrading from Version 9.x, skip this step. If you are upgrading from Version 10 or 10.x (minor upgrade),
uninstall the old version of Visual C++ Runtime for Dragon with msiexec.exe by passing the installer the /x
option followed by the old version’s GUID and the /qn option to turn off any GUI. The example below shows
uninstalling the 32-bit Visual C++ Runtime for Dragon:

msiexec /x {4A5A427F-BA39-4BF0-9A47-9999FBE60C9F}

/L*v "C:\updatelog.log" /qn

To uninstall the 64-bit version, use the alternative GUID shown in the adjacent table.

5. Be sure you have the Dragon serial number (or the group serial number, if you are upgrading Dragon on mul-
tiple networked computers).

6. Be sure all mapped drives you plan to use are mapped on individual client machines where you are dis-
tributing the upgrade.

7. Install any pending Windows updates on clients and reboot as needed before continuing.

8. Insert the product DVD in the drive and search the DVD for the path where the Dragon setup.exe is located.

9. Install the new version of Visual C++ Runtime for Dragon by entering the full path to vcruntime.exe on a 32-
bit system or vcruntime_x64.exe on a 64-bit system:

ISSetupPrerequisites\VCRuntime\vcruntime.exe /S /v"qn /l*v %TEMP%\vcruntime.log"

OR

ISSetupPrerequisites\VCRuntime\vcruntime_x64.exe /S /v"qn /l*v %TEMP%\vcruntime.log"

If you are installing Version 10 rather than Version 10.x or 11, you have only the 32-bit version and use a
slightly different path:

ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-ADE12FB7DEC5}\vcruntime.exe /S
/v"qn /l*v %TEMP%\vcruntime.log"

10. If you are performing a minor upgrade, skip this step. If you are performing a major upgrade from Version
9.x, perform an initial installation on a single machine where you configure the settings of user profile
options, Auto-Formatting options, and administrative settings. You can follow the instructions in Install the
Same Configuration on Additional Machines under Installation using the Dragon command line.



11. Be sure you can access the .ini files from the old installation (minor upgrades) or the .ini files you just created
in the initial installation (major upgrades) from all computers you will be upgrading. (Or copy the files to a
local path on the client machine where you are about to upgrade.)

12. For a major upgrade, install the new version of Dragon with msiexec.exe by passing the installer the /i option
followed by the name of the Dragon .msi file and options like those shown in the sample below:

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-## REBOOT=ReallySuppress
INSTALLDIR="C:\<full_path>\Dragon11"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"

REMOVEOLDPROD=1 /L*v "C:\logfile.log" /qn

To ensure that the entire old version of the product is removed, you pass REMOVEOLDPROD=1 (major
upgrades only, not minor upgrades) so that the process removes the old version of Dragon before installing
the new. In addition, you should be sure to provide the full path to each .ini file you are using.

13. For a minor upgrade, install the new version of Dragon with msiexec.exe the same way as you would the
major upgrade, only passing both REINSTALL or REINSTALLMODE options, as shown in the sample below.
Here REINSTALL is set to ALL and REINSTALLMODE is set to vemus, where /v indicates to reinstall from the
source (reupdating cache), e indicates to install the newer file if one is available, mumeans to rewrite the
registry settings, and s means to reinstall all shortcuts and recache all icons. For more information on the
REINSTALL and REINSTALLMODE settings, refer to MSI Options for Installing Dragon Features/Advanced
Options.

Here is a typical minor upgrade installation line:

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
REBOOT=ReallySuppress
INSTALLDIR="C:\<full_path>\Dragon11"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
REINSTALL=ALL REINSTALLMODE=vamus

/L*v "C:\logfile.log" /qn

Caution: If you do not pass the REINSTALL and REINSTALLMODE options, the minor upgrade will fail.

Using setup.exe for Upgrades

When installing both major and minor upgrades, the setup.exe installer automatically installs Visual C++ Run-
time for Dragon before installing Dragon.

Although the upgrade does not migrate forward the configuration and Roaming User Profile settings from the
earlier version, you can reuse the nsdefaults.ini and roamingdef.ini files you used to install Version 11. You can
also create new .ini files or update existing ones.

When you run setup.exe with a GUI to install a minor upgrade, setup.exe can detect when a previous version of
Dragon exists on a target machine. Once it detects a previous version, setup.exe runs the rest of your instal-
lation in minor upgrade mode, automatically overwriting older files with newer files and adding any missing
files. .



Using setup.exe for Silent Upgrades

If you are upgrading a previous version of Dragon, you must use the REINSTALL=ALL option and REIN-
STALLMODE set to the sub-options that indicate which files to reinstall, usually REINSTALLMODE=vamus. If you
did not originally install in the default location, the INSTALLDIR option is also required. Here is the command
line using setup.exe:

To upgrade silently with setup.exe, you pass the /s option, then pass REINSTALL or REINSTALLMODE options:

setup.exe /s /v"/i "Dragon NaturallySpeaking 11.msi"

SERIALNUMBER=#####-###-####-####-##

REBOOT=ReallySuppress

INSTALLDIR=\"C:\<full_path>\\Dragon11\"

DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"

REINSTALL=ALL REINSTALLMODE=vamus

/L*v C:\logfile.log /qn"

Step-by-Step Command Line Installation with msiexec.exe

Another way to install Dragon from the command line on several dictation client machines is to use the msiex-
ec.exe program from Microsoft. You are required to use msiexec.exe instead of setup.exe if you are installing
Dragon from a server across a network to a single or multiple machines.

In the sections that follow, you carry out these two tasks:

■ Install Dragon on Initial Machine and Establish Configuration

■ Install Same Configuration on Additional Machine(s)

Finding the MSI Installer on the Dragon DVD

The compiledMSI file is located on your installation DVD. The files for each edition are named:

■ Dragon NaturallySpeaking (all editions) or Dragon Medical: Dragon NaturallySpeaking 11.msi

■ SDK Client Edition (DSC): Dragon SDK Client Edition 10.msi

■ SDK Server Edition (DSS): Dragon SDK Server Edition 10.msi

You can double click on one of these .msi files to start the InstallShield Wizard; however, to instead take advan-
tage of available command line options, you can pass the file name as the application to install to the msiex-
ec.exe command using the /i option:

msiexec.exe /i "Dragon NaturallySpeaking11.msi"

Install Dragon on Initial Machine and Establish Configuration

Follow the steps outlined under Step-by-Step Command Line Installation with setup.exe.

Then return here and continue with the next section to install the same configuration on individual client
machines using msiexec.exe instead of setup.exe.



Install Same Configuration on Additional Machine(s)

If you chose Enable Desktop Search Commands on the Commands tab during the initial installation, you must
install Google Desktop or Microsoft Vista Search before you install Dragon; otherwise, that option does not take
effect.

1. Be sure you can access the .ini files you created in the previous procedure from the computer you will be
installing on or copy the files to a local path on the client machine where you are about to install Dragon.

2. Be sure you have the Dragon serial number (or the group serial number, if you are installing Dragon to mul-
tiple computers on a network).

3. Be sure all mapped drives you plan to use are mapped on individual client machines where you are dis-
tributing the installation.

4. Install any pending Windows updates/reboot the machine.

5. Open a command line window by selecting Start > Run and entering cmd.

6. Insert the product DVD in the DVD drive and search the DVD for the path where the Dragon setup.exe file is
located.

7. In the command window, switch to the ISSetupPrerequisite\VCRuntime\ directory inside the directory of the
executable for Dragon. (If you are installing Version 10, rather than Version 10.x or 11, the path to switch to
is ISSetupPrerequisite\{1FAD9007-0FF1-4B05-B7CE-ADE12FB7DEC5} .)

8. On the command line, run the installation of Visual C++ Runtime (requires 4.08 MB of disk space to install):

vcruntime.exe

The Choose Setup Language dialog box appears asking you to select a language for the installation. After you
select the language, an initialization GUI briefly displays, then the InstallShield wizard pops up. To disable the
dialog box that requests the language, pass the /S option (see more options below). To install vcruntime.exe
without seeing either the Choose Language Setup dialog or the InstallShield wizard, you should execute the
command line shown here for 32-bit Windows:

vcruntime.exe /S /v"/qn /l*v %TEMP%\vcruntime.log"

Or the command line shown here for 64-bit Windows:

vcruntime_x64.exe /S /v"/qn /l*v %TEMP%\vcruntime.log"

Caution: The first time you try any installation, you should not run it in Silent mode, because if you have neg-
lected to provide required information, you then receive a GUI prompt for that information.

9. On your product DVD, locate the compiled .msi file for the edition of Dragon you want to install and switch to
that directory.

10. Retrieve the customized nsdefaults.ini and roamingdef.ini files from the computer where carried out the ini-
tial installation.

11. To install Dragon, enter the following command line, using the /i option also using the /qn option to install the
product in Quiet mode, where no GUI appears. You also pass the Dragon serial number for the SERI-
ALNUMBER option, the full path to the nsdefaults.ini file for the DEFAULTSINI option, and the full path to the
roamindef.ini file for the ROAMINGUSERINI option:

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"



ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v "C:\Logs\logfile.log" /qn

Notes:

■ For an administrative installation, you pass the /a option to msiexec rather than the /i option. You also need
to pass the TARGETDIR option instead of the INSTALLDIR option.

■ The first time you test this installation, you should pass /q rather than /qn so that if you have neglected to pro-
vide information about a setting that does not have a default, you receive a prompt asking for that infor-
mation.

The bolded portion of the preceding command line is included so that if something goes wrong during the instal-
lation, you receive messages about it. You pass /L and a series of sub-options to have the installation process
log errors and other types of messages related to the process. (You can then send the log file to Nuance Tech-
nical Support should any issues arise.)

Here are other optional actions you can take on the command line that link you to further instructions, below:

Additional Options for Installations with MSIEXEC.EXE

Note: In Dragon 11, you enable the QuickStart feature after you install Dragon, not during the installation proc-
ess.

Additional Options for Silent Installations

■ Modifying the Default Installation Directory

■ Configuring Installation of Product Updates

■ Suppressing Reboot of Machine After Installation

■ Installing Same Roaming User Profile Configuration on Additional Machine(s)

Additional Options with Extensive Settings for Silent Installations

■ Installing Some Vocabularies Locally/Others Only On Demand

■ Installing Text-to-Speech Feature

■ Reinstalling Dragon with Particular Set of Features

■ Setting Day/Time of Scheduled Tasks

Additionally, you can launch th eOnline Registration Form After Installation

Additional Options for Silent Installations

Note: In Dragon 11, you enable the QuickStart feature after you install Dragon, not during the installation proc-
ess.

Additional Options for Silent Installations

■ Modifying the Default Installation Directory

■ Configuring Installation of Product Updates

■ Suppressing Reboot of Machine After Installation

■ Installing Same Roaming User Profile Configuration on Additional Machine(s)

Additional Options with Extensive Settings for Silent Installations



■ Installing Some Vocabularies Locally/Others Only On Demand

■ Installing Text-to-Speech Feature

■ Reinstalling Dragon with Particular Set of Features

■ Setting Day/Time of Scheduled Tasks

Additionally, you can launch the Online Registration Form After Installation

Modifying Default Installation Directory

If you want to set an installation directory other than the default, pass INSTALLDIR="<path to install>" to
msiexec on the command line:

msiexec /i "Dragon NaturallySpeaking 11.msi"

SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI="C:\<full_path>\nsdefaults.ini"

INSTALLDIR="C:\<full_path>\Dragon11"

/L*v "C:\Logs\logfile.log" /qn

Note: For an administrative installation, you should pass the TARGETDIR option instead of the INSTALLDIR
option.

Configuring Installation of Product Updates

If you want the individual client machine to download product updates to Dragon over the web, you would set
the PRODUCTUPDATEFLAG option to 1 (option checks the check box). If you prefer to let the server download
the updates and later distribute them to client machines, set this option to 0 (unchecks the check box). To not
even display the check box, set the option to -1. For enterprise sites, choose -1 to prevent product updates from
being downloaded.

msiexec /i "Dragon NaturallySpeaking 11.msi"

SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI="C:\<full_path>\nsdefaults.ini"

INSTALLDIR="C:\<full_path>\Dragon11"

PRODUCTUPDATEFLAG=-1 /L*v "C:\Logs\logfile.log" /qn

Suppressing Reboot of Machine After Installation

To suppress rebooting of the machine after installation of Dragon completes, you can pass Microsoft's REBOOT
option set to ReallySuppress. Using this option also suppresses the reboot sometimes required by the instal-
lation of Visual C++ Runtime for Dragon, which setup.exe installs in the background. Using this option is highly
recommended if you are executing a silent installation (But if system updates are pending, rebooting is required
for DNS to work normally.

REBOOT=ReallySuppress

The altered command line would look like this:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon11\" /qn



PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress

/L*v C:\Logs\logfile.log /qn"

Suppressing Reboot of Machine After Installation

To prevent the machine where you are installing Dragon from rebooting automatically after the installation
ends, you can pass Microsoft’s REBOOT option set to ReallySuppress:

REBOOT=ReallySuppress

The altered command line would look like this:

msiexec /i "Dragon NaturallySpeaking 11.msi"

SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI="C:\<full_path>\nsdefaults.ini"

INSTALLDIR="C:\<full_path>\Dragon11"

PRODUCTUPDATEFLAG=-1

REBOOT=ReallySuppress

/L*v "C:\Logs\logfile.log" /qn

Installing the Same Roaming User Profile Configuration on Additional Machine(s)

Use the roamingdef.ini file you created during the initial installation as the input for the ROAMINGUSERINI
option in this format (be sure to use the full path to the file when you pass the option):

ROAMINGUSERINI="Y:\<full_path>\roamingdef.ini"

In the above example, Y: is mapped network drive, accessible from client machines.

Optionally include the ROAMINGUSERINI option in the installation command line. If you do not use this prop-
erty, default settings are assumed.

msiexec /i "Dragon NaturallySpeaking 11.msi"

SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI="C:\<full_path>\nsdefaults.ini"

INSTALLDIR="C:\<full_path>\Dragon11"

ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"

/L*v "C:\nuanceLogs\logfile.log" /qn

After you have completed the installation, verify that all options are correctly set on the client machine.

Launching Online Registration Form After Installation

To have the online registration form for Dragon pop up on the workstation in its browser immediately after the
installation completes, you can pass a option to the WEBREGISTRATION option and set it to 1 (applies only if
you do not use the /qn option). The default is 0 which means registration will not be launched.

WEBREGISTRATION=1

The revised command line would look like this:



msiexec /i "Dragon NaturallySpeaking 11.msi"

SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI="C:\<full_path>\nsdefaults.ini"

INSTALLDIR="C:\<full_path>\Dragon11" PRODUCTUPDATEFLAG=-1

REBOOT=ReallySuppress

WEBREGISTRATION=1 /L*v "C:\Logs\logfile.log"

Installing Some Vocabularies Locally and Others On Demand

When you install Dragon or Dragon Medical on a client machine, by default you install all the available vocab-
ularies locally.

If you do not want all of those vocabularies to be installed locally, but to instead have them installed only
if/when a user attempts to create a particular vocabulary, you can indicate that fact on the installation com-
mand line by adding the ADDLOCAL option and setting it to the names of the vocabularies to install locally. For
instance, to install only an English Legal vocabulary, you would set ADDLOCAL to NatSpeak,ENUMedical and the
command line would appear as follows (NatSpeak must be in the setting of ADDLOCAL, unless you set ADD-
LOCAL to ALL, or the installation will fail):

msiexec /i "Dragon NaturallySpeaking 11.msi"

SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI="C:\<full_path>\nsdefaults.ini"

INSTALLDIR="C:\<full_path>\Dragon11" PRODUCTUPDATEFLAG=-1

REBOOT=ReallySuppress ADDLOCAL=NatSpeak,ENUMedical

/L*v "C:\Logs\logfile.log" /qn

Separate the features/vocabularies for ADDLOCAL with commas, but do not put spaces in the list. The names
you must use for the vocabularies consist of a prefix for the language, then the name of the vocabulary, such as
ENU for English and Cardiology to form ENUCardiology. For a list of the exact names for features/vocabularies
you can assign to ADDLOCAL or ADVERTISE on the command line, refer to Summary: MSI Options for Installing
Dragon Features/Advanced Options.

Particularly in a Dragon Medical installation, you might find it useful to have most vocabularies available but not
locally installed. You can take that action by setting ADDLOCAL to ALL and then setting the ADVERTISE property
to a list of vocabularies to not be installed locally, so that you end up with a subset of the medical vocabularies
locally installed and all others available only on demand. The command line might look like the following:

msiexec /i "Dragon NaturallySpeaking 11.msi"

SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI="C:\<full_path>\nsdefaults.ini"

INSTALLDIR="C:\<full_path>\Dragon11" PRODUCTUPDATEFLAG=-1

REBOOT=ReallySuppress ADDLOCAL=ALL

ADVERTISE=ENUCardiology,ENUEmergency,ENUGastroenterology

/L*v "C:\Logs\logfile.log" /qn

Installing Text-to-Speech Feature

To install Text-to-Speech locally, you would include the feature in the list of features for ADDLOCAL; for
instance, you would add TTSENX for Text-to-Speech in English:



msiexec /i "Dragon NaturallySpeaking 11.msi"

SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI="C:\<full_path>\nsdefaults.ini"

INSTALLDIR="C:\<full_path>\Dragon11" PRODUCTUPDATEFLAG=-1

REBOOT=ReallySuppress

ADDLOCAL=TTSENX,NatSpeak,ENUMedical

/L*v "C:\Logs\logfile.log" /qn

Reinstalling Dragon with Particular Set of Features

Sometimes you want to reinstall Dragon and add or remove particular features of the product. You can also take
this action on the command line using the REINSTALL and REINSTALLMODE options of the MSI installer. You set
REINSTALL to those features you want to install or to ALL.

For example, to install a minor upgrade to Dragon, you might use this command line:

msiexec /i "Dragon NaturallySpeaking11.msi" REINSTALL=ALL REINSTALLMODE=vamus /qn

The vemus options: v indicates to reinstall from the source (reupdating cache), e indicates to install the newer
file if one is available, mu means to rewrite the registry settings, and s means to reinstall all shortcuts and re-
cache all icons. For more information on the REINSTALL and REINSTALLMODE settings, refer to Summary: MSI
Options for Installing Dragon Features/Advanced Options.

Setting Day/Time for Scheduled Tasks

To retain the default schedule for data collection and modify schedules for acoustic model optimization to Mon-
days at 1 AM and language model optimization to Mondays at 6 AM, you would set the PERIODIC_TASK string as
follows:

PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"

An MSI installation command line including the option setting this schedule would look like this:

msiexec /i "Dragon NaturallySpeaking 11.msi"

SERIALNUMBER=#####-###-####-####-##

INSTALLDIR="C:\<full_path>\Dragon11"

DEFAULTSINI="C:\<full_path>\nsdefaults.ini"

ROAMINGUSERINI="C:<full_path>\roamingdef.ini"

PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"

/L*v "C:\Logs\logfile.log" /qn

For more information on the PERIODIC_TASK option, refer to MSI Options for Roaming User Profile, Tuning, and
Data Collection Setup.

Launching Online Registration Form After Installation

To have the online registration form for Dragon pop up on the workstation in its browser immediately after the
installation completes, you can pass a option to the WEBREGISTRATION option and set it to 1 (applies only if
you do not use the /qn option). The default is 0 which means registration will not be launched.

WEBREGISTRATION=1



The revised command line would look like this:

msiexec /i "Dragon NaturallySpeaking 11.msi"

SERIALNUMBER=#####-###-####-####-##

DEFAULTSINI="C:\<full_path>\nsdefaults.ini"

INSTALLDIR="C:\<full_path>\Dragon11" PRODUCTUPDATEFLAG=-1

REBOOT=ReallySuppress

WEBREGISTRATION=1 /L*v "C:\Logs\logfile.log"

MSI Options Specific to Dragon

This section describes the fundamental msiexec.exe options that apply to Dragon NaturallySpeaking and Dragon
Medical. Additional options that apply only to a Dragon installation are listed in:

■ MSI Windows Installer Options

■ MSI Options for Installing Dragon Features/Advanced Options

■ MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

Caution: Before you install Dragon using an MSI installation, you must install Visual C++ Runtime for Dragon on
each dictation machine using the vcruntime.exe available on the product DVD. You cannot install Visual C++
Runtime as part of a typical msiexec.exe installation. For details, refer to Installing Visual C++ Runtime for
Dragon.

If you install Dragon using its setup.exe file, InstallShield installs vcruntime.exe for you.

Dragon command line options do not need to be prefaced by hyphens or slashes.

Notes:

■ In Dragon 11, you enable the QuickStart feature after you install Dragon, not during the installation process.

■ Launching msiexec.exe /i "Dragon NaturallySpeaking 11.msi" XYZ=ABC automatically sets the property
named XYZ to the value of ABC internally and continues the installation. However, if you use setup.exe to
install, you must put all msiexec.exe options you pass it in quotation marks after the /v option.

Unless noted otherwise, all property values are in UPPERCASE.

Options Description

DEFAULTSINI="c:<
path>\
nsdefaults.ini"

Indicates a default settings (nsdefaults.ini ) file that the installer uses to
change the default behavior of the product for all users at installation time. This
file must be in an .ini file format; any settings you want to take effect on clients
must have a section name encased in square brackets as well as the value and
data. If only values and data are set in this file without the section name
encased in brackets, the settings are not propagated on client machines.
Usually, you do not edit the nsdefaults.ini file directly; instead you set
defaults in Dragon’s Options and Administrative Settings dialog boxes.

Follow these steps to create a nsdefaults.ini file for an MSI installation:

Install Dragon on a machine with Windows administrator privileges.

Set options in the Options and Administrative Settings dialog boxes as
required in your environment and save them by closing Dragon.



Copy the nsdefaults.ini file created by this installation of Dragon to a separate
location. By default, the nsdefaults.ini is located in:
C:\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking11\

Use the copied nsdefaults.ini as the input for the DEFAULTSINI option.

SERI-
ALNUMBER=abcde--
fgh-ijkl-mnop-qr

A serial (license) number is required for all installations. You must specify a
valid serial number on the command line.

Note: Specifying a serial number on the command line does not bypass the
serial number checking within setup.

PRO-
DUCTUPDATEFLAG=0
(or 1 or –1)

Sets the default state of the product update check box at the end of installation,
to indicate whether the installation should automatically check the web for prod-
uct updates. Automatic product updates are not supported for enterprise instal-
lations.

A value of 0 (zero) turns the check box off by default, 1 (one) turns it on by
default.

To disable the option entirely (turn the option off and suppress the display of the
check box altogether), set the value to –1.

The default setting is 1 (enables the check box and checks for product updates
by default).

SETDEFAULTS=0 (or
1)

If set to 1, sets the default state of Modify the application’s settings for all
users check box to display the Options dialog box at the end of the instal-
lation. The Options dialog box lets you change Dragon’s standard behavior,
including specifying hot keys, customizing how text is formatted, changing ini-
tial microphone settings, and setting the how often your user profiles are
backed up. Applies only if your installation displays the Installation Wizard.

A value of 0/1 will turn check box off/on accordingly.

With SETDEFAULTS=1, no dialogs display during installation if /qn is used for
Quiet mode installation.

SETADMINS=0 (or 1) If set to 1, sets the default state of Modify the administrative settings
check box to display the Administrative settings dialog box at the end of the
installation. The Administrative settings dialog box lets you set up the Roam-
ing feature, set the backup location of your user profiles, and restrict users
from modifying commands and vocabularies. Applies only if your installation dis-
plays the Installation Wizard.

A value of 0/1 will turn checkbooks off/on accordingly.

With SETADMINS=1, no dialogs display during installation if /qn is used for
Quiet mode installation.



SETFORMATTINGS=0
(or 1)

If set to 1, sets the default state of Modify the administrative settings
check box to display the Auto-Fomatting dialog box at the end of the instal-
lation. The Auto-Formatting dialog box lets you set up visual formats for the
output of the recognized text, including standard abbreviations and other pref-
erences. Applies only if your installation displays the Installation Wizard.

A value of 0/1 will turn check box off/on accordingly.

With SETFORMATTINGS=1, no dialogs display during installation if /qn is
used for Quiet mode installation.

WEB-
REGISTRATION=1 (or
0)

Determines whether or not to launch the on-line product registration form after
the installation completes. 0 disables the product registration. The default of 1
enables display of the form.

MSI Options for Installing Dragon Features/Advanced Options

This section describes additional msiexec.exe options that apply to Dragon NaturallySpeaking and Dragon Med-
ical. Although these options are for msiexec.exe, they are also available for setup.exe if you use them with the
/v“ option.

Other options are listed under:

■ Summary: MSI Windows Installer Options

■ Summary: MSI Options Specific to Dragon.

■ Summary: MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

The following table presents options that apply to a Dragon installation where you select particular features to
install. Unless noted otherwise, all property values are in UPPERCASE.

Options Description

ADDLOCAL=Feature1,Feature2,... or ADD-
LOCAL=ALL

Set the ADDLOCAL property to a list of features to be installed
locally, delimited by commas. To install all features locally
(including user profiles), use ADDLOCAL=ALL on the command
line.

ADVER-
TISE=Feature1,Feature2,FEATURE3,...

Set the ADVERTISE property to a list of features to be available
but not locally installed, delimited by commas. To install all fea-
tures as advertised, use ADVERTISE=ALL on the command
line. The ADVERTISE option overrides the ADDLOCAL option.
The best method for installing a particular set of features is to
set the ADDLOCAL property to ALL and then set the ADVERTISE
property to those features you do not want installed locally. A
list of the features that you can set for installation is listed in
the section after this table.

REINSTALL=Feature1,Feature2,... (or
ALL)

List of features that are to be reinstalled, delimited by com-
mas. To reinstall all features use REINSTALL=ALL on the com-
mand line.

If you set the REINSTALL property, you should also set the
REINSTALLMODE property, to indicate the type of reinstall to



be performed. If the REINSTALLMODE property is not set, then
by default all files that are currently installed are reinstalled
only if the currently installed file is an earlier version (or is not
present). By default, no registry entries are rewritten.

Note that even if REINSTALL is set to ALL, only those features
that were already installed previously are reinstalled. Thus, if
REINSTALL is set for a product that is yet to be installed, no
installation action takes place at all.

For more information, see: http://msd-
n.microsoft.com/library/default.asp?url=/library/en-
us/msi/setup/reinstall.asp

REINSTALLMODE={type of reinstallation
to perform}

String that contains letters indicating the type of reinstall to
perform. Options are case-insensitive and order-independent.
This property should normally always be used in conjunction
with the REINSTALL property. However, this property can also
be used during installation, not just during a reinstall.

By default the REINSTALLMODE=omus to reinstall all files whose checksums are missing or corrupt, rewrite all
registry names, reinstall all shortcuts and re-cache icons. Below is a list of the options with abbreviated def-
initions:

p — Reinstall only if the file is missing.

o — Reinstall if the file is missing or is an older version.

e — Reinstall if the file is missing or is an equal or older version.

d — Reinstall if the file is missing or a different version is present.

c — Reinstall only files whose checksums are missing or corrupt.

a — Force all files to be reinstalled, regardless of checksum or version.

u — Rewrite all required registry entries from the Registry Table that go under HKEY_CURRENT_USER or HKEY_
USERS .

m — Rewrite all required registry entries from the Registry Table that go under HKEY_LOCAL_MACHINE or
HKEY_CLASSES_ROOT. Regardless of machine or user assignment, rewrite all info from these tables: Class,
Verb, PublishComponent, ProgID, MIME, Icon, Extension, and AppID . Reinstall all qualified components. When
reinstalling an application, run the RegisterTypeLibraries and InstallODBC actions.

s — Reinstall all shortcuts and re-cache all icons, overwriting existing shortcuts and icons.

v — Run from the source package, re-cache the local package. Does not apply to new installation of a product
or feature.

If you set REINSTALLMODE without also setting REINSTALL, then the detection modes you specify still
apply and the overwrite mode is used. The REINSTALLMODE property affects only those features selected
for installation using REINSTALL.

For example, to launch a minor upgrade without using setup.exe, you must set the following properties on the
command line:

REINSTALL=ALL REINSTALLMODE=vamus

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/reinstall.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/reinstall.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/reinstall.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/reinstall.asp


To install a minor upgrade using an .msi file, use this command line:

msiexec /i "Dragon NaturallySpeaking11.msi" REINSTALL=ALL REINSTALLMODE=vamus

For more information on REINSTALLMODE and the reinstall option codes, see: http://msd-
n.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/reinstallmode.asp

REMOVEOLDPROD=1 Removes the old version of the product before installing the
new version. Should be used in major upgrades only.

/x<Product.msi|ProductCode> Un-installs the currently installed version of Dragon. You are
required to take this action during upgrading; however, you
should be familiar with the entire upgrade procedure before
proceeding with this option.

MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

This section summarizes the Roaming User Profile, acoustic/language model tuning, and data collection options
for command line installations of Dragon NaturallySpeaking and Dragon Medical. Other options are listed under:

■ Summary: MSI Windows Installer Options

■ Summary: MSI Options Specific to Dragon

■ Summary: MSI Options for Installing Dragon Features/Advanced Options

Options Description

PERIODIC_TASK=<string> Sets schedule for either one, two, or three tasks — an acoustic
model optimization (ACO) task, language model optimization
(LMO) task, and/or data collection (DC) task. You can schedule
each task to run daily or weekly, but need to set the schedule
for each task only once.

The <string> of PERIODIC_TASK contains these arguments, separated by semicolons:

aco | lmo | dc — One, two, or all three of them with a vertical bar separating each. If you do not pass the
acronym for the feature, that feature is set to its default.

Administrator login name. Be sure you use the fully qualified <domain name>\<account name> in a case
where the user is a local administrator but the machine is on a domain.

Administrator password.

When to run the task(s), with times for each of multiple tasks separated by a vertical bar (|). Each scheduled
time should be in the format DayOfWeek, hh:mm, where the day of the week is the three letter abbreviation
(no period), the time is the 24-hour time, and the comma between them is required.

The task runs once a week on the day/at the time you indicate. If you omit the DayOfWeek, the task runs
every day at the time given.

The first of multiple times becomes the schedule for the first task named in the first parameter, the second
time the schedule for the second task, the third the schedule for the third task. If you omit a time by having
two vertical bars with no time between them or by leaving out the first or last time, the corresponding task is
scheduled for a default time.

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/reinstallmode.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/reinstallmode.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/reinstallmode.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/reinstallmode.asp


Default Schedules

Acoustic model optimization (ACO) — Mon, 02:00

Language model optimization (LMO) — Every day, 03:00

Data collection (DC) — Fri, 01:00

Examples of PERIODIC_TASK Settings

A string setting this option to perform an acoustic model optimization every Monday at 1 AM and a language
model optimization the same day at 4 AM is (notice the comma between the day of the week and the time):

PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 04:00"

To schedule only data collection and language model optimization tasks and have them occur every day at 4
PM and 11 PM, respectively, you would enter only the time for each task, without indicating a particular day:

PERIODIC_TASK="dc|lmo;myadmin;mypswd;04:00|23:00"

A string setting this option to perform an acoustic model optimization every Tuesday at midnight, data col-
lection every Wednesday at 3 AM, and a language model optimization every Friday night at 10 PM is:

PERIODIC_TASK="aco|dc|lmo;myadmin;mypswd;Tue, 00:|Wed, 03:00|Fri, 22:00"

To have the data collection and language model optimization tasks occur at default times, you modify the pre-
vious string by removing the times for those tasks, but leaving space between the vertical bars and after the
last vertical bar:

PERIODIC_TASK="aco|dc|lmo;myadmin;mypswd;Tue, 00:| | "

ROAMINGUSERINI="c:\xyz.ini" Specifies a roaming user .ini file (roamingdef.ini) that con-
tains the Master Roaming User Profile location and any
associated HTTP or HTTPS settings for a Roaming User Profile.
These are the same options set in the Network Directories
field of the Roaming tab of the Administrative settings
dialog box and the HTTP and HTTPS Settings dialog boxes.

When you enable the Roaming feature, Dragon creates an
encrypted roamingdef.ini file. Use the following steps to
create a roamingdef.ini file to be used for an MSI installation
where the Roaming feature is enabled:

Install Dragon on a machine with Windows administrator priv-
ileges.

Enable the Roaming feature options required in your envi-
ronment. These must include the Master Roaming User Profile
location set in the Network Directories field in the Roaming tab
of the Administrative Settings dialog box and any HTTP or
HTTPS settings.

Test these settings to make sure the Roaming User Profile con-
nection works.

Save your settings by closing Dragon.



Copy the encrypted roamingdef.ini or roaming.ini file (use the

one that is newer) created by this installation of Dragon to a
separate location. By default, the .ini is located in:
C:\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking11\

Set the ROAMINGUSERINI option to the name of the roam-
ingdef.ini file. The default is empty (no .ini file will be used).

To set these options using ROAMINGUSERINI, the Roaming
feature must be enabled in the nsdefaults.ini file.

Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties

When specifying features on the command line:

■ If a feature does not exist in a particular edition or language, overriding its default property has no effect.

■ Some features (such as Text-to-Speech) have sub-features. Setting these features on the command line auto-
matically turns on the properties of all sub-features, unless you specify an additional override for those sub-
features.

■ Any information in parentheses after the sub-feature is not included in the feature name.

You can specify any of the following features using ADDLOCAL and ADVERTISE properties on the command line:

Feature—
Sub-feature

Sub-feature

NatSpeak

Note:Required

in ADDLOCAL; if

not included,

installation fails

None

Samples (
Sample
Commands

files)

None

TTS (Text-

to-Speech)

TTSDEU (German Text-to-Speech)

TTSENU (US English Text-to-Speech)
TTSENG (British English Text-to-Speech)

TTSESP (Spanish Text-to-

Speech)

TTSFRA (French Text-to-

Speech)

TTSITA (Italian Text-to-

Speech)

TTSNLD (Dutch Text-to-

Speech)

Tutorial TutDEU (German Tutorial)

TutENX (English Tutorial)

TutESP (Spanish Tutorial)

TutFRA (French Tutorial)

TutITA (Italian Tutorial)

TutNLD (Dutch Tutorial)



Speech—
DEU (Ger-
man)

Sub-features for DEU (German):

DEUGeneral (German General Large, Swiss German
General, Empty Dictation General

)

DEULegal (German Legal)

DEUMedical (German Medical

Large)

DEURadiology (German Med-

ical Radiology Large)

Speech ENX

(English)—

ENU (US

English)

Dragon NaturallySpeaking and Dragon Medical:Sub-fea-
tures for ENU (US English): 

ENULegal (US English Legal Large)

ENUGeneral (US English General Medium, US English

Empty Dictation, US English Commands Only)

ENUGenSvc (US English Large General)

Note: The ENU sub-feature
includes support for the fol-
lowing accents:

General — Use if your accent
is not covered by the another
choice or you are not sure
which accent to select.

Australian accented English

British accented English

Indian accented English

Inland Northern US (Great
Lakes area)
— Covers Upstate New York
through the Chicago area.

SEAsian accented English —
South East Asian

Southern US — Covers most of
the Southern United States,
including Texas.

Spanish Accented English.

Speech ENX

(English)—

ENU (US

English)
(continued)

Note: ENU-

Radiology and

ENUPathology

are not avail-

able in the

Dragon Med-

ical Small Prac-

tice Edition.

Dragon Medical Only Sub-features for ENU
(US English):

ENUCardiology (US English Medical Large

Cardiology, Pediatric Cardiology)

ENUEmergency (US English Emergency Medicine

ENUObGyn (US English
Medical Large ENT, Fetal
Medicine, Midwifery,
Obstetrics and Gynecology,

Ophthalmology)

ENUOncology (US English Med-
ical Large Oncology, Radiation

Therapy)

ENUOrthopaedic (US English
Medical Large Dentistry, Large
Hand Surgery, Neurosurgery,
Orthopaedics, Oral and Facial
Surgery, Orthopaedic Surgery,
Plastic Surgery, Podiatry)



Large)

ENUGastroenterology (US English Medical Large Gas-

troenterology, Pediatric Gastroenterology)

ENUGeneralPractice (US English Large Family
Medicine, Allergy and Immunology, Dermatology,
Epidemiology, Geriatric, Hematology, Infectious
Disease, Internal Medicine, Medical Education and
Writing, Nephrology, Nursing, Osteopathy,

Pulmonary Disease, Rheumatology, Sleep Lab)

ENUMedical (US English General Medical Large—No

Specialty)

ENUMentalHealth (US English Large Medical
Addiction Psychiatry; Endocrinology, Diabetes, and

Metabolism; Psychiatry, Psychology)

ENGNeurology (US English Anesthesiology,
Neurology, Pain Medicine, Physical Medicine and
Rehabilitation, Vascular and Interventional

Radiology)

ENUPathology (US English

Medical Large Pathology)

ENUPediatrics (US English
Medical Large Pediatrics,
Neonatal and Perinatal

Medicine, Pediatric Dentistry)

ENURadiology (US English
Medical Large Nuclear

Medicine or Radiology)

ENURehabilitation (Neurology,
Physical Medicine,
Rehabilitation and Speech and
Language Pathology)

ENUSurgery (US English
Medical Large Cardiac
Surgery, Colon and Rectal
Surgery, Surgery, Thoracic
Surgery, Urology, Vascular

Surgery)

Speech ENX

(English)—

ENG (UK

English)

Dragon NaturallySpeaking and Dragon MedicalSub-fea-
tures for ENG (UK English):

ENGGeneral (UK English General Large, Empty Dic-

tation General, Commands Only)

Note: The ENG sub-feature
includes support for the fol-
lowing accents:

General — Use if your accent
is not covered by the other
choices or you are not sure
which accent to select.

Australian accented English.

Indian accented English.

SEAsian accented English –
South East Asian.



Speech ENX

(English)—

ENG (UK

English)

Dragon Medical OnlySub-features for ENG (UK
English):

ENGCardiology (

UK English Cardiology Large)
ENGEmergency

(UK English Emergency Large)

ENGGastroenterology (

UK English Gastroenterology Large)
ENGGeneralPractice

(UK English General Practice Large)
ENGMedical

(UK English Medical Large — No Specialty)
ENGMentalHealth

(UK English Mental Health Large)

ENGNeurology (

UK English Neurology Large)

ENGObGyn (UK English ObGyn

Large)

ENGOncology (

UK English Oncology Large)
ENGOrthopaedic

(UK English Large Orthopedic)

ENGPathology (

UK English Large Pathology)
ENGPediatrics

(UK English Large Pediatrics)
ENGRadiology

(UK English Large Radiology)
ENGSurgery

(UK English Large Surgery)

Speech—

ITA (Italian

)

Sub-features for ITA (Italian):

ITA (Italian General Large and Italian Empty Dic-

tation General Large)

Speech—

NLD (Dutch

)

Sub-features for NLD (Dutch):

NLDGeneral (Dutch General Large and Dutch Empty

Dictation General Large)

Dragon Medical OnlySub-features for NLD (Dutch):

NLDCardiology (Dutch Cardiology)
NLDGeneralPractice (Dutch General Practice)

NLDMedical (DutchMedical Large)
NLDOrthopaedics (Dutch Orthopaedics Large)

NLDPathology (Dutch Pathol-
ogy Large)

NLDPediatrics (Dutch Pedi-
atrics)
NLDRadiology (Dutch Radi-
ology Large)

NLDRalph (Dutch Ralph Large)
NLDSurgery (Dutch Surgery
Large)

Speech—

FRA (

French)

Sub-features for FRA (French):

FRAGeneral (French General Large, French Empty
Dictation General Large)

FRAMedical (French Medical

Large)
FRARadiology
(French Radiology Large)

Speech—

ESP (Span-

ish)

Sub-features for ESP (Spanish):

ESP (Latin American Spanish General Large)

ESP (Latin American Spanish Empty Dictation General Large)
ESP (Castilian Spanish General Large)
ESP (Castilian Spanish Empty Dictation General Large)



Installing Visual C++ Runtime for Dragon

Caution: Before you carry out an installation of Dragon using msiexec.exe, you must install Visual C++ Runtime
for Dragon on every dictation client machine. You can install it one of the following ways:

■ Use the Dragon setup.exe on the command line, which automatically installs vcruntime.exe for you.

■ Include a vcruntime.exe command line in your admininstall.bat script (see Carrying Out an Administrative
Installation).

■ If you are using msiexec.exe to install Dragon, manually install vcruntime.exe from the DVD (see instructions
below).

■ With Citrix, be sure you publish vcruntime.exe as an application in Citrix and then install it before installing
Dragon.

Manually Installing Visual C++ Runtime

Note: These steps are included in the msiexec.exe installation of Dragon.

1. Find the ISSetupPrerequisites/VCRuntime directory on the product DVD and open it. In this directory you find
the vcruntime.exe and vcruntime_x64.exe files.

If you are installing Version 10 rather than Version 10.x or 11, look in the ISSetupPrerequisites\{1FAD9007-
0FF1-4B05-B7CE-ADE12FB7DEC5} directory; you find only the 32-bit version of vcruntime.exe for Version 10.

2. Copy the vcruntime files to your server or to another accessible location. These .exe files install Visual C++
Runtime for Dragon. Run vcruntime.exe on each 32-bit machine where you intend to install Dragon and vcrun-
time_x64.exe on each 64-bit machine.

Caution: Do not attempt to extract the .msi file from either vcruntime.exe or vcruntime_x64.exe. Installing the
Visual C++ Runtime for Dragon as part of an msiexec.exe command line installation of Dragon is not rec-
ommended and not supported.

Pushing an installation of the Visual C++ Runtime

You can install the Visual C++ Runtime for Dragon using a Windows installer (MSI).

To create the MSI file for the C++ Runtime, perform the following steps:

1. On the Dragon installation disc, find the vcruntime.exe file.

2. Double-lick the vcruntime.exe file.

3. When the Welcome dialog-box displays, use Windows explorer to navigate to the Windows user's %TEMP%
directory.

4. In the newest directory under the %TEMP% directory, look for a file called Visual C++ 9.0 Runtime for
Dragon NaturallySpeaking.msi.

You can now use a server application and the Visual C++ 9.0 Runtime for Dragon NaturallySpeaking.msi
file to push the Visual C++ Runtime to multiple computers across a network.

See Overview of Installing Dragon using the Windows installer (MSI) for more information on pushing MSI instal-
lations and using MSI files from a command prompt.



Using an MSI file to install the Visual C++ Runtime from a command line

You can use the Visual C++ 9.0 Runtime for Dragon NaturallySpeaking.msi file to install the C++ Run-
time from a command line.

From a command line, pass the MSI file name as the application to install to the msiexec.exe command using
the /i option:

msiexec.exe /i "Dragon NaturallySpeaking11.msi"

Command Line Options for vcruntime.exe

Option Purpose of Option

/L <Lang ID> To provide language ID. The default is US English.

/S Silent mode. To turn off GUI prompt for the Choose Setup Language dialog box.

/v"<msiexec options>" To hide all GUI dialogs.To provide msiexec.exe parameters, especially /qn for

a silentmsiexec installation and /l*v to indicate a file where extensive instal-
lation messages should be logged. If you want fewer messages in the log, you

can pass /l without the v option. The * is a wildcard that calls all the other log-
ging options available.



Setting up and dictating with Roaming User Profiles

The Roaming feature lets users dictate with Dragon from different network locations and on different machines
without having to create and train individual User Profiles at each location.

The Roaming feature works by storing user profiles in a central network location so that the information Dragon
learns from a user dictating on one machine is also available on other machines.

To set up Roaming User Profiles, carry out the steps shown in the table below, in chronological order.

For information on: See:

The Roaming feature Overview of the Roaming feature

Setting up the Roaming feature, including:

■ Creating a network storage location for the Master Roaming
User Profiles

■ Where to install and configure Dragon

■ Storage space required for the Master and Local Roaming
User Profiles

■ How Dragon Synchronizes Master and Local Roaming User
Profiles

■ Estimating Network traffic caused by synchronization

Setting up the Roaming feature

Enabling the Roaming feature on each machine where a user
will dictate, including:

■ Setting Roaming User Profile locations

■ Setting Roaming User Profile options

■ Testing an HTTP or HTTPS connection

Enabling the Roaming feature on each
machine where a user will dictate

Creating Roaming User Profiles by using one of the following
methods:

■ Creating and training a new Roaming User Profile

■ Converting a non-roaming local user profile into a Roaming
User Profile

■ Copying a non-Roaming User Profile to the Master Roaming
User Profile location

Creating a Roaming User Profile on
the local machine

Dictating with a Roaming User Profile, including:

■ Opening a Roaming User Profile

■ Using multiple dictation sources with a single user profile

■ Running the Acoustic and Language Model Optimizer for Roam-
ing User Profiles

Dictating with a Roaming User Profile



For information on: See:

■ Synchronizing Master and Local Roaming User Profiles

Upgrade Roaming User Profiles from Dragon NaturallySpeaking
or Dragon Medical Version 9.x or 10.x to Version 11

Upgrading Roaming User Profiles:
Overview

Overview of the Roaming feature

The Roaming feature lets users dictate with Dragon from different network locations and on different machines
without having to create and train individual User Profiles at each location.

Some situations that the Roaming feature makes possible:

■ A doctor may need to dictate reports in a medical office building using a desktop computer, in a hospital
room using a Tablet PC, or at home using a laptop computer. The Roaming feature allows the doctor to use
the same set of User Profiles containing the same vocabulary words with the acoustic information from
each location.

■ A user dictates on the same laptop at multiple offices and at home. Before leaving the office, the user
loads a set of User Profiles from a central location on the network to his laptop. Once home, the user dic-
tates and corrects as you normally would. When you return to the office, you reconnect the laptop to the
network. The next time the user opens a Dragon user profile, the Roaming feature synchronizes the
updated User Profiles on the laptop with those at the network’s central location.

The relationship between the Master and the Local Roaming User Profile

With the Roaming feature, each Dragon user profile has a single Master Roaming User Profile that can be
opened from multiple networked machines running Dragon. The Master Roaming User Profile is stored on a net-
work location accessible to your dictating users.

When a Master Roaming User Profile is opened from that central network location, Dragon transfers a copy of
that user profile to the local machine. That local copy is called the Local Roaming User Profile.

The Local Roaming User Profile is a copy of the user data taken from the Master Roaming User Profile but mod-
ified locally by corrections and acoustic data gathered during a dictation session.

You can set a central storage device to contain all your Master Roaming User Profiles. By loading a Dragon user
profile from the central network location, your users can dictate at any computer where Dragon is installed.
When users exit Dragon and save the changes to their user profiles, these changes are saved in that central loca-
tion. The next time the user runs Dragon, all the changes saved are available regardless of which computer on
the network he or she uses for dictation.

Advantages of the Roaming feature

It is important to distinguish the Roaming feature from simply browsing to a network directory and creating
files there. Nuance recommends using the Roaming feature rather than storing non-Roaming User Profiles in a
network directory. Using the Roaming feature, you can:

■ Minimize network traffic. When Dragon opens a user profile, if there is already a copy of the Roaming User
Profile on the local machine, only the updates are downloaded from the network. When the user closes the
user profile at the end of his or her dictation session, only the updates from the current session are uploaded
to the network. These updates typically amount to no more than a few KB of data, as opposed to roughly 25



MB of data if the entire user profile is opened and closed over the network.

■ Allow the user to use Dragon even if the network directory is unavailable. In that case, Dragon opens the local
copy of the Roaming User Profile.

■ Give the administrator precise control over where users can put user profiles. If the Roaming feature is ena-
bled, the administrator can specify whether or not to also allow users to browse to any user profile location;
the default is not to allow browsing. This means that the administrator can easily see how many User Profiles
have been created and who created them. If the Roaming feature is not enabled, users can browse to any loca-
tion to which they have access and create User Profiles there.

■ If HTTP Roaming is configured, it can be used to provide username/password authentication on User Profiles.

Hosting Master Roaming User Profiles

There are several methods for hosting your Master Roaming User Profiles:

■ On a file server you connect to over a Mapped Drive

■ On a file server that you connect to over a UNC (Universal Naming Convention) address

■ On a web server that you connect to over HTTP (http://)

■ On a secure web server that you connect to over SSL (https://)

Why the Master Roaming User Profiles should be in shared directories

Nuance recommends placing the master Roaming User Profiles in a shared directory to make certain admin-
istrative tasks more efficient. These tasks include:

■ Scheduling an Acoustic and Language Model Optimizer task that optimizes multiple user profiles

■ Upgrading multiple User Profiles to a new major release of Dragon

■ Keeping track of how many User Profiles have been created, which helps with licensing compliance (note that
Dragon is licensed per user, not per workstation)

It is possible, though not recommended, to place Roaming User Profiles in a non-shared, user-specific location
such as the user’s home drive, provided every user’s home drive is mapped to the same drive letter (this is
because the Roaming User Profile location is an administrative setting that is per-workstation, not per-user).

Using multiple Roaming User Profile locations

If you have a large number of Roaming User Profiles, you may want to divide them among multiple shared direc-
tories. This facilitates performing tasks such as scheduling the Acoustic and Language Model Optimizer on a sub-
set of user profiles. You can choose how to divide your user profiles, for example:

■ By department

■ By alphabetical groupings (for example A through H, I through M, N through R, and S through Z)

On each PC, you can configure any number of Roaming User Profile locations. Make sure you give each Roaming
User Profile location a display name that makes it clear to your users which location to choose from.

Controlling user access to other user's profiles

If you have multiple Dragon users on an end-user workstation, those users will have multiple user profiles to
choose from in Dragon's Open User Profile dialog box.



If you use a shared directory for User Profiles, whether they are roaming or non-roaming, you may be con-
cerned about the ability of a user to see and/or open another user’s profile as well as their ability to open the
correct profile. There are several ways to address this concern:

■ Many of Nuance’s customers address this concern simply through user training. Each user should be aware
that if they open another user’s profile and try to use it, their accuracy will be poor and user-specific cus-
tomizations will not be available. Therefore, each user has an incentive to use only their own profile. How-
ever, this fact does not prevent a malicious user from damaging another user’s profile.

■ If users always log into Windows with a unique Windows user ID, you can use Windows file permissions to con-
trol access to the profiles. Typically, you do this by granting Full Control or Read/Write/Modify access to the
shared directory, but do not allow this permission to propagate to sub-directories. That way, each user
becomes the creator owner of any Dragon user profile that he or she creates. Users can still see all of the
Dragon user profiles in the Open User Profile dialog box, but if they try to select another user’s profile, a mes-
sage will appear saying that they do not have permission to access that profile. Apply similar file permissions
to the local copy of each Roaming User Profile; the default location for local copies is under
c:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking11\Roaming

Users.

■ If users log in using a shared Windows user ID, the best way to control access is through HTTP Roaming. In
this configuration, you set up a web server running either IIS or Apache and with the WebDAV file system ena-
bled. On each workstation, you specify a URL on the web server as the Roaming User Profile location. When a
user launches Dragon, before displaying the Open User Profile dialog it prompts for a user name and pass-
word, which it uses to authenticate against the web server.

You can use file permissions on the web server to specify which User Profiles are accessible to each account
on the web server. File security is a function of the web server and the WebDAV software.

Making it easier for users to select their user profiles 

As described above, the Dragon Open User Profile dialog shows a list of all of the User Profiles in a shared direc-
tory (unless you are using HTTP Roaming to limit access to User Profiles). If there are more User Profiles than
will fit on one screen, you can train users to go directly to a specific user profile by typing the first few letters of
its name.

It is possible to create an icon in the Start Menu and/or the Windows desktop that opens a specific user profile.
This can be helpful if there are only a few users of Dragon who share a particular workstation. Make a copy of
the Dragon icon for each user, and place the parameter /user ″user name″ on the natspeak.exe command line.

In Dragon 11, you can display and view groups of user profiles in a tree-style structure. See "Open User Profiles
dialog box optimized for Roaming" in Dragon version 11 - What's New for administrators for more information.

Backing up your Master Roaming User Profiles

Dragon does not backup local Roaming User Profiles on the end-user workstations and does not backup the
Master Roaming User Profiles on the location where they are stored on your network.

It is the responsibility of your local system administrator to backup the Master Roaming User Profiles.

Notes: For use of WebDAV

■ After you install Internet Information Services and WebDAV, you need to use the Internet Information Serv-
ices Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom Properties”, and “Allow Property
Queries with Infinite Depth” settings to true. For example, in IIS 7:



■ For more information, see Configuring Internet Information Services and WebDAV for HTTP Roaming.

■ If you connected to your Roaming User Profile Master Directory over HTTP and you find that the Open User
Profile dialog box does not display all the vocabularies and acoustic models for your user profiles, make sure
that you:

■ Add all file extensions within your Master Roaming User Profile directories and sub-directories to the Reg-
istered MIME types list of your IIS server. You could also add a wildcard ( .*) MIME-type. For more infor-
mation on adding a wildcard ( .*) MIME-type, see
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-

b497-4b8c-b552-83a2c180cd32.mspx?mfr=true.

■ Check that no files in your user profile directory are locked, password protected, or otherwise access-
restricted by your server permissions.

Setting up the Roaming feature

When setting up the Roaming feature, note the following:

■ Creating a network storage location for the Master Roaming User Profiles

■ Where to install and configure Dragon

■ Storage space required for the Master and Local Roaming User Profiles



■ Synchronizing Master and Local Roaming User Profiles

■ Estimating Network traffic caused by synchronization

Note: To enable the Roaming feature and set the Roaming User Profile options, you must log into an account
with Windows Administrator privileges.

Creating a network storage location for the Master Roaming User Profiles

For any installation of Dragon, you must first determine where on the network the Master Roaming User Profiles
should be located. 

Dragon lets you store your Master Roaming User Profiles on:

■ Any networked machine.
You are not strictly required to store Master Roaming User Profiles on a server. Any shared location acces-
sible to other computers on the network is a perfectly acceptable place to store Master Roaming User Profiles.

■ a Windows file server

■ A web server (HTTP)

■ A secure web server running SSL (HTTPS)

Note: The location(s) you pick must be accessible to all computers where users will dictate with a Roaming User
Profile. Each location must have adequate storage space for Roaming User Profiles. For more information, see
Storage space required for User Profiles.

What to consider for the Master Roaming User Profile location

To set up a location for the Master Roaming User Profiles, you should first determine:

■ The kind of network file server on which you want to store your Master Roaming User Profiles. Make sure it
has enough storage space. Each location you pick must be accessible to all computers where your users will
dictate with Roaming User Profiles. You can create multiple network storage locations.

■ How the machines from where your users will dictate will connect to that network location; for example using
a mapped drive, UNC connection, or an HTTP or HTTPS connection..

Using a networked machine or Windows file server

If you choose to use a networked machine or Windows server, you should determine the path to where the
Master Roaming User Profiles will reside. You can create multiple network storage locations.

The Roaming feature supports the following types of locations for your Master Roaming User Profiles:  

■ Mapped Drives—Connects to a shared network folder that has a drive letter assigned to it.

■ UNC Paths—Connects to a shared network folder using the Universal Naming Convention (UNC) to locate a
user profile. Format is: \\<servername>\<sharename>\<path>\<filename>.

What you'll need to know to configure your local Roaming User Profiles

After you have chosen the type of machine to store the Master Roaming User Profiles, you should determine the
following information so that you configure your local copies of Dragon to connect to a mapped or shared drive:

Mapped Drives

UNC paths



Using a HTTP or HTTPS web server

If you choose to use a HTTP or HTTPS web server, the Roaming feature supports the following types of locations
for your Master Roaming User Profiles

■ HTTP (http:)—Connects to machine on the internet or your local intranet. Format is: http://
<myserver.com>/<webdav>

■ HTTP with SSL (https:)—Connects to machine on the internet or your local intranet with SSL. Format is:
https://<myserver.com>/<webdav>

Supported web servers

If you want to store your Master Roaming User Profiles on a web server, Internet access to Master Roaming
User Profiles is supported on two web servers:

■ Microsoft Internet Information Services (IIS) version 6.0, 7.0, and 7.5. For this type of server:

■ Digest authentication through a proxy server with Internet Information Server (IIS) 6.0 is not sup-
ported.

■ Be sure that the server has Web-based Distributed Authoring and Versioning (WebDAV) software is
turned on to publish content to an Internet Information Services (IIS) web server.

If you have not already installed the WebDAV component, use the Add or Remove Programs in your Con-
trol Panel and run the Windows Components Wizard. WebDav is listed under Application Server>Internet
Information Services>World Wide Web Service>WebDAV Publishing.

■ Apache HTTP Server 2.0.54 and higher. For this type of server:

■ Internet Roaming User—Redirects must be turned on when using Digest authentication.

■ Be sure that the server has Web-based Distributed Authoring and Versioning (WebDAV) software turned
on. The WebDAV Apache module is available free of charge at http://www.webdav.org/mod_dav/.

What you'll need to know to configure your local Roaming User Profiles

After you have chosen the type of machine to store the Master Roaming User Profiles, you should determine the
following information so that you configure your local copies of Dragon to connect to the HTTP server:

■ The network location: You need to know the URL address of your HTTP server. For more infor-
mation, see XXXXX.

■ HTTP settings: For your http (or https) connection you need to know authentication, firewall,
and proxy server information. For more information, see HTTP Settings.

Notes: For use of WebDAV

■ After you install Internet Information Services and WebDAV, you need to use the Internet Information Serv-
ices Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom Properties”, and “Allow Property
Queries with Infinite Depth” settings to true. For example, in IIS 7:

http://www.webdav.org/mod_dav
http://www.webdav.org/mod_dav
http://www.webdav.org/mod_dav


■ For more information, see Configuring Internet Information Services and WebDAV for HTTP Roaming.

■ If you connected to your Roaming User Profile Master Directory over HTTP and you find that the Open User
Profile dialog box does not display all the vocabularies and acoustic models for your user profiles, make sure
that you:

■ Add all file extensions within your Master Roaming User Profile directories and sub-directories to the Reg-
istered MIME types list of your IIS server. You could also add a wildcard ( .*) MIME-type. For more infor-
mation on adding a wildcard ( .*) MIME-type, see
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-

b497-4b8c-b552-83a2c180cd32.mspx?mfr=true.

■ Check that no files in your user profile directory are locked, password protected, or otherwise access-
restricted by your server permissions.

Where to install and configure Dragon

Installing Dragon where you plan to dictate using the Roaming feature

Dragonmust be installed each computer where you plan to have users dictating with Roaming User Profiles.



Installing Dragon on the same machine as your Master Roaming User Profiles

Nuance recommends that you install Dragon on the same machine where the Master Roaming User Profiles for
your network are located.

As the system administrator, you are responsible for running the Acoustic and Language Model Optimizer
on the network location of the Master Roaming User Profiles. The Acoustic and Language Model Optimizer
and the Acoustic and Language Model Optimizer Scheduler can only be run on the Master Roaming User
Profiles.

Running the Acoustic and Language Model Optimizer updates the Master Roaming User Profiles with the accumu-
lated acoustic data from any corrections and additional training done by the users at the machines where they
dictate. Running the Acoustic and Language Model Optimizer will increase your overall accuracy. Any opti-
mizations done by the Acoustic and Language Model Optimizer are copied to each Local Roaming User Pro-
file when synchronization occurs.

Running the Acoustic and Language Model Optimizer over the network can result in a large amount of data
being transferred between the server and the workstation running the optimizer.

For more information, see Running the Acoustic and Language Model Optimizer for Roaming User Profiles.

If you are using Dragon 11, see Using multiple acoustic models with a user profile for information on using the
Acoustic and Language Model Optimizer with a user profile that has two acoustic models.

Notes:

■ You must have Windows Administrator privileges on the machine where you are running the Scheduler for
the Acoustic and Language Model Optimizer.

■ Do not enable the Roaming feature on the administrator machine where you plan to run the Acoustic and
Language Model Optimizer.

■ When the Roaming feature is enabled on a machine where someone dictates, that machine is blocked from
locally running the Acoustic and Language Model Optimizer or the Acoustic and Language Model
Optimizer Scheduler on the local copy of the Roaming User Profiles.

For more information on installing or upgrading Dragon

For more information on installing or upgrading Dragon on the machines in your network, see:

■ Upgrading Roaming User Profiles: Overview for information how to upgrade Roaming User Profiles from
Dragon NaturallySpeaking or Dragon Medical Version 9.x or 10.x to Version 11.

■ The Installation Guide that came with your copy of Dragon for information on installing Dragon on a single
machine

■ The System Administrator's Guide for information on how to use MSI to install or upgrade Dragon on multiple
machines.

Storage space required for the Master and Local Roaming User Profiles

Adequate storage space must be available for User Profiles that store information about each particular user’s
speech patterns.

You need to plan for storage space on:

■ Each computer where you plan to have users dictating with a Roaming User Profile.

■ The network accessible central machine or machines where Master Roaming User Profiles are stored.



These are guidelines only and not definitive specifications—actual size will vary from site to site.

For each Master Roaming User Profile- on the network

For each Master Roaming User Profile (User Profiles stored on the central network location), you should plan
on:

■ 25 MB for each set of Roaming User Profiles, This includes:

o 8 MB for each additional vocabulary you add for this user profile

o 18 MB for each additional dictation source you add for this user profile

■ 500 MB for acoustic optimizer data associated with each dictation source of each user profile

For each computer where Dragon is installed

You must install 1 copy of Dragon on each computer where your users will be dictating with the Roaming fea-
ture. Multiple users can use a single Dragon installation.

Each installation of Dragon takes a minimum of 1 GB of free hard disk space for a custom Installation where you
install only the program files and 1 set of user profiles. Installations can range from 800 MB (US English Stand-
ard Edition) to 2.5 GB (US English Medical Edition), depending on which languages and vocabularies you install.
See Dragon 11 system requirements for information on disk space requirements for Dragon 11.

Each installation of Dragon takes a minimum of 1 GB of free hard disk space for a custom Installation where you
install only the program files and 1 set of user profiles. Installations can range from 800 MB (US English Stand-
ard Edition) to 2.5 GB (US English Medical Edition), depending on which vocabularies you install. See Dragon 11
system requirements for information on disk space requirements for Dragon 11.

For each Local Roaming User Profile- on the client PC

On each installation of Dragon where your users plan to dictate using the Roaming feature, each Local Roaming
User Profile (the User Profiles stored on the local machine running Dragon), require the following:

■ 25 MB for each set of Roaming User Profiles. This includes:

o 8 MB for each additional vocabulary you add for this user profile

o 18 MB for each additional dictation source you add for this user profile

■ 10 MB per topic for language model optimizer data in the topic container data

■ 240 MB for acoustic optimizer data associated with each dictation source of each user profile

How much acoustic optimizer data is retained locally is controlled by settings on the Data tab of the Options
dialog box:

1. To set the number of minutes of audio to retain locally, click the Archive size... button and position the
slider.

2. To turn off retaining this data locally, check the Conserve disk space required by user profile (for port-
ability) option.

For each non-Roaming User Profile, you should plan on approximately twice as much space as a Local Roaming
User Profile, because Dragon periodically makes a backup copy of the files and stores it on the same machine.
The product does not back up Roaming User Profiles this way as they are located on a central machine that your
Information Technology department should back up regularly.



How Dragon Synchronizes Master and Local Roaming User Profiles

When a user that uses a Roaming User Profile exits Dragon, switches user profiles, closes a user profile, or
saves a user profile, Dragon saves changes to the Local Roaming User Profile and then synchronizes these
changes with the Master Roaming User Profiles on the network.

In a networked situation, this occurs at the time one of these operations is performed.

When a user dictates using a computer not currently connected to a network, all changes are saved to the Local
Roaming User Profile; synchronization occurs when the user reattaches the computer to the network containing
the Master Roaming User Profile and opens that user profile again.

For more information on what options effect what data gets synchronized between the Master and Local Roam-
ing User Profile, see Setting/selecting Roaming User Profile options.

Note: During synchronization, changes to the Master Roaming User Profile overwrite any changes made to a
Local Roaming User Profile that a user has been using for dictating and correcting dictation while not on the net-
work.

What happens during synchronization

The following changes take place when Local and Master Roaming User Profiles are synchronized:

■ Combines words added to the Local Roaming User Profile during a dictation session with the Master Roaming
User Profile vocabulary,

■ Removes words deleted from the Local Roaming User Profile from the Master Roaming User Profile vocab-
ulary.

■ Copies acoustic data (from files with a .DRA or .NWV extension) from the Local Roaming User Profile and
adds them to the Master Roaming User Profile where the data become available to the Acoustic Optimizer
(Note that .DRA files saved voluntarily by the user along with a document do not get added to the Master
Roaming User Profile. The.DRA files created automatically by Dragon for use by the optimizer are the only
ones that get added to the Master Roaming User Profile). For more information on running the Acoustic Opti-
mizer, see Running the Acoustic and Language Model Optimizer for Roaming User Profiles.

■ Copies any custom commands created or modified locally (using the MyCommands editor) to the Master
Roaming User Profile.

■ Saves any local user options that you changed on the Options or Formatting dialog box to the Master Roam-
ing User Profile, except the options listed below.

What changes don't get synchronized

The following options are not synchronized with the Master Roaming User Profile; they remain exclusively on
the local computer with the Local Roaming User Profile:

Locally set options on the Options dialog:

■ On the Data tab:

o Conserve disk space required by user profile option

o Create usability log option in the Advanced dialog box

o Incremental adaptation in general training option

■ On the Miscellaneous tab:

o Voice enable menus and dialog controls option



o Launch Dragon in QuickStart mode when Windows starts option

■ On other tabs of Options dialog box:

o All the options on the Playback/Text-to-speech tab

o All the options on the Hot keys tab

■ Settings in the Auto-Formatting dialog box:

o The UK and Canadian postcodes option

o Medical Auto-Formatting options

What files are synchronized

The following table explains how and when individual files are copied or updated to the master Roaming User
Profile or to the local cache when the Master and Local Roaming User Profiles are synchronized.

For more information on what options effect what data gets synchronized between the Master and Local Roam-
ing User Profile, see Setting/selecting Roaming User Profile options.

These options can effect how much data is transferred across your network when the Master and Local Roaming
User Profiles are synchronized. For more information, see Estimating Network traffic caused by synchronization
.

File Name or

Type

When Copied or Updated to Master Roaming User

Profile

When Copied or

Updated to Local

Cache

Acoustic files:

*.usr
and
*.sig

At save time if the Always copy acoustic infor-
mation to network option in the Administrative set-
tings is on. If the setting is off (the default), after the
acoustic optimizer runs on the master Roaming User Pro-
file, the server incorporates the changes

In Dragon 11, a user can set the Save Acoustic infor-
mation option to control if Dragon saves the .usr and
.sig files on each computer they dictate on. See "Con-
trolling updates to the acoustic components of a user pro-
file" in Dragon version 11 - What's New for
administrators for more information.

Copied if version

number on server is

different

Vocabulary
files:

*.voc

Copied only after the acoustic files for the user profile
have been modified with information from Learn from
specific documents, Learn from sent e-mails,
Import a list of words or phrases, and similar pro-
cedures.

Copied if version

number on server is

different

Acoustic archive
created for each
dictation ses-
sion:

Copied to session folder if it exists; once master voice_
container limit is reached, nothing more is copied. The
local copy is deleted and a zero-length file is created.

Never



acarchive.nwv
(encryption dis-
abled)

acarchive.enwv
(encryption ena-
bled)

Audio.ini Copied to master after running the Check Microphone wiz-
ard or at user profile close if not copied successfully
after running the Check Microphone wizard

Copied if version

number on server is

different; also cop-

ied right before

Check Microphone

wizard is run

Backups Never

Dragon does not backup local Roaming User Profiles on
the end-user workstations and does not backup the
Master Roaming User Profiles on the location where they
are stored on your network.

It is the responsibility of your local administrator to
backup the Master Roaming User Profiles.

However, Dragon does automatically back up local non-
Roaming User Profiles on the end-user workstations as
specified in the Miscellaneous tab of the Administrative
Settings dialog box.

Never

DRA files,
aco.ini; dra-
files.ini

Copied to session folder if the master voice_container
has space. Files are deleted after being copied; aco.ini
and drafiles.ini are recreated at zero-length

Never

Custom com-
mands created
on client PC:

Mycmds.dat

Copied when user profiles are saved, or a user profile is
closed and saved.

Copied at user pro-

file open if version

number on server is

different

Options.ini, sop-
tions.ini, itnop-
tions.ini

Copied at user profile close, options dialog close when
the timestamp on the local file has changed.

Copied on user pro-

file open, options

dialog open if ver-

sion number is dif-

ferent on the server

History of
changes to the
vocabulary:

Vocdelta.dat

Merged to master copy on user profile save and open.
When vocabularies are copied up, vocdelta.dat is reset
to zero in the master copy for that topic.

Copied to local

cache on user pro-

file open and

merged into the voc



if version number is

different on the

server

nsuser.ini,
local.ini, nssys-
tem.ini, nat-
speak.ini

Never (machine dependent) Never

Estimating Network traffic caused by synchronization

The following table explains how and when individual files are copied or updated to the master Roaming User
Profile or to the local cache when the Master and Local Roaming User Profiles are synchronized and how much
data is transferred in the process.

In addition, this table which option controls whether the data is transferred. For more information on what
options effect what data gets synchronized between the Master and Local Roaming User Profile, see Set-
ting/selecting Roaming User Profile options.

The estimates of the data transferred across the network is for a single Roaming User Profile.

Files copied to the Master

Roaming User Profile

Transfer

Direction

& Data

Amount

Files copied to the

Local Roaming User

Profile

Administrative

Setting to enable

for Transfer

Acoustic files: *.user
and *.sig

User Action: Dictation,
Audio Setup

Transfer time: When the
user profile is saved

15 MB

<------>

Transfer time:
Copied if server ver-
sion is different
from client version

■ Always copy
acoustic infor-
mation to net-
work

■ Save Acoustic
information

Vocabulary files: *.voc

User Action: Dictation,
Learn from specific doc-
uments, Learn from sent
e-mails, Vocabulary Opti-
mizer.

Transfer time: Copied
only after the vocabulary
files for the user have
been modified with infor-
mation from Learn from
specific documents, Learn
from sent e-mails, and the
Vocabulary Optimizer.
Copy only happens after
saving or closing a user

13 MB

<------>

Transfer time:
Copied if server ver-
sion is different
from client version

Access network
at user profile
open/close only



Files copied to the Master

Roaming User Profile

Transfer

Direction

& Data

Amount

Files copied to the

Local Roaming User

Profile

Administrative

Setting to enable

for Transfer

profile.

Acoustic archive
created for each dic-
tation session: acar-
chive.nwv,
acarchive.enwv

User Action: Dictation,
Correction

Transfer time: Copied to
session folder if it exists.
Once master voice_con-
tainer limit is reached,
nothing more is copied.
Copy only happens after
saving or closing a user
profile.

240 MB

<--------

Transfer time:
Never. The local
copy is deleted and
a zero-length file is
created after files
are copied to the
server.

Access network
at user profile
open/close only

DRA files created dur-
ing dictation: DRA files,
aco.ini, drafiles.ini

User Action: Dictation,
Correction

Transfer time: Copies to
session folder if the
master voice_container
has space.

1.3
MB/minute

<--------

Transfer time:
Never. Files are
deleted after being
copied; aco.ini and
drafiles.ini are rec-
reated at zero-
length

Conserve archive
size on network



Files copied to the Master

Roaming User Profile

Transfer

Direction

& Data

Amount

Files copied to the

Local Roaming User

Profile

Administrative

Setting to enable

for Transfer

Custom commands
created on client PC:
Mycmds.dat

User Action: Changes to
some Options on the local
PC

Transfer time: Copied
when a user profile is
closed or saved.

66 K

<------>

Transfer time:
Copied when a user
profile opens on the
local PC and the ver-
sion number on the
server is different
from the version
number on the
server

.INI file changes on
client PC: options.ini,
soptions.ini, itnoptions.ini

User Action: Changes to
some Options on the local
PC

Transfer time: Copied at
user profile close, Options
dialog close when the
timestamp on the local file
has changed

< 1 k

<------>

Transfer time:
Copied to local
cache on when a
user profile opens
and merged into the
voc if the version
number is different
on the server

History of changes to
the vocabulary: Voc-
delta.dat

User Action: Adding
words, changing word
properties

Transfer time: Merged
to master copy a user pro-
file is saved or opened.
When vocabularies are
copied up, vocdelta.dat is
reset to zero in the master
copy for that vocabulary

500 KB
max. (12

bytes/word)

<------>

Transfer time:
Copied when a user
profile opens or the
Options dialog
opens if the server
version is different
from the client ver-
sion

Merge contents
of vocdelta.dat
into network user
profile when file
is full

Log file: Dragon.log

User Action: Any use of
Dragon

Transfer time: Copied if
the Administrative option
is set.

< 1 MB

<--------

Transfer time:
Never

Copy Dragon log
to network



Enabling the Roaming feature on each machine where a user will dictate

After you have set up the network location for the Master Roaming User Profiles and installed or upgrading
Dragon on the machines in your network, you must enable the Roaming feature on each machine where the
user will dictate using a Roaming User Profile.

Step 1: Start Dragon

You must start Dragon to enable the Roaming feature.

Step 2: If already Dragon is running, select Administrative Settings

If Dragon is already running, on the DragonBar, select Tools > Administrative Settings and click Proceed.
This action closes all open user profiles and displays the Administrative Settings dialog box.

Step 3: Turn on the Roaming feature

After closing any open user profiles:

1. 1. If Dragon is running, from the DragonBar menu, select Tools > Administrative Settings. This action
displays the Administrative Settings dialog box.

Note: You do not have to be running Dragon to act as an administrator of the product. Instead of opening
the Administrative Settings dialog box from the DragonBar menus, you can open the dialog box from
the command line by selecting Start > Run, then entering the following command in the Open text box
(include a space between natspeak.exe and the /SetAdministrativeOptions option that follows it):

“C:\Program Files\Nuance\NaturallySpeaking11\Program\natspeak.exe”
/SetAdministrativeOptions

2. On the Roaming tab, check Enable.

3. Click Apply to save the changes and keep the dialog box open.

Note: With the Roaming feature enabled, the Open User Profile dialog box later displays only user profiles in
the Roaming User Profile storage locations. To let the users open both local (non-roaming) and Roaming User
Profiles, check the Allow non-roaming user profiles to be opened option in the Administrative Settings
dialog box. Clearing this option prevents users from dictating with a non-roaming (local) user profile by mis-
take, but you should check it now if you want to ensure you can open existing local user profiles so that you can
convert them to Roaming User Profiles.

Step 4: Set the location of Master Roaming User Profiles

On each computer where you plan to have users dictating as a Roaming User Profiles, you must tell that instal-
lation of Dragon where the Master Roaming User Profiles are located.



After selecting Enable on the Roaming tab:

1. Click the Add button. The Roaming User Network Location dialog box displays. You use the Roaming User
Network Location dialog box to define the network location of the master Roaming User Profiles. The loca-
tion you pick must be accessible to all computers on the network that you want available for dictation with
Dragon.

1. Set the Display Name to the way the name of the directory should display in other dialog boxes. The
display name later appears in the Roaming tab of the Administrative Settings dialog and the Loca-
tion of user profile text box of both the Open User Profile and the Manage User Profiles dialog
boxes.

2. Set the Network Location. See the types of locations that the Roaming feature supports in Step 1: Create
network storage location for Master Roaming User Profiles.

3. If you are using a web server to store Master Roaming User Profiles, click the HTTP Settings and
SSL Settings (if you are using HTTPS) button to set information about your HTTP and HTTPS connection and
proceed with HTTP Settings and SSL Settings for further information. After entering the HTTP and SSL Set-
tings, use the Test Connection button to make sure your settings are correct. For help troubleshooting a
problem with the connection, see Testing and troubleshooting an HTTP connection .

4. Click OK in the Roaming User Network Location dialog box.

For more information on setting the location of the master Roaming User Profiles, see Roaming User Network
Location.

Note: You cannot create a non-Roaming User Profile on an HTTP connection. You can only create
Roaming User Profiles on an HTTP connection when the Roaming feature is enabled.

Step 5: Set location of Local Roaming User Profiles

When a user opens a Master Roaming User Profile, Dragon transfers a copy of that user profile to the local
machine. That local copy is called the Local Roaming User Profile. This is the location on the computer where
changes made during a dictation session, such as corrections or new acoustic data, are stored before they are
synchronized with the master Roaming User Profile.

You can set this location, called <Roaming Local>, from the Administrative Settings dialog box. Nuance rec-
ommends leaving this option at the default setting.

Note: the location of <Roaming Local> is per-PC and cannot be changed to a user-specific location.

<Roaming Local>

To accept the default <Roaming Local> location (which Nuance recommends), click OK on the Administrative
Settings dialog box. You will be prompted to create the default directory if it does not already exists. When you
see the following message, click Yes.

The default location of <Roaming Local> is:

■ XP: C:\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking11\RoamingUsers\<display name>\

■ Vista: C:\Users\All Users\Nuance\NaturallySpeaking11\RoamingUsers\<display name>\



See Dragon version 11 file structure for information on the default location of the RoamingUsers directory for
Dragon 11 on Windows 7.’

The <display name> is the name you defined for the Master Roaming User Profile location. You can have mul-
tiple network storage locations for your Master Roaming User Profiles and each has its own corresponding direc-
tory for Local Roaming User Profiles.

Changing the default location for <Roaming Local>

1. Use the Browse for Folder dialog box to open a location where you want to store the local Roaming User
Profile. This is the location on the computer where changes made during a dictation session, such as cor-
rections or new acoustic data are stored before they are synchronized with the master Roaming User Profile.

2. If the directory does not currently exist, click Make New Folder and type a name for the new folder. The
new directory can have any name, but calling it something meaningful, such as Local Roaming User Profiles,
will make the folder easier to find in the future.

3. Click OK.

Step 6: Set Roaming feature options

The Administrative Settings dialog box also contains several options that affect how the Roaming feature
works. You select the options that indicate how you want a Roaming User Profile to function at each Roaming
User Profile location. For a list of the options to choose from, refer to Selecting Roaming User Profile options. 

Notes:

■ Once you set up an installation of Dragon to use the Roaming feature, users on that machine can only open
Roaming User Profiles; they cannot open any locally created user profiles unless you choose the "Allow non-
roaming user profiles to be opened" option. For a list of the options to choose from, refer to Selecting
Roaming User Profile options. 

■ If a user is dictating with a Roaming User Profile, the Acoustic and Language Model Optimizer Sched-
uler is disabled on the local user's machine. You must run the Acoustic and Language Model Optimizer
on the machine where your Master Roaming User Profiles are located or on an administrator’s workstation.
For more information, see Running the Acoustic and Language Model Optimizer with a Roaming User Profile.

Administrative Settings: Roaming tab

You use the Roaming tab of the Administrative Settings dialog box to set up the Roaming feature. You must
set up the Roaming feature on each computer where you want users to dictate with a Roaming User Profile.

When Roaming is enabled in Administrative Settings, by default the Open User Profiles dialog box displays large
numbers of User Profiles quickly. They can also be organized into subfolders. See "Creating subfolders for
Roaming User Profiles" in the Dragon Help for more information.

Enable

SelectEnable to activate the Roaming feature and the Roaming User Profile options.

Network Directories

To set the location of the master Roaming User Profile(s):

1. Click the Add button. You use the Roaming User Network Location dialog box to define the network loca-
tion of the master Roaming User Profiles. The location you pick must be accessible to all computers on the



network that you want available for dictation with Dragon.

2. Set the Display Name and the Address under Network Location. The Roaming feature supports the fol-
lowing types of locations:

■ Mapped Drive—the format is: <drive letter>:\<folder name>. For example, y:\roaming.

■ UNC Path—the format is: \\servername\sharename\path\filename.

■ HTTP (http:)—the format is: http://myserver.com/webDAV. For HTTP locations, click the HTTP Set-
tings button to set information specific to your HTTP connection. You can also test your connection to the
HTTP server from HTTP Settings dialog box.

■ HTTP with SSL (https:)—the format is: https://myserver.com/WebDAV. For HTTP with SSL locations,
click the SSL Settings button to set information specific to your HTTP with SSL connection. You can also
test your connection to the HTTP with SSL server from SSL Settings dialog box.

Local directory (for cache)

When a user opens a Master Roaming User Profile, Dragon transfers a copy of that user profile to the local
machine. The local copy is called the Local Roaming User Profile.

You can change the setting of this location, always called <Roaming Local>.

The default location of <Roaming Local> on Windows XP is:
Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking11\RoamingUsers\<display name>\<username>

See Dragon version 11 file structure for information on the default location of the RoamingUsers directory for
Dragon 11 on Windows Vista and Windows 7.

The <display name> is a name you assigned as a Master Roaming User Profiles location. You can have multiple
network storage locations for your Master Roaming User Profiles.

The <username> is the name of an individual Master Roaming User Profile. There is a separate directory for
each user profile.

Click the Browse button to find or create a new location.

Check Boxes for Roaming User options

The check boxes and other components below the Local directory are the Roaming User options. You can
also configure the Open User Profiles dialog box to display the Classic Open User Profiles dialog if desired. See
Selecting Roaming User Profile options. for details.

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first installed Dragon. Note that
the default is to have the Roaming feature turned off.

Notes: For use of WebDAV

■ After you install Internet Information Services and WebDAV, you need to use the Internet Information Serv-
ices Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom Properties”, and “Allow Property
Queries with Infinite Depth” settings to true. For example, in IIS 7:



■ For more information, see Configuring Internet Information Services and WebDAV for HTTP Roaming.

■ If you connected to your Roaming User Profile Master Directory over HTTP and you find that not all your User
Profiles are listed in the Open User Profile dialog box, or after creating a Roaming User Profile you cannot
open it again, or the Open User Profile dialog box does not display all the vocabularies and acoustic models
for your user profiles, make sure that you:

■ Add all file extensions within your Master Roaming User Profile directories and sub-directories to the Reg-
istered MIME types list of your IIS server. You could also add a wildcard ( .*) MIME-type. For more infor-
mation on adding a wildcard ( .*) MIME-type, see
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-

b497-4b8c-b552-83a2c180cd32.mspx?mfr=true.

■ Check that no files in your user profile directory are locked, password protected, or otherwise access-
restricted by your server permissions.

Administrative Settings: Roaming User Network Location

You use the Roaming User Network Location dialog box to define the network location of the master Roam-
ing User Profiles.

The location you pick must be accessible to all computers where users will dictate using a Roaming User Profile.



Display Name

Sets the directory name displayed in the following locations:

■ The Roaming tab of the Administrative Settings dialog box

■ The Location of user profile drop-down list in the Open User Profile dialog box.

Note:With the Roaming feature enabled, the Open User Profile dialog box displays only user profiles in the
Roaming User Profile locations. To let the users open both local (non-roaming) and Roaming User Profiles,
select the Allow non-roaming user profiles to be opened option on the Administrative Settings
dialog box. Clearing this option prevents users from dictating with a non-roaming (local) user profile by acci-
dent. For more information, see Enabling the Roaming feature on each machine where a user will dictate.

■ The Location of user profile drop-down list in the Manage User Profiles dialog box.

Network Location—Address

On each computer where you plan to have users dictating as a Roaming User Profiles, you must tell that instal-
lation of Dragon where the Master Roaming User Profiles are located.

The Roaming feature supports the following types of locations:

Mapped Drives and UNC Paths

Mapped drives connect to a shared network folder that has a drive letter assigned to it.

UNC paths connect to a shared network folder using the Universal Naming Convention (UNC) to locate a user
profile. The UNC is a way to identify a shared file on a computer or network without having to know the storage
device it is on. The UNC path format is:
\\servername\sharename\path\filename.

To use a mapped drive or UNC path:

1. Under Network Location, enter the address of the mapped drive or UNC path.

You can click Browse to browse for the location of the mapped drive or UNC path. This displays the Browse for
Folder dialog box. You can also create a new directory on the mapped drive or UNC path by clicking the Make
New Folder button.

2. Click OK when you are done.

Intranet/Internet connections

The Intranet/Internet connection supports both HTTP and HTTP over an encrypted Secure Sockets Layer (SSL).

To use an Intranet/Internet connection:

1. Under Network Location, enter the URL address of your HTTP or HTTPS server where your master Roaming
User Profiles are located.

2. Click

■ HTTP Settings...to display the HTTP Settings dialog box, where you can set information specific to
your HTTP connection like Authentication, Firewall, and Proxy Server information. You can also test your
connection to the HTTP server from this dialog box. For more information, see HTTP Settings.

■ SSL Settings...to display the SSL Settings dialog box, where you can set information specific to your
HTTPS (SSL) connection. You can also test your connection to the HTTPS server from this dialog box. For
more information, see HTTPS Settings.



Note: You cannot create a non-Roaming User Profile on an HTTP or HTTPS connection. You can create only
Roaming User Profiles on an HTTP or HTTPS connection and only when the Roaming feature is enabled.

Setting up HTTP Connection: HTTP Settings

You use the HTTP Settings dialog box to define and configure the connection to your web (HTTP) server. Enter
information about your connection in the following sections and text boxes of the dialog box:

Authentication

Passwords

Defines how a user that uses a Roaming User Profile enters the server username and password. This user-
name/password is to the server, not a local login:

■ Prompt for User and Password: Select if local users will be prompted for a username/password when
they connect to the HTTP server.

■ User/password: Sets the default username/password needed to connect to the HTTP server. Be sure to
put the domain name followed by a backslash in front of the user login name; for example, Nuance\JW-
yman.

Authentication Type

Sets the type of authentication used on the HTTP server you specified as the Address in the Roaming User
Network Location dialog box. Select the type that indicates how your server is configured:

■ Basic: Choose if the server is configured for Basic authentication, where the username and password are
passed over the network as clear text

■ Digest: Choose if the server is configured for Digest authentication, where the passwords are never trans-
mitted across the internet in unencrypted form. Digest is not supported for IIS.
Note: Digest authentication through a proxy server with Internet Information Server (IIS) 6.0 is not sup-
ported.

Note: For security reasons, be sure that anonymous logins are disabled on the HTTP or HTTPS server.

Connection

Follow Redirects

If you are storing the Master Roaming User Profiles on a server that redirects incoming connections to another
location, you can define how Dragon handles these redirects:

■ Never: redirects are never followed, but ignored.

■ Always: redirects are always followed.

■ Same Scheme Only: only redirects using the same scheme as the client request are permitted.

Keep Connection Alive

This setting tells the client and server to keep the connection alive after the current session ends.

Firewall and Proxy Servers

Use Proxy Server

Select Use Proxy Server if you are connecting to your HTTP server through a proxy server.



Type

Select the type of firewall used on the HTTP server from the drop-down list:

■ HTTP Proxy: Select for a proxy server that specializes in HTML (web page) transactions.

■ Tunnel: Select if you are connecting to the server with tunneling software.

■ SOCKS4: Select for a SOCKS4 protocol that relays TCP sessions at a firewall host to allow application
users transparent access across the firewall. SOCKS4 doesn't support authentication, UDP proxy. SOCKS4
clients require full Domain Name Service (DNS).

■ SOCKS5: Select for a SOCKS5 protocol that relays TCP sessions at a firewall host to allow application
users transparent access across the firewall. SOCKS5 supports multiple authentication methods. SOCKS5
clients use the SOCKS5 server to perform the DNS lookup.

Server

Enter the server name provided by your network administrator.

Port

Enter the port number needed to connect to the proxy server or firewall.

Username

Enter any username needed to log in to the proxy server or firewall.

Password

Enter any password needed to log in to the proxy server or firewall.

Firewall Data or Proxy Authorization

Enter any special authentication string provided by your network administrator.

Timeouts

Lock Timeout

Set to the number of seconds the server should wait before breaking the lock on any open Master Roaming User
Profiles. Setting the lock to 0 uses the default setting from the server. Specifying another time overrides the
server default. The administrator is responsible for breaking this type of lock.

A network locks prevent anyone from opening a Master Roaming User Profile that someone else has already
opened. While this process does not take a long time, network problems can cause a lock to become “stuck” and
not release when the opening process is completed. When this happens, the next time you try to open that user
profile, you see a message informing you of the lock.

The Administrator has to break the lock.

Connection

Number of seconds before Dragon should close the connection to the server either when the connection is idle
or after the connection has been open for that duration.

Connection Timeout Type

Sets when the connection timeout in the previous text box applies:



■ Inactivity: Closes the connection after the Roaming User Profile is inactive for the specified time.

■ Absolute: Closes the connection after the specified time independent of any Roaming User Profile net-
work activity. Use this option with caution, as it could close the connection during synchronization.

Test Connection

Once you have filled in the information, you can click the Test Connection button to test the connection to the
HTTP server.

Restore Defaults

Restores the default settings.

After you click OK, you return to the Administrative Settings dialog box.

Setting up HTTP Connection: HTTP Settings

You use the HTTP Settings dialog box to define and configure the connection to your web (HTTP) server. Enter
information about your connection in the following sections and text boxes of the dialog box:

Authentication

Passwords

Defines how a user that uses a Roaming User Profile enters the server username and password. This user-
name/password is to the server, not a local login:

■ Prompt for User and Password: Select if local users will be prompted for a username/password when
they connect to the HTTP server.

■ User/password: Sets the default username/password needed to connect to the HTTP server. Be sure to
put the domain name followed by a backslash in front of the user login name; for example, Nuance\JW-
yman.

Authentication Type

Sets the type of authentication used on the HTTP server you specified as the Address in the Roaming User
Network Location dialog box. Select the type that indicates how your server is configured:

■ Basic: Choose if the server is configured for Basic authentication, where the username and password are
passed over the network as clear text

■ Digest: Choose if the server is configured for Digest authentication, where the passwords are never trans-
mitted across the internet in unencrypted form. Digest is not supported for IIS.
Note: Digest authentication through a proxy server with Internet Information Server (IIS) 6.0 is not sup-
ported.

Note: For security reasons, be sure that anonymous logins are disabled on the HTTP or HTTPS server.

Connection

Follow Redirects

If you are storing the Master Roaming User Profiles on a server that redirects incoming connections to another
location, you can define how Dragon handles these redirects:

■ Never: redirects are never followed, but ignored.

■ Always: redirects are always followed.



■ Same Scheme Only: only redirects using the same scheme as the client request are permitted.

Keep Connection Alive

This setting tells the client and server to keep the connection alive after the current session ends.

Firewall and Proxy Servers

Use Proxy Server

Select Use Proxy Server if you are connecting to your HTTP server through a proxy server.

Type

Select the type of firewall used on the HTTP server from the drop-down list:

■ HTTP Proxy: Select for a proxy server that specializes in HTML (web page) transactions.

■ Tunnel: Select if you are connecting to the server with tunneling software.

■ SOCKS4: Select for a SOCKS4 protocol that relays TCP sessions at a firewall host to allow application
users transparent access across the firewall. SOCKS4 doesn't support authentication, UDP proxy. SOCKS4
clients require full Domain Name Service (DNS).

■ SOCKS5: Select for a SOCKS5 protocol that relays TCP sessions at a firewall host to allow application
users transparent access across the firewall. SOCKS5 supports multiple authentication methods. SOCKS5
clients use the SOCKS5 server to perform the DNS lookup.

Server

Enter the server name provided by your network administrator.

Port

Enter the port number needed to connect to the proxy server or firewall.

Username

Enter any username needed to log in to the proxy server or firewall.

Password

Enter any password needed to log in to the proxy server or firewall.

Firewall Data or Proxy Authorization

Enter any special authentication string provided by your network administrator.

Timeouts

Lock Timeout

Set to the number of seconds the server should wait before breaking the lock on any open Master Roaming User
Profiles. Setting the lock to 0 uses the default setting from the server. Specifying another time overrides the
server default. The administrator is responsible for breaking this type of lock.

A network locks prevent anyone from opening a Master Roaming User Profile that someone else has already
opened. While this process does not take a long time, network problems can cause a lock to become “stuck” and
not release when the opening process is completed. When this happens, the next time you try to open that user
profile, you see a message informing you of the lock.

The Administrator has to break the lock.



Connection

Number of seconds before Dragon should close the connection to the server either when the connection is idle
or after the connection has been open for that duration.

Connection Timeout Type

Sets when the connection timeout in the previous text box applies:

■ Inactivity: Closes the connection after the Roaming User Profile is inactive for the specified time.

■ Absolute: Closes the connection after the specified time independent of any Roaming User Profile net-
work activity. Use this option with caution, as it could close the connection during synchronization.

Test Connection

Once you have filled in the information, you can click the Test Connection button to test the connection to the
HTTP server.

Restore Defaults

Restores the default settings.

After you click OK, you return to the Administrative Settings dialog box.

Setting up secure web server connection: SSL Settings

You use the SSL Settings dialog box to define and configure the connection to your secure web (HTTPS) server.
Enter information about your connection in the following sections and text boxes of the dialog box:

Certificate Store

Here you indicate the type of certificate that provides server identity, certificate, and public key information to
clients that try to establish a connection:

Certificate Store Type

Select the certificate store type used for the client certificate on the local machine:

■ User (default): For Windows, choose if the certificate store is a certificate store owned by the current user.
For Java, choose if the certificate store is the name of a JKS (Java Key Store) file. If the provider is OpenSSL,
choose if the certificate store is a file that contains the PEM encoded certificate and private key.

■ Machine: Choose if the certificate store is a machine store (not available in Java or when provider is
OpenSSL).

■ PFX file: Choose if the certificate store is the name of a Private Key Server or PFX (PKCS12) file containing
certificates. If the provider is OpenSSL, the file may contain only one certificate and private key.

■ PFX Blob: Choose if the certificate store is a string (binary or base64 encoded) representing a certificate
store in PFX (PKCS12) format.

■ PEM Key: Choose if the certificate store is a string or file name that contains a Privacy Enhanced Mail (PEM)
encoded certificate and private key. This store type is currently not supported in Java.

Certificate Store

The name of the certificate store for the client certificate on the local machine:



The storage location is called the certificate store. A certificate store will often have numerous certificates, pos-
sibly issued from a number of a different certification authorities:

■ MY: A certificate store holding personal certificates with their associated private keys.

■ CA: A certificate store holding Certifying Authority (CA) certificates.

■ ROOT: A certificate store holding ROOT certificates.

■ SPC: A certificate store holding Software Publisher Certificate (SPC) certificates.

■ Other: Any other Certificate Store not listed above.

Notes:

■ If you select PFX file for the Certificate Store Type, for the Certificate Store select Other and enter
the name of the file in the associated text box below it.

■ If you select PFX Blob for the Certificate Store Type, for the Certificate Store select Other and enter
the binary contents of a PFX file (for example, the PKCS12) in the associated text box below it.

■ If you are using OpenSSL, for the Certificate Store select Other and enter the name of the file containing a
certificate and a private key in the associated text box.

Certificate Store Password

The password for the Certificate Store on the local machine if one is required.

Open SSL

Select Using OpenSSL if the HTTPS server uses OpenSSL as a Certificate Authority. OpenSSL is a free non-
commercial implementation of SSL.

When you select Using OpenSSL, you must provide:

■ Cipher List: A string that controls the ciphers to be used by SSL. The cipher list consists of one or more
cipher strings separated by colons.

■ Certificate Authority File: Name of the file containing the list of certificate authorities (CAs) trusted by
your application. The file set by this property should contain a list of CA certificates in PEM format.

■ CA Directory: Path to a directory containing CA certificates. The path set by this property should point to a
directory containing CA certificates in PEM format.

General

Use this section to enable/disable the supported security protocols on the HTTPS server.

■ TLS1: Version 1 of the Transport Layer Security (TLS) protocol.

■ SSL3: Version 3 of the Secure Sockets Layer (SSL) protocol.

■ SSL2: Version 2 of the Secure Sockets Layer (SSL) protocol.

■ PCT1: Version 1 of the Private Communications Transport (PCT) protocol.

Notes:

■ Although a number of sites still support SSL2, Nuance recommends that you disable it because of potential
security vulnerabilities.

■ If you select Using OpenSSL, this functionality is provided by the Cipher List.



Test Connection

Once you have filled in the information, you can click the Test Connection button to test the connection to the
HTTPS (SSL) server.

Restore Defaults

Restores the default settings.

After you click OK, you return to the Administrative Settings dialog box.

Testing and troubleshooting an HTTP connection

Once you have supplied all the necessary information needed to connect to your HTTP server, press the Test
Connection button. The Test Connection button tests the connection to your HTTP server based on the infor-
mation you supplied in the Roaming User Network Location and HTTP Settings dialog boxes.

Troubleshooting test connections

The table below lists the possible messages you might receive after pressing the Test Connection button.

Message Solution

Connection test successful! None—test successful.

Could not connect to the network
location.

■ Check spelling and syntax of the HTTP address in the HTTP Settings
dialog.

■ Check your local network for problems.

Could not copy a file to the net-
work location

■ Check create and write privileges on the server

■ WebDav Server not installed or active. For more information, see
Configuring Internet Information Services and WebDAV for HTTP
Roaming.

Could not create a directory on the
network location

■ Check the create directory privileges on the server for the Master
Roaming directory.

■ Check the privileges for creating sub-directories under the Master
Roaming directory.

Could not delete a file from the net-
work location

■ Check permissions on the Master Roaming directory. The user
must have read, write, and modify privileges

■ Check that privileges are inherited in the sub-directories.

Could not delete a directory from
the network location

■ Check permissions on the Master Roaming directory. The user
must have read, write, and modify privileges

■ Check that privileges are inherited in the sub-directories.

Could not copy files into a direc-
tory created on the network loca-
tion

■ Check permissions on the Master Roaming directory. The user
must have read, write, and modify privileges.

■ Check for authentication time-out on your server.

■ Check your local network for problems.



Could not list the contents of a
directory created on the network
location

■ Check permissions on the Master Roaming directory. The user
must have read, write, and modify privileges

■ Check that privileges are inherited in the sub-directories.

Contents of newly created direc-
tory TempDir were incorrect

Caused by an incomplete directory listing. Try again. If the problem
persists, check the condition of your network.

Could not copy a file from the net-
work location

■ Check permissions on the Local Master Roaming directory.

■ Check that the Local Master Roaming directory exists.

■ MIME types not set to *.* (the file is .txt).

Could not get the size of a newly
created directory on the network
location.

Apache: Make sure DavDepthInfinity directive is set to "on" for
Master Roaming directory.

Could not rename a file on the net-
work location

■ Check permissions on the Master Roaming directory. The user
must have read, write, and modify privileges

■ Check that privileges are inherited in the sub-directories.

Could not rename a directory on
the network location

■ Check permissions on the Master Roaming directory. The user
must have read, write, and modify privileges

■ Check that privileges are inherited in the sub-directories.

Could not copy a directory within
the network location

■ Check permissions on the Master Roaming directory. The user
must have read, write, and modify privileges

■ Check that privileges are inherited in the sub-directories.

Setting and selecting Roaming User Profile options

The Administrative Settings dialog box also contains several options that you can choose from to indicate
how you want a Roaming User Profile to function at each Roaming User Profile location.

These options can effect how much data is transferred across your network when the Master and Local Roaming
User Profiles are synchronized. For more information, see Estimating Network traffic caused by synchronization
and How Dragon Synchronizes Master and Local Roaming User Profiles.

Roaming User Profile options on the Administrative Settings dialog box

Display Classic Open User Profiles dialog

Enable this option to display the Classic Open User Profiles dialog box. The setting configures the Open User
Profiles dialog box to display only folders that contain actual Dragon Medical User Profiles in the Location of
User Profiles box.

Note:

For faster performance at large sites with Roaming User Profile directories, Nuance recommends using the
default appearance for the Open User Profiles dialog box. Displaying the Classic Open User Profiles dialog
box takes longer because Dragon Medical first verifies that directories contain valid Dragon Medical User Pro-
files. Directory structures do not display with the Classic setting.



Allow non-Roaming User profiles to be opened

Select this box to permit the user to open non-Roaming (local) user profiles. Nuance recommends clearing this
option to prevent anyone from dictating with a non-Roaming (local) user profile by accident. You may want to
set this option temporarily in order to convert non-roaming (local) user profiles to Roaming User Profiles, and
then clear it when you are done.

Merge contents of vocdelta.dat into network user profile when file is full

Select this box to copy the contents of the local vocdelta.dat file to the master Roaming User Profile without
running the Acoustic and Language Model Optimizer.

If you do not set this option and if you have not run the Acoustic and Language Model Optimizer for a long time,
the user will see a message when the vocdelta.dat file becomes full. If you do not run the Acoustic and Lan-
guage Model Optimizer regularly, you should set this option to prevent end users from seeing this message.

Vocdelta.dat is the file used to store vocabulary changes in the Master Roaming User Profile. It is updated when-
ever a Local Roaming User Profile is closed, and it is used to update the Local Roaming User Profile with vocab-
ulary changes every time that user profile is opened. When you run the Acoustic and Language Model Optimizer
on the Master Roaming User Profile, Dragon incorporates the contents of vocdelta.dat into the vocabulary (.voc)
file and clears the content of vocdelta.dat.

If you check this setting, Dragon monitors the size of the vocdelta.dat file. When the vocdelta.dat file
reaches 90% of it's maximum size (500 KB), Dragon incorporates the contents of the vocdelta.dat file into the
vocabulary (.voc) file and clears vocdelta.dat

This operation occurs when the user opens the local Roaming User Profile. This operation can take a long time
because the vocabulary file must be transferred over the network twice. Subsequently, opening the local Roam-
ing User Profile on another workstation can also take a long time because the entire vocabulary file must be cop-
ied from the master to the local Roaming User Profile.

Selecting this option will transfer at maximum 500 KB, or 12 bytes/word across the network at synchronization
if the Roaming and Local copies are different..

Access network at user profile open/close only 

Select this box to synchronize changes made to the local Roaming User Profile to the Master Roaming User Pro-
file only when a local Roaming User Profile opens or closes. If this box is not selected, then these local changes
are immediately transferred to the Master Roaming User Profile. The only changes affected by this setting are
the changes a user makes locally from the Options dialog box, therefore this setting is highly unlikely to have a
perceptible impact on Dragon’s performance.

At synchronization, setting this option will copy approximately

■ 13 MB of vocabulary files (*.voc).

■ 240 MB of acoustic archive files create for each dictation session (acarchive.nwv and acarchive.enwv).
Note: These files are only copied from the Local to the Roaming User Profile; they are never copied from the
Roaming User Profile to the local user profile.

These file will synchronize across the network when:

■ Vocabulary files - when the Local user modifies the vocabulary with information from the Learn from spe-
cific documents, Learn from sent e-mails, or Vocabulary Optimizer dialogs or when the Roaming and
Local copies are different.

■ Acoustic archive files - these files will be copied to session folder if it exists. Once the master voice_container
limit is reached, nothing more is copied.



Ask before breaking locks on network user profiles (recommended for UNC and mapped drives)

Select this box to keep the option of maintaining or breaking a network lock when opening a Roaming User Pro-
file. Normally, network locks prevent anyone from opening a Roaming User Profile at the same time someone
else is opening that user profile. While this process does not take a long time, network problems can cause a
lock to become "stuck" and not release when the opening process is completed. When this happens, the next
time anyone tries to open that user profile, Dragon displays a message stating that the user profile is locked
and giving them the option of overriding it. If you do not want this message displaying and always want to break
a network lock in this situation, you can clear this option to prevent the message from appearing. Because the
presence of a lock can indicate a problem that needs to be addressed, Nuance recommends that you enable this
option.

Notes:

■ This option is valid for users connecting to the Master Roaming User Profile location using a mapped drive or
UNC drive, but is not supported for users connecting over HTTP.

■ Be careful when in breaking a locked Roaming User Profile. For example, if you break a lock when another
user is writing to the Master Roaming User Profile, breaking the lock may corrupt the Master Roaming User
Profiles.

■ If a user opens a Roaming User Profile while the Acoustic and Language Model Optimizer is running on the
Master Roaming User Profile, the user will see a message but can continue.

Set audio levels on each machine (recommended)

Select this box to run the Check your microphone option from the Accuracy Center window before your
first session with a Roaming User Profile. This includes the Volume Check and the microphone Quality Check
. Check this option if your users are dictating on different machines or on a single machine, like a laptop, in
many different locations. When a user changes machines or locations, the audio setup data can vary depending
on differences in the microphone and sound card, as well as differences in ambient sound levels of each Roam-
ing User Profile location. In situations where Dragon detects a significant difference between operating sys-
tems, sound cards, microphones, or other hardware, the program will prompt you to run Check your
microphone even if you do not have this option selected. 

Save acoustic information

A user selects the Save acoustic information option to make sure that their acoustic information is saved
along with their local User Profile. By saving the acoustic information, the user ensures that any corrections
they make will be available after they close and re-open the User Profile. This option also makes sure that these
corrections will be synchronized between the Local and Master Roaming User Profile if the user also enables the
Always copy acoustic information to network option

This option is turned on by default

Copy Dragon Log to Network

Select this box to copy the Dragon.log file from the local workstation to the master Roaming User Profile loca-
tion whenever the program synchronizes the local and master Roaming User Profile. Dragon.log contains infor-
mation that can help to diagnose problems that your users might encounter using Dragon.

Note: The Dragon.log file will not be copied once the maximum size is reached in the Disk space reserved
for network archive option.

Selecting this option can increase how long it takes to close a Roaming User Profile. It can also limit the use-
fulness of the Acoustic and Language Model Optimizer because it reduces the amount of acoustic data that can



be stored in the network archive. Nuance recommends that you not set this option unless requested by Nuance
Technical Support.

Selecting this option will transfer 1 MB or less of data across the network at synchronization. These files are
only copied from the Local Roaming User Profile to the Master Roaming User Profile; they are never copied
from the Master Roaming User Profile to the Local Roaming User Profile.

Always copy acoustic information to network

Select this box to copy the user profile’s acoustic model (.usr and .sig files) to the Master Roaming User Profile
location.

If you chose not to copy the user profile’s acoustic information to the network, updates to the acoustic model
that you make on one machine (for example by correcting and training words) will not be available on other
machines used by that particular Roaming User Profile until you run the Acoustic and Language Model Opti-
mizer on the Master Roaming User Profile location and the Local and Master Roaming User Profiles syn-
chronize. Therefore, if you do not run the Acoustic and Language Model Optimizer on the Master Roaming
User Profiles regularly, you should set this option.

By always copying the acoustic information to the Master Roaming User Profile location, you ensure these accu-
racy improvements will be available when the Master Roaming User Profile is opened from another location.
However, setting this option can increase the amount of time it takes to close a Roaming User Profile.

In Dragon 11, a user can set the Save Acoustic information option to control if Dragon saves the .usr and
.sig files on each computer they dictate on.
See "Controlling updates to the acoustic components of a user profile" in Dragon version 11 - What's New for
administrators for more information.

The transfer of acoustic information based on this option's setting is not limited by setting the Disk space
reserved for network archive option.

Setting this option will copy approximately 15 MB across the network at synchronization if the Roaming and
Local copies are different.

Conserve archive size on network 

Select this box to prevent copying of .DRA files (files that contain the acoustic data from the latest dictation ses-
sion) to the Master Roaming User Profile location when the program synchronizes the Local and Master Roaming
User Profiles. Leaving this box unchecked allows the local .DRA files to synchronize with the Master Roaming
User Profile, which makes the .DRA files available to the Acoustic and Language Model Optimizer when it
is run on the Master Roaming User Profile locations and provides increased accuracy.

However, because .DRA files can be large, if you experience excessive network slowdowns, checking this
option may solve the problem by eliminating the copying of these files each time the Master and Local Roaming
User Profiles synchronize. You can still run the Acoustic and Language Model Optimizer on the Master
Roaming User Profile, but since it will not have the .DRA files to process, the accuracy gains will be less.

Note: The .DRA files will not be copied once the maximum size is reached in the Disk space reserved for
network archive option.

At synchronization, setting this option will copy approximately 1.3 MB for each minute of dictation saved in the
.DRA files. These files are only copied from the Local Roaming User Profile to the Master Roaming User Profile;
they are never copied from the Master Roaming User Profile to the Local Roaming User Profile.



Disk space reserved for network archive

Use this option to specify the maximum size of the directory containing the acoustic data (the .dra and the log
files) available to the Acoustic Optimizer. By default the archive size is 500 MB per dictation source. To con-
serve space, you can reduce the default size and select the Conserve archive size on network option.

Creating a Roaming User Profile on the local machine

There are two ways to create a Roaming User Profile:

■ Train a new Roaming User Profile

■ Convert a non-roaming local user profile into a Roaming User Profile

To open or create a Roaming User Profile, your local installation of Dragonmust be configured for Roaming
User Profiles. For more information, see Enabling the Roaming feature on each machine where a user will dic-
tate.

Notes

■ If you use a variety of microphones or input devices with your Roaming User Profile, see the topic: Using mul-
tiple dictation sources with a single user profile.

■ If you modify a master Roaming User Profile while you have a local Roaming User Profile open on a computer
that is not currently connected to the network (for example, a laptop at a remote location), the changes to the
master Roaming User Profile will overwrite any changes you make to the local Roaming User Profile when
you synchronize the local and master Roaming User Profiles.

■ When a user that is using a Roaming User Profile exits Dragon, switches user profiles, closes a user profile, or
saves a user profile, Dragon saves changes to the Local Roaming User Profile and then synchronizes these
changes with the Master Roaming User Profile on the network. For more information, see How Dragon Syn-
chronizes Master and Local Roaming User Profiles

Creating and training a new Roaming User Profile

To create and train a new Roaming User Profile:

1. To display the Open User Profile dialog box, select Profile > Open User Profile on the DragonBar.

Note:When the Roaming feature is enabled, users can create only Roaming User Profiles. The Location of
user profiles field displays only the Roaming User Profile locations you defined in the Administrative Set-
tings dialog box. To let the users create both local (non-roaming) and Roaming User Profiles, select the
Allow non-Roaming User profiles to be opened option on the Roaming tab of the Administrative Set-
tings dialog box. Clearing this option prevents user profiles from dictating with a non-roaming local user pro-
file by accident. For more information, see Enabling the Roaming feature on each machine where a user will
dictate.

If you allow users to open both non-roaming local and Roaming User Profiles, be sure they select the correct
location from the Location of user profiles field.

If there are multiple roaming profile locations, make sure each user selects the correct location from the
Location of user profiles field.

2. Click New and begin training the user profile as you would any other user profile.



3. When you are finished training the user profile, the program saves the User Profiles into the master Roaming
User Profile location specified in the Location of user profiles field.

Converting a non-roaming local user profile into a Roaming User Profile

You can convert an existing non-roaming local user profile to a Roaming User Profile from the Manage User
Profiles dialog box. Converting a non-roaming local user profile copies that user profile to the Master Roaming
User Profile location.

To convert a non-Roaming User Profile to a Roaming User Profile:

1. Select Profile > Manage User Profiles from the DragonBar. This action displays the Manager User
Profiles dialog box.

2. In the Location of user profile drop-down list at the bottom of the dialog box, select the non-roaming
local location of your user profiles. Now the list under User Profiles should include all the non-roaming
local user profiles that you can convert to Master Roaming User Profiles.

3. Select the non-roaming local user profiles you want to convert to a Master Roaming User Profile.

4. Click the Advanced button and then select Save to Roaming from the menu that pops up. The Save to
Roaming dialog box appears.

5. Under Select Roaming Master Location to save the user, select the appropriate Master Roaming
User Profile location from the drop-down list. In the Choose subdirectory if wanted field, you can
select a subdirectory within the Roaming Master location. When finished, click OK. A Master Roaming User
Profile location appears in this list only if it is currently available to the local machine.

6. Repeat the process for any other non-roaming local user profiles you want to convert to Master Roaming
User Profiles.

Dictating with a Roaming User Profile

You dictate with a Roaming User Profile the same way you would with any other user profile. For specific infor-
mation about working with a Roaming User Profile, refer to the following topics:

■ Opening a Roaming User Profile

■ Using multiple dictation sources with a single user profile

■ Running the Acoustic and Language Model Optimizer for Roaming User Profiles

■ Synchronizing Master and Local Roaming User Profiles

Opening a Roaming User Profile

When the Roaming feature is enabled, you can only open Roaming User Profiles (unless you set an option allow-
ing speakers to open both Roaming and Local User Profiles).

To open a Roaming User Profile:

1. On the DragonBar, select Profile > Open User Profile.

2. On the Open User Profile dialog box, select a user profile from the list, and click Open.
If you do not see the user profile you are looking for, press F5 to refresh the list of user profile.

Notes:



■ If you allow users to select both non-roaming local and Roaming User Profiles , make sure they select the
correct location from the Location of user profiles drop-down list.

■ When the Roaming feature is enabled, you can only open Roaming User Profiles. The Location of user
profiles drop down list displays only the Roaming User Profile locations you defined in the Admin-
istrative Settings dialog box. To let the users open both local (non-roaming) and Roaming User Profiles,
select the Allow non-Roaming User profiles to be opened option in the Administrative Settings
dialog box. Clearing this option prevents users from dictating with a non-roaming local user profile by acci-
dent. For more information, see Enabling the Roaming feature on each machine where a user will dictate.

■ If you connect to your Roaming User Profile Master Directory over HTTP or HTTP with SSL, and you find
that the Open User Profile dialog box does not display all the vocabularies and acoustic models for your
user profiles, make sure that:

■ The .INI extensions is registered in MIME types (ini.png) list of your IIS server.

Add all file extensions within your Master Roaming User Profile directories and sub-directories to the
Registered MIME types list of your IIS server. You could also add a wildcard ( .*) MIME-type. For
more information on adding a wildcard ( .*) MIME-type, see:

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-
4b8c-b552-83a2c180cd32.mspx?mfr=true

■ The user's topics.ini and acoustics.ini files are not locked, password protected, or otherwise
access restricted by your server permissions.

Using multiple dictation sources with a single user profile

It is possible to have a variety of dictation sources (audio input devices) for a single set of User Profiles so that
the speaker can deploy various microphones or portable recording devices. This ability is especially useful with
the Roaming feature. By allowing multiple dictation sources, you can still have the same User Profiles for each
location regardless of the microphone type.

To add a new dictation source to a user profile

1. In the Open User Profile dialog box, select the user profile to dictate with the new dictation source.

2. Click the Source button and then click New. The New Dictation Source dialog box appears.

3. Select a new input device for dictation from the list on the New Dictation Source dialog box. You can
choose from among different microphone or recorder types.

4. Click OK. You return to the Open User Profile dialog box.

5. Select the user profile you just created and click Open. If you have not previously trained the user profile
with the new dictation source, the Profile Creation wizard appears and you can begin training.

Running the Acoustic and Language Model Optimizer for Roaming User Profiles

When the Roaming feature is enabled on a workstation, that workstation cannot run the Acoustic and Lan-
guage Model Optimizer or the Acoustic and Language Model Optimizer Scheduler because the opti-
mizer or scheduler can only be run on the Master Roaming User Profile. Later, any optimizations done by the
Acoustic and Language Model Optimizer are copied to each Local Roaming User Profile when syn-
chronization occurs.

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-83a2c180cd32.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-83a2c180cd32.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-83a2c180cd32.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-83a2c180cd32.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-83a2c180cd32.mspx?mfr=true


The system administrator is responsible for running the Acoustic and Language Model Optimizer on the net-
work location of the Master Roaming User Profiles. The administrator can install Dragon on the machine where
the Master Roaming User Profiles are located or an administrator's machine that has network access to the
Master Roaming User Profiles and run the Scheduler for the Acoustic and Language Model Optimizer. If
possible, the administrator’s workstation should be co-located with the server because a large amount of data
needs to be transferred between the server and the workstation running the optimizer.

Note: You must have Windows Administrator privileges on the machine where you are running the Scheduler
for the Acoustic and Language Model Optimizer.

Running the Acoustic and Language Model Optimizer on a multi-core machine

If a Roaming User Profile is created and used on a multi-core machine with the Roaming feature enabled, if an
administrator runs the Acoustic and Language Model Optimizer on that profile on a single-core machine, all accu-
racy improvements may not be applied to the profile. If an administrator runs the Acoustic and Language Model
Optimizer for a Roaming User Profile on a single-core machine, when a user opens the profile on a multi-core
machine, only the first acoustic model will load.

To make sure that corrections and accuracy improvements that users make are applied to their Roaming User
Profile, an administrator should run the Acoustic and Language Model Optimizer on Roaming User Profiles only
on a multi-core machine.

Running the Acoustic and Language Model Optimizer on a user profile with two acoustic models

If the computer that a user dictates on meets certain system requirements, Dragon 11 , can use two acoustic
models (instead of one) with a user profile. Using two acoustic models instead of one increases recognition and
dictation accuracy. Acoustic models that can be added in pairs to a user profile are called Two-pass models.

See Using multiple acoustic models with a user profile for more information.

To run the Acoustic and Language Model Optimizer to optimize Roaming User Profiles

1. Be sure that a copy of Dragon is installed on the computer where you plan to run the Acoustic and Lan-
guage Model Optimizer. Also be sure that the Roaming feature is not enabled.

2. On the Windows Start menu, select Programs > Dragon NaturallySpeaking 11 > Dragon Nat-
urallySpeaking Tools > Scheduler for Acoustic and Language Model Optimizer to start the Acoustic
and Language Model Optimizer Scheduler.

3. Access the master directory of the Roaming User Profiles you want to optimize: select File > Set Speaker
Directory from the menu of the Acoustic and Language Model Optimizer Scheduler window. In the
Set User Profile Directory dialog box, either enter the path of the directory or click the Browse button. If
the user profiles you want to optimize are located in multiple directories, you can change directories to locate
the additional user profiles.

4. Select the user profile(s) you want to optimize and set a schedule for running the Acoustic and Language
Model Optimizer. For specific instructions, click the Help button in the window.



Controlling user access to other user's profiles

If you have multiple Dragon users on an end-user workstation, those users will have multiple user profiles to
choose from in Dragon's Open User Profile dialog box.

If you use a shared directory for User Profiles, whether they are roaming or non-roaming, you may be con-
cerned about the ability of a user to see and/or open another user’s file as well as their ability to open the cor-
rect file. There are several ways to address this concern:

■ Many of Nuance’s customers address this concern simply through user training. Each user should be aware
that if they open another user’s file and try to use it, their accuracy will be poor and user-specific cus-
tomizations will not be available. Therefore, each user has an incentive to use only their own file. However,
this fact doesn't prevent a malicious user from damaging another user’s file.

■ If users always log into Windows with a unique Windows user ID, you can use Windows file permissions to con-
trol access to the files. Typically, you do this by granting Full Control or Read/Write/Modify access to the
shared directory, but do not allow this permission to propagate to sub-directories. That way, each user
becomes the creator owner of any Dragon User Profile that he or she creates. Users can still see all of the
Dragon user profiles in the Open User Profile dialog box, but if they try to select another user’s profile a mes-
sage will appear saying that they do not have permission to access that profile. Apply similar file permissions
to the local copy of each Roaming User Profile; the default location for local copies is under
C:\Documents and Settings\All Users\ApplicationData\Nuance\NaturallySpeaking11\Roaming
Users

■ If users log in using a shared Windows user ID, the best way to control access is through HTTP Roaming. In
this configuration, you set up a web server running either IIS or Apache and with the WebDAV file system ena-
bled. On each workstation, you specify a URL on the web server as the Roaming User Profile location. When a
user launches Dragon, before displaying the Open User Profile dialog it prompts for a user name and pass-
word, which it uses to authenticate against the web server.

You can use file permissions on the web server to specify which User Profiles are accessible to each account
on the web server. File security is a function of the web server and the WebDAV software.

Making it easier for users to select their user profiles

As described above, the Dragon Open User Profile dialog shows a list of all of the User Profiles in a shared direc-
tory (unless you are using HTTP Roaming to limit access to User Profiles). If there are more User Profiles than
will fit on one screen, you can train users to go directly to a specific user profile by typing the first few letters of
its name.

In Dragon 11, you can display and view groups of user profiles in a tree-style structure. See "Open User Profiles
dialog box optimized for Roaming" in Dragon version 11 - What's New for administrators for more information.

Notes: For use of WebDAV

■ After you install Internet Information Services and WebDAV, you need to use the Internet Information Serv-
ices Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom Properties”, and “Allow Property
Queries with Infinite Depth” settings to true. For example, in IIS 7:



■ For more information, see Configuring Internet Information Services and WebDAV for HTTP Roaming.

■ If you connected to your Roaming User Profile Master Directory over HTTP and you find that the Open User
Profile dialog box does not display all the vocabularies and acoustic models for your user profiles, make sure
that you:

■ Add all file extensions within your Master Roaming User Profile directories and sub-directories to the Reg-
istered MIME types list of your IIS server. You could also add a wildcard ( .*) MIME-type. For more infor-
mation on adding a wildcard ( .*) MIME-type, see
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-

b497-4b8c-b552-83a2c180cd32.mspx?mfr=true.

■ Check that no files in your user profile directory are locked, password protected, or otherwise access-
restricted by your server permissions.

Configuring Internet Information Services and WebDAV for HTTP Roaming

Here we discuss how to configure Internet Information Services (IIS) and Dragon Professional and Medical to
allow you to use WebDAV shares as http roaming users profile locations.

You must perform two steps to use IIS and WebDAV for Dragon HTTP Roaming:

1. Configuring Internet Information Services and WebDAV

2. Configuring Dragon internet roaming



Configuring Internet Information Services and WebDAV

To run WebDAV, you must install Internet Information Services (IIS) version 6 or higher on a server operating
system such as Windows 2003 Server or Windows Server 2008.

In this section we discuss installing and configuring WebDAV on both IIS 6.0 and IIS 7.0.

Installing and configuring WebDAV on Internet Information Services 6.0

Internet Information Services 6.0 - Install WebDAV

Perform the following steps after you install IIS 6.0

1. In Windows Server 2003, to install WebDAV on the IIS 6 server.

2. In Control Panel, open Add or Remove Programs .

3. Run the Windows Components Wizard.

4. Navigate to Application Server > Internet Information Services > World Wide Web Service

5. In |the World Wide Web Service, dialog box, selectWebDAV Publishing.

6. Click OK.

7. In the Internet Information Services (IIS) Manager dialog box, selectWeb Service Extensions.

8. Make sure the status for the WebDAV item is set to Allowed.

Internet Information Services 6.0 - Configuring WebDAV

1. Create a virtual directory that points to the Roaming User directory. For more information, see
http://msdn.microsoft.com/en-us/library/zwk103ab.aspx

2. Enable Basic Authentication for the Roaming User directory. For more information, see:
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/9b619620-4f88-
488b-8243-e6bc7caf61ad.mspx?mfr=true

3. Do not enter a value for default domain. In the Dragon Roaming configuration settings, when you specify a
username without specifying a domain or machine name, the domain of the machine is used as the default
domain.

4. For DNS, add the “wildcard MIME mapping" to the virtual directory. For instructions, see
http://support.microsoft.com/kb/326965

5. In the IIS Manager, set the Allow Property Queries with Infinite Depth property to True.

6. Make sure that the files in your Roaming User Profile directory are not locked, password protected, or other-
wise restricted for access by server permissions.

Installing and configuring WebDAV on Internet Information Services 7.0

Internet Information Services 7.0 - Install WebDAV

1. Install WebDAV on the IIS 6 server. For more information, see
http://learn.iis.net/page.aspx/350/installing-and-configuring-webdav-on-iis-7/



Internet Information Services 7.0 - Configuring WebDAV

1. Create a virtual directory that points to the Roaming User directory. For more information, see
http://msdn.microsoft.com/en-us/library/bb763173.aspx

2. Enable Basic Authentication for the Roaming User directory. For more information, see:
http://technet.microsoft.com/en-us/library/cc733010(WS.10).aspx

3. In the IIS Manager, select Default Web Site in the left pane.

4. In the main view, double-click the WebDAV Authoring Rules icon.

5. SelectWebDAV Settings.

6. In the WebDAV Settings page, under Authoring Behavior, set the Allow Unknown MIME Types property to
True.

7. Under Property Behaviour, set the Allow Custom Properties and Allow Property Queries with Infinite
Depth properties to True.

8. Click Apply to save the changes.

9. Make sure that the files in your Roaming User Profile directory are not locked, password protected, or other-
wise restricted for access by server permissions.



Configuring Dragon internet roaming

Perform the following steps to configure Dragon internet roaming on all workstations.

1. Start Dragon.

2. Open the Administrative Settings dialog. On the Dragon Bar, select Tools > Administrative Settings.

3. In the Roaming tab, select Enable.

4. Click the Add button to add a new network location.

5. Set the Display Name and the Network Location. The Roaming User Network Location dialog box displays
examples of what you can enter in the Address field.

■ For HTTP locations, you can click the HTTP Settings button to set information specific to your HTTP con-
nection like Authentication, Firewall, and Proxy Server information. You can also test your connection to
the HTTP server from HTTP Settings dialog box.

Upgrading Roaming User Profiles: Overview

This section describes how to upgrade Roaming User Profiles from Dragon NaturallySpeaking or Dragon Medical
Version 9.x or 10.x to Version 11.

Since the Local Roaming User Profile is a copy of a subset of the user data taken from the master Roaming User
Profile, you cannot directly upgrade the Local Roaming User Profile when you upgrade the local Dragon instal-
lation from Version 9.x or 10.x to Version 11.

See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for administrators for
more information.

Notes:

■ Upgrading a set of Version 9.x or 10.x master Roaming User Profiles to Version 11 leaves the Version 9.x or
10.x master Roaming User Profiles unchanged. Leaving the Version 9.x or 10.x files intact allows the users in
your network to run Dragon Version 9.x or 10.x while you plan your upgrade.

■ Plan to upgrade the master Roaming User Profiles at a time when they are not being opened by end users, for
example during the night or on a weekend.

■ Even though the Dragon 11 User Profile Upgrade Wizard supports both mapped drives and UNC paths, Nuance
strongly recommends that you upgrade your Master Roaming User Profiles on a drive on a machine where
Dragon 11 is locally installed. Nuance does not recommend that you upgrade your Master Roaming User Pro-
files across a network to either a mapped drive or UNC path; upgrading over a network will take a undeter-
mined length of time. In addition, the User Profile Upgrade Wizard does not support upgrading user profiles
over an HTTP connection.

Step 1: Preparing to upgrade Roaming User Profiles

To upgrade your Master Roaming User Profiles from a previous version of Dragon, Nuance recommends that
you install Dragon 11 directly on the network machine where the version 9.x or 10.x Master Roaming User Pro-
files are located and upgrade those Master Roaming User Profiles directly to Dragon 11 Master Roaming User
Profiles.

If you are unable to install Dragon where your version 9.x or 10.x Master Roaming User Profiles are located,
Nuance recommends that you:



■ Install Dragon 11 on a separate machine where you will perform the upgrades.

■ Copy the version 9.x or 10.x Master Roaming User Profiles from their network location to the machine where
Dragon 11 is installed.

■ Upgrade the version 9.x or 10.x Master Roaming User Profiles on the machine where Dragon 11 is installed.

■ Copy the upgraded version 11 Master Roaming User Profiles to a network accessible directory on the original
network location.

For more information, see Preparing to upgrade Roaming User Profiles.

Step 2: Upgrading the User Profiles

As administrator you must separately upgrade the master Roaming User Profiles to Version 11 using the Ver-
sion 11 User Profile Upgrade Wizard.

After you upgrade the version 9.x or 10.x Master Roaming User Profiles, you can then proceed to upgrade end-
user systems that deploy the Roaming feature.

For more information, see Upgrading master Roaming User Profiles

Step 3: Upgrade the end-user systems

After you have upgraded the master Roaming User Profiles, you can then proceed to upgrade end-user systems
that deploy the Roaming feature.

For more information, see Upgrading end-user systems.

Preparing to upgrade Roaming User Profiles

Step 1: Install Dragon 11 on the machine where you will perform the upgrades of your version 9.x

or 10.x Master Roaming User Profiles

Nuance recommends that you install Dragon 11 on the machine where the version 9.x or 10.x Master Roaming
User Profiles are located. If that is not possible, Nuance recommends that you install Dragon 11 on a separate
machine where you will perform the upgrades.

See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for administrators for
more information.

Notes:

■ If you are unable to install Dragon where your version 9.x or 10.x Master Roaming User Profiles are located,
Nuance recommends that you install Dragon 11 on a separate machine where you will perform the upgrades.
For more information, see Upgrading Roaming User Profiles: Overview.

Step 2: On the version 9.x or 10.x end-user systems that use the Roaming feature

On the end-user systems where the users dictate using the version 9.x or 10.x Roaming feature, save and close
any open user profiles on each Dragon Version 9.x or 10.x system that uses the Roaming feature.

Note: If there is no time when all of your Roaming User Profiles are unused (for example, if you are supporting
a hospital where some physicians use Dragon during a night shift), you can upgrade different groups of Roaming
User Profiles at different times.



Step 3: On the central network location that stores the version 9.x or 10.x Master Roaming User Profiles:

1. (Optional) Back up the master Roaming User Profiles to a separate location, either by using any system
backup utility that is implemented at your facility or by using the Dragon The Manage User Profiles dialog.

Note: You are not required to back up the Roaming User Profiles because when you upgrade, your Version
9.x or 10.x User Profiles are retained in a directory separate from your Version 11 User Profiles.

2. Create a new directory on the shared network drive that should store the upgraded Dragon 11 Master Roam-
ing User Profiles. Although you can store the upgraded Version 11 user profiles in the same location as the cur-
rent user profiles— this would make two versions of each user profile visible to the end user and lead to
confusion — Nuance recommend that you create a location that differs from the location that stores the cur-
rent User Profiles.

Step 4: Copy the version 9.x or 10.x Master Roaming User Profiles from the previous network loca-

tion to the machine where Dragon 11 is installed.

If you installed Dragon 11 on the machine where the version 9.x or 10.x Master Roaming User Profiles are
located, then proceed to Step 5 below.

If you installed Dragon 11 on a machine other than where the version 9.x or 10.x Master Roaming User Profiles
are located, then do the following on the machine where Dragon 11 is installed:

1. Create a directory on the local machine that will hold all the Master Roaming User Profiles you plan to
upgrade.

2. Copy the version 9.x or 10.x Master Roaming User Profiles from the network location to the directory you just
created.

Step 5: On the administrator system from where you will upgrade the version 9.x or 10.x Master Roaming User Pro-

files to version 11:

1. Start Dragon Version 11 and make sure the Roaming feature is turned off.

To turn off the Roaming feature:

a. Close any open user profiles.

b. Click Administrative Settings on the DragonBar Tools menu. This action displays the Admin-
istrative Settings dialog box.

c. On the Roaming tab, make sure Enable is not selected.

2. Close Dragon.

3. Follow the instructions in the next section, Upgrading master Roaming User Profiles.

Upgrading master Roaming User Profiles

As administrator you must separately upgrade the master Roaming User Profiles to Version 11 using the Ver-
sion 11 User Profile Upgrade Wizard on the version 9.x or 10.x Master Roaming User Profiles.

See "Upgrading user profiles to Dragon version 11" in Dragon version 11 - What's New for administrators for
more information.



Before proceeding with this section, make sure you have followed the procedure described in Preparing to
upgrade Roaming User Profiles.

After you have upgraded the version 9.x or 10.x Master Roaming User Profiles and optionally copied them back
to their network location, you can then proceed to upgrade your end-user systems that use the Roaming fea-
ture. For more information, see Upgrading end-user systems.

Step 1: Upgrade the version 9.x or 10.x Master Roaming User Profiles using the User Profile

Upgrade Wizard

On the machine where both your version 9.x or 10.x Master Roaming files and Dragon 11 are installed:

1. Select Start > Programs > Dragon NaturallySpeaking 11 > Dragon NaturallySpeaking Tools >
Upgrade Users.

Note: If you did not turn off the Roaming feature in the Administrative Settings dialog box before attempt-
ing to start the User Profile Upgrade Wizard, you receive an error message stating that you cannot
upgrade a Roaming User Profile. If you receive the message, go back to the Administrative Settings dialog
and be sure the Enabled check box is not checked.

2. On the Select User Profiles to Upgrade page, click Add... to select the location of the version 9.x or 10.x
Master Roaming User Profiles. The the Select User Profiles to Upgrade page now displays a list of user
profiles in the selected directory. For example:

You can continue to use the Add... button to add user profiles from other local locations or use the Remove
button to remove specific user profiles. Click Next to continue.

3. On the Choose Destination page, in the Destination for upgraded user profiles text box, choose the
local location you previously created that will contain the upgraded Version 11 master Roaming User Profiles.



If you do not see the location you want, you can click the Browse button, find the correct location, and click
Next. For example:

4. The Upgrade User Profiles page displays the number of user profiles that the wizard is prepared to
upgrade.

5. Click Begin to start the upgrade process. The upgrade process can take 2-3 minutes or more per user profile,
depending on the speed of your system and your network. You can click Stop at any time to interrupt this
process.

The upgrade process creates new master Roaming User Profiles in the destination you selected.

6. Click Finish to complete the upgrading process and exit the User Profile Upgrade Wizard.

Note: The User Profile Upgrade Wizard renames each Version 11 master Roaming User Profile as follows:
<name> (v11).
For example, a Version 10.x Master Roaming User Profile named roaminguser1 will be copied and named roam-
inguser1 (v11) when upgraded to Version 11. The Version 10.x Master Roaming User Profile named roam-
inguser1 remains unchanged.

Having the files renamed like this could cause some confusion for the users in your network who are dictating
with Roaming User Profiles. If, for example, you chose to locate your Version 9.x or 10.x and your upgraded
Version 11 Roaming User Profiles in the same network directory, the Open User Profile dialog box would dis-
play both the old and the Version 11 master Roaming User Profiles.

Step 2: Clean up network locations of Version 9.x or 10.x master Roaming User Profiles (optional) 

When the User Profile Upgrade Wizardmodifies the Version 9.x or 10.x master Roaming User Profiles to
work with Dragon Version 11, it makes a copy of the upgraded user profile first, keeping the original Version



9.x or 10.x files unchanged. This allows you to return to the old User Profiles in case you need them again.

As administrator, you can optionally rename or remove the Version 9.x or 10.x master Roaming User Profiles
through the Manage User Profiles dialog box.

Step 3: Copy the upgraded version 11 Master Roaming User Profiles back to their network location

(Optional)

If you were unable to install Dragon where your version 9.x or 10.x Master Roaming User Profiles were located
and you copied your version 9.x or 10.x Master Roaming User Profiles to another machine where Dragon 11 was
installed, you must now copy the upgraded version 11 Master Roaming User Profiles back to the new network
accessible directory that you created on their original network location.

You can skip this step if you installed Dragon 11 on the machine where the version 9.x or 10.x Master Roaming
User Profiles are located and upgraded those Master Roaming User Profiles directly to Dragon 11 Master Roam-
ing User Profiles.

Step 4: Upgrade your end-user systems from Dragon V9 or V10 to Version 11

After you have upgraded the master Roaming User Profiles, you can then proceed to upgrade your end-user sys-
tems where users dictate deploying the Roaming feature. For more information, see Upgrading end-user sys-
tems.

Upgrading end-user systems to Dragon 11

After you have upgraded the master Roaming User Profiles, you can then proceed to upgrade the end-user sys-
tems that use the Roaming feature. See "Upgrading user profiles to Dragon version 11" in Dragon version 11 -
What's New for administrators for more information.

Before proceeding with this section, make sure you have followed the procedure described in Upgrading master
Roaming User Profiles.

Step 1: Upgrade Version 9.x or 10.x systems where users will dictate with the Version 11 Roaming

feature

Since the User Profile Upgrade Wizard leaves your Version 9.x or 10.x master Roaming User Profiles
unchanged and in their original network location, your Version 9.x or 10.x systems can continue to use the
Roaming feature until you upgrade those installations to Version 11.

Notes:

■ When prompted, choose to remove the Version 9.x or 10.x Dragon installation. If you choose not to remove
the previous installation, you cannot continue to upgrade.

Step 2: Enable the Roaming feature on upgraded end user systems and try opening a Roaming User

Profile

When you upgrade a Dragon system to Version 11, the Roaming feature is turned off by default, unless you built
the Roaming User Profile settings into an MSI package.

To turn on the Roaming feature on the upgrade machines:

1. Start Dragon.

2. If a user profile opens, close it.



3. Click Administrative Settings on the DragonBar Tools menu. This displays the Administrative Set-
tings dialog box.

4. On the Roaming tab, select Enable.

5. The Network Directories list will display the network location of the Version 9.x or 10.x master Roaming
User Profiles.

If you created a new network directory for your Version 11 master Roaming User Profiles, you can either click
the Add button to add the new network location or select a listed directory and then click Edit to change the
path to the new location. When you have finished, click OK to close the Administrative Settings dialog box.
You should also remove any unused Version 9.x or 10.x master Roaming User Profile directory to avoid con-
fusion.

6. Select Profile > Open User Profile on the DragonBar. This action displays the Open User Profile
dialog box. If you allow users to select both non-roaming local and Roaming User Profiles, make sure they
select the correct location (the Version 11 Roaming User Profile location) from the Location of user pro-
files field.

7. Select a user profile and click Open.

Note: If the Roaming User Profiles have not already been upgraded and stored in the new master Roaming User
Profile directory, when you click Open, the User profile needs to be upgraded dialog box appears. Since
you cannot upgrade Roaming User Profiles locally, you should click Cancel here and return to Upgrading
master Roaming User Profiles. If you click OK instead of Cancel, you receive a message stating You cannot
upgrade a roaming user because you cannot upgrade Roaming User Profiles on a workstation that has the
Roaming feature enabled.



Using Dragon in a Citrix server environment

With the exception of the Medical Small Practice edition of Dragon, you can deploy and run Dragon in a Citrix
environment. When you dictate using Dragon Medical in a Citrix environment, you can use all capabilities of the
PowerMic II microphone, including all of the device's standard and programmable button functions and its bar
code scanner. The Dragon does not support the PowerMic I microphone.

Note: The Medical Small Practice Edition of Dragon does not support Citrix.

Tasks: Topic:

Sizing and Configuring Dragon for Citrix Determining requirements for deploy-
ing Dragon in a Citrix environment

Installing and publishing Dragon on the Citrix server Installing and publishing Dragon on the
Citrix server

Creating policies to allow Dragon users to access Dragon from
their desktops.

Creating Policies for Dragon on the Cit-
rix server

Using Dragon published on a Citrix Presentation Server with
another published application like Microsoft Word.

Making published applications work
together in a Citrix environment

Setting Up the Program Neighborhood on Citrix clients:

■ Enabling sound quality on the client

■ Installing the Citrix Client Update

Setting up the Program Neighborhood
on Citrix clients

Using a Wyse thin computing device with Microsoft Windows XP
to dictate using Dragon

Running Dragon on a Winterm device

For more information on sizing and performance when running Dragon in a Citrix environment, please see:

http://www.nuance.com/naturallyspeaking/citrix

Installing and publishing Dragon on the Citrix server

Dragon NaturallySpeaking and Dragon Medical include support for deploying and running Dragon in a Citrix envi-
ronment.

You can run Dragon through the Citrix Webclient, Program Neighborhood Agent, or the Program Neighborhood.

Requirements for running Dragon in a Citrix environment

See Dragon 11 system requirements for more information.

Installing and publishing Dragon on the Citrix server

1. Install Dragon as you normally would other applications that you make available on the Citrix server. Make
note of the location of the Dragon installation directory.
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2. Perform one of the following tasks to publish Dragon:

■ If you installed a non-SDK version of Dragon, you must publish it as an Application.

When publishing Dragon from the Presentation Server Console, use natspeak.exe as the Dragon
executable. By default, the Dragon applications install into the following directory:
\Program Files\Nuance\NaturallySpeaking11\Program

For example:

■ If you installed the SDK Client Edition of Dragon, you must publish Dragon as a Desktop from the Citrix
Presentation Server Console in order to view and run the sample programs from a client.

3. In the Specify Client Requirements dialog box, check the Enable legacy audio setting. For example, if
you are using the Program Neighborhood:

4. Publish the Dragon Citrix Client Update as Content.



When you publish the Dragon Citrix Client Update from the Presentation Server Console, use
vddnspatch.exe as the Citrix Client Update executable. For example:

Notes:

■ You must install this Client Update directly on each client computer. For more information, see
Setting Up the Program Neighborhood on Citrix clients.

■ You must have administrator rights to install the Citrix Client Update.

■ You do not need to re-install the Citrix Client Update if was already installed as part of an MSI
installation. See Installing the Citrix Client Update using MSI installer for more information.

Creating Policies for Dragon on the Citrix server

You must create two policies for Dragon before users can access Dragon NaturallySpeaking or Dragon Medical
from their desktops.

Create the AudioIn policy

1. Perform one of the following actions to create a policy named AudioIn:

■ From the Presentation Server Console, select Policies and click the Create Policy button.

■ Select Actions > Policy > Create Policy from the menu

2. Perform one of the following actions to set the properties of the AudioIn policy. You can use the Properties
dialog to enable Microphones and allow a client's microphones to be used for audio input.

■ Select the AudioIn policy and then click the Properties button.

■ Select Actions > Properties from the menu.



For example:

3. Perform one of the following actions to specify the users that can use the AudioIn policy:

■ Select the AudioIn policy and then click the Apply this policy to button.

■ Select Actions > Policy >Apply this policy… from the menu.e This displays the Policy Filters for
the AudioIn Policy. Select Users and grant access to the appropriate Dragon users.

Create the AudioOut policy

1. Perform one of the following actions to create a second policy named AudioOut:

■ From the Management Console, select Policies and click the Create Policy… button.

■ Select Actions > Policy > Create Policy from the menu.

2. Select the AudioOut policy and then click the Properties button to set the properties to enable the Sound
Quality and set the client audio quality to High sound quality; lowest performance.

3. Perform one of the following actions to specify which users can use the AudioOut policy (in other words, all
users who need access to Dragon).

■ Select the AudioOut policy and then click the Apply this policy to button.

■ Select Actions > Policy > Apply this policy… from the menu) This displays the Policy Filters for the
AudioOut Policy – select Users and grant access to the appropriate users.

Making published applications work together in a Citrix environment

In a Citrix environment, to run published installation of Dragon with another published application like Microsoft
Word, you must run both applications in a single Citrix client session.

Use the following guidelines to make sure all published applications work together.

Guidelines for a Dragon administrator in a Citrix environment

Use one of the following approaches to provide users with access to applications:

■ In Citrix, publish the desktop and let users start applications from the published desktop.

■ In Citrix, use identical settings to publish all the applications that users require. If the settings are not iden-
tical, Dragonmay not operate correctly with other applications you publish. For example, if the settings you
use to publish Microsoft Word are different than the settings you use to publish Dragon, the microphone hot-
key will not work in Microsoft Word.



Guidelines for a Dragon client user in a Citrix environment

The following guidelines apply if you publish separate applications and do not publish a Desktop.

1. Start all applications in Seamless mode.

2. Do not change Application Set settings when you run a published application.

3. When you use the Smooth Roaming feature with published applications that are on multiple computers, per-
form one of the following actions:

■ Close all published applications before moving to a new location.

■ Start published applications in the same order on all the machines that you use. For example, if you run
a published Microsoft Word application on a computer, to work in the same session when you move to a
new computer, start Microsoft Word on the new computer before you start another published application
like Dragon. This allows the published Dragon application to run in the same session as Microsoft Word.

Notes

■ Citrix will start published applications in separate sessions when:

1. The applications are published with different settings (Colors, Enable Legacy Audio, Encryption). Cit-
rix places applications into seperate Windows sessions if the color settings are different. Using different
color settings may cause problems with dictation. If you have problems with applications that use dif-
ferent color settings, use the same color settings for all applications.

2. You publish even one application as a Desktop.

3. The client does not start the application in Seamless mode.

4. A client launches one application, changes Application Set settings, and then launches another appli-
cation.

5. A user starts different applications from different machines. If the user starts the same application from
a different machine, it connects to the same session and disconnects the previous session, as in Smooth
Roaming feature.

Setting up the Program Neighborhood on Citrix clients

2. If you intend to dictate from the Citrix client, you must run the Citrix Client Update before you run Dragon for

the first time.

3. After you publish Dragon and the Citrix Client Update, the Citrix ICA clients should see and display both pro-

grams in their Citrix Program Neighborhood window (or Web Client interface). For example: 



When you start Dragon from the client, you should change from DragonBar mode to Floating mode to make it
easier to display other applications you run from a server.

Prepare to run the Citrix Client Update

4. In order to run the Citrix Client Update, each client machine must be joined to the network domain of the Citrix

server. In other words, the Citrix server must be able to recognize the client's Windows logon credentials. If the

client is not joined to the network domain of the Citrix server, you may see an error message when you try to run

the Citrix Client Update.

5.

As a workaround, you can connect the client machine to the server, providing your domain user name and pass-

word.

1. From the Windows Explorer, click on the Tools menu and then click Map Network Drive.

2. In Drive, type or select the drive letter to map to the shared resource.

3. In Folder, type the server and optionally, the share name of the resource, in the form of \\server name\
share name. You can also click Browse to locate the resource.

4. Click Finish.

5. In the User name and password dialog box, type your user name in the form of domain\user name.

6. In Password, type your domain password.

Install the Citrix Client Update

You must have administrator rights to install the Citrix Client Update. You do not need to re-install the Citrix
Client Update if it was installed earlier as part of an MSI installation. See Installing the Citrix Client Update
using MSI installer for more information.



During the installation of Citrix Client Update,you may see the following error message:

Unable to set High Sound Quality in your Citrix client. It is recommended that you do this manually

Double-check that the Audio settings on your client are set to high. For more information, see Enable sound
quality on the client before you start Dragon as a published application.

Note: about Winterm

1. Double-click the Citrix Client Update icon in the Program Neighborhood to start the Citrix Client Update
installer wizard.

2. When prompted, click Next and then Patch to start the installation.

3. When the installation completes, click Finish.

Enable sound quality on the client before you start Dragon as a published application

After you install the Citrix Client Update and before you start Dragon as a published application, you must
enable sound on the client for the application set for Dragon on each Citrix client.

1. From the Citrix Program Neighborhood, select the Application Set that contains Dragon and the Citrix Client
Update.

2.
From this Application Set click the Settings button .

The Settings dialog for the selected application set displays.

3. Select the Default Options tab and unselect the Sound Server Default check box.

4. Select the Enable Sound check box.



5. In the drop-down list under Enable Sound, select High sound quality.

Notes:

■ Using the Web Client Interface: If Dragon is published with the Audio quality set to low on the server but
with the Audio quality set to high on the client through the Program Neighborhood, the client will not
receive an Audio Quality warning when Dragon is started through the Web Client Interface.

■ If you are using a Phillips SpeechMike, set up your system so that sound playback is through a different
device and not the SpeechMike. To do this, select Sound and Audio Devices from the Windows control
panel and use the Audio tab to set your Sound playback and Sound recording devices.

■ There must be sound system installed on the client. For example, if your client has disabled USB audio, you
cannot create a Dragon user profile. If you disable USB audio, enable it and re-connect to the Citrix server.

Running Dragon on a Winterm device

If you want to dictate with Dragon NaturallySpeaking or Dragon Medical on a Wyse thin computing device (Win-
term) running Microsoft Windows XP Embedded (XPe), you must run the Citrix Client Update on that device
before you run Dragon for the first time.

Note: Nuance has tested this procedure with the Wyse S90 with native support for ICA client 9.x.

Prepare a WinTerm device for use with Dragon in a Citrix environment

1. Log into the Wyse thin computing device as an Administrator.

2. From the Administrator desktop or a command prompt, disable the Enhanced Write Filter (EWF) to unblock
write operations on the flash memory so you can install the Citrix Client update.

3. Open the Citrix Program Neighborhood, enable sound on the client for the application set for Dragon. For
more information, see Setting up the Program Neighborhood on Citrix clients.

4. From the Wyse thin computing device, map a network drive to the location where you published the Dragon
audio client as content.
You can map the network drive using the Windows Explorer or a command prompt. For example:

net use * \\server_name\c$ /user:domain_name\user_name * /persistent=no

5. In the Program Neighborhood, double-click the Citrix Client Update icon to install the Dragon audio client.



6. Follow the instruction from the Citrix Client Update install wizard.

7. Log out of the Administrator account if required.

After you install the Citrix Client Update, you can start Dragon and create your user profiles.

After installation, the Citrix Client Update uses approximately 118 KB of flash memory on the Winterm
device.

Increase the volume of the microphone when creating user profiles on a WinTerm device

When you create a Dragon user profile on the Winterm device, if you see a "Sound level is too low" error, you
must manually increase the volume of the microphone.

1. On Windows XP, select Start > Control Pane l> Sound and Audio Device. On Windows Vista, select
Start > Control Panel > Sound.

2. On Windows XP, select Audio tab. On Windows Vista, select Recording tab.

3. Perform one of the following actions to boost the microphone volume:

■ On Windows XP, double-click the Volume button under Sound recording to display the microphone
slider. Move the slider all the way to the right to set the maximum boost. If you see a Boost checkbox,
select the checkbox.

■ On Windows Vista, double-click the Microphone icon to display the Microphone Properties dialog.
Your sound card and microphone determines if you set the boost from the Levels or the Custom tab. If
you see a slider to set the boost, move the slider all the way to the right to set the maximum boost. If you
see a Boost checkbox, select the checkbox.

Disabling or redirecting Citrix Logging

When you start a Citrix ICA session, the ICA client starts and loads the module.ini file from the root folder of
the Citrix client. This module.ini file contains a list of the parameters used to select and configure the com-
munications stack modules.

To save space on the Citrix client, you can disable or redirect Citrix logging:

1. Open the module.ini file. By default, the module.ini file is located in the Citrix client directory:
C:\Program Files\Citrix\ICA Client

2. To disable logging:

■ Go to the [VDDNS] section.

■ Change the line LogLevel=2 to LogLevel=0.

3. To redirect logging to another location or device:

■ Go to the [VDDNS] section.

■ Change the path in the line.

4. Save and exitmodule.in.



Customizing Vocabularies with the Dragon Vocabulary Tool (Voctool)

You use the Dragon Vocabulary Tool to customize a vocabulary by adding new words and by optimizing the
language model.

This section of the Administrator Guide Help describes the Vocabulary Tool Wizard and includes the following
topics:

■ Starting Voctool — Starting the Voctool UI and command line.

■ Step 1: Selecting a user profile— The type of information available that can be modified on the introduction
screen.

■ Step 2: Choosing Documents — Selecting documents for the Vocabulary Tool to analyze.

■ Step 3: Choosing Word Lists — Selecting word lists for analysis.

■ Step 4: Analysis Settings — Specifying how the Dragon Vocabulary Tool analyzes the documents and word
list files you chose.

■ Step 5: Analyzing Files — Confirming the file list; stopping and resuming the analysis.

■ Step 6: Previewing New Words — Reviewing new words, their frequency, etc.; clearing, editing, saving, and
training words from the word list.

■ Step 7: Training Added Words — Selecting the words to train.

■ Step 8: Build the Language Model — Building a new language model with the information you collect.

■ Summary Page — Displaying information about the newly-built language model.

■ Voctool command line switches — Listing command line switches.

Starting Voctool

There are two ways to start Voctool:

■ Click Start > All Programs > [[[Undefined variable Primary.XXXProductNameXXX]]] 11 > [[[Undefined var-
iable Primary.XXXProductNameXXX]]] > Voctool.

■ You can run the Vocabulary Tool using MS-DOS commands. To view a list of command-line switches for run-
ning the Vocabulary Tool, type voctool.exe /? at the prompt inside a command-prompt window. See Voc-
tool command line switches for a list of switches. By default, voctool is located in:
C:\Program Files\Nuance\NaturallySpeaking11\Program

Notes

When you start the Voctool, on the Introduction page of the wizard you are immediately prompted to select a
user profile/vocabulary. Once you select a user profile, you can click the Change User/Vocabulary... button
to change the user profile only before you proceed with running the Voctool. Do not change the current user
profile or the vocabulary after you make this selection or while you are running the Vocabulary Tool. If you do
try to change the user profile or vocabulary, the Vocabulary Tool stops running and discard any changes.



Voctool overview

You can use the Vocabulary Tool to customize a vocabulary by adding new words and optimizing the language
model.

You can use the Introduction page in the Vocabulary Tool to find and modify the following information:

User

The name of the user profile that the Vocabulary Tool modifies.

Vocabulary

The vocabulary type you apply when you create a user profile.

The Change User/Vocabulary button

You click this button to open the Select User dialog box and choose a different user profile from a list of avail-
able user profiles.

Using the Introduction page to add words to a vocabulary

1. Select one of the following two options to add new words to the vocabulary:

■ Use the Add new words from documents and adapt to writing style option to instruct the Vocab-
ulary Tool to examine the documents you choose in the Choose Documents page. In general, you should
select documents that reflect the preferred writing style and vocabulary of the person that uses the mod-
ified user profiles for dictation.

■ Use the Add new words from word list files option to instruct the Vocabulary Tool to examine the
files you choose in the Choose Word Lists page. When you choose this option, the Vocabulary Tool only
add words and does not analyze word frequency or otherwise adapt the vocabulary to a particular writing
style.

2. Click Next.

Notes

■ Do not change the current user profile or the vocabulary when you run the Vocabulary Tool. If you do try to
change the user profile or vocabulary, the Vocabulary Tool stops running and does not save any changes it
made.

■ You can use MS-DOS commands to run the Vocabulary Tool from a command line. To view a list of com-
mand-line switches for the Vocabulary Tool, on a command line, type voctool.exe /?.

Voctool:Choosing Documents

You use the Choose Documents page of the Vocabulary Tool to select documents for the Vocabulary Tool
to analyze. The Vocabulary Tool identifies words in a document that are not in the current vocabulary. The
tool analyzes the frequency and order of the words in the samples to understand the writing style of the author
of the document.

You can modify the list of documents that display on this page, then click Next to proceed with the wizard.

The following information and buttons appear on this page:



The document list

The document list is a list of documents that the Vocabulary Tool will process. If no documents appear in the
list, click the Add Folder or Add Document button to find and add a folder or a document. You can use the but-
ton to the right of the document list to add and remove documents or folders from the list.

The Add Folder button

You click the Add Folder button to open the Browse for Folder dialog box and select a folder of documents to
display in the documents list. You can click the Add Folder button as many times as necessary to add addi-
tional folders of documents to the list.

The Add Document button

You click the Add Document button to open the Add Documents dialog box and select documents from a
folder to display in the documents list. You can press the CTRL key and select multiple documents at once. You
can also press the SHIFT key and select a range of documents by clicking the first and last documents in a
range of documents. You can click the Add Documents button as many times as necessary to select different
documents to add to the list.

The Remove Document button

You select documents and click the Remove Document button to remove documents from the document list.
You can press the CTRL key and select multiple documents at once. You can also press the SHIFT key and
select a range of documents by clicking the first and last documents in a range of documents.

The View Document button

You select a document and click the View Document button to open the document in its native application. For
example, if the document has a .doc extension, Microsoft Word starts and displays the document. The appro-
priate application must be available on your computer for you to view a document.

The Save List button

You click the Save List button to open the Save Document List as File dialog box and save the current list of
documents as a .txt file in a folder. The text file contains the names of each file and the full path to each file.
The Vocabulary Tool can process the following types of files:

■ Microsoft Word (*.DOC)

■ Corel WordPerfect (*.WPD)

■ ASCII Text (*.TXT)

■ Rich Text Format (*.RTF)

■ HyperText (*.HTM, *.HTML, *.SHTM, and *.SHTML)

If your computer does not have access to an application that can open a particular type of file, the Vocabulary
Tool will not be able to process the document.

The Load List button

You click the Load List button to open the Load Document List from File dialog box and load a file that con-
tains a list of documents. This is the file you create using the Save List button. If you attempt to load a file that
does not contain an appropriate file list, an error message displays and the contents of the file do not appear in
the document list.



Note: Do not process a document that contains invalid characters or text that does not reflect the writing style
of a user represents. Processing the document may damage the vocabulary or decrease the recognition accu-
racy of Dragon by building a Language Model from examples that do not reflect the dictation style of the user.

Voctool:Choosing Word Lists

You use the Choosing Word Lists page of the Vocabulary Tool to select word lists for the Vocabulary Tool
to analyze. The Vocabulary Tool can identify if a word is in the current vocabulary.

A word list is an ASCII text document that contains words or shorts phrases to add to a vocabulary. Each word
or phrase should be on an separate line. You can use a backslash (\) to separate the written form of a word
from the spoken form of a word. For example: "& Co.\and Company"

The following information and buttons appear on this page:

Word Lists

A list of files that contain the word lists that the Vocabulary Tool can process. You can use the buttons on the
right of the Word list to add or remove file names from the list. You can select Export custom word and
phrase list on the Vocabulary menu of the DragonBar to create a word list file from a current Dragon user
profile.

The Add Word List button

You click the Add Word button to open the Add Word List Files dialog box and to select file names to display
in the documents list. You can press the CTRL key and select multiple files at once. You can also press the
SHIFT key and select a range of files by clicking the first and last files in a range of files. You can click the Add
Word List button as many times as necessary to select different folders that contain files to add to the doc-
ument list.

The Remove Word List button

You click the Remove Word List button to remove a file or set of files from the documents list. You can press
the CTRL key and select multiple documents at once. You can also press the SHIFT key and select a range of
files by clicking the first and last files in a range of files.

Note: Do not process a document that contains invalid characters or text that does not reflect the writing style
of a user represents. Processing the document may damage the vocabulary or decrease the recognition accu-
racy of Dragon by building a Language Model from examples that do not reflect the dictation style of the user.

Voctool:Analysis Settings

You use the Analyze Settings page in the Vocabulary Tool to configure how the Vocabulary Tool analyzes
documents and word list files. You use the Choose Documents page or the Choose Word Lists page in the Vocab-
ulary Tool to select documents and word list files.

You can change the following settings:

The Vocabulary Tool: Find unknown words

You use the Find unknown words option to have the Vocabulary Tool find words that are not already in the
vocabulary. This option is only available if the Vocabulary Tool is analyzing documents and not word lists.

The Vocabulary Tool: Find known words with unknown capitalization

You use the Find known words with unknown capitalization option to have the Vocabulary Tool find
words that are in the vocabulary but with a different capitalization. Only use the Find known words with



unknown capitalization option with word lists that you want to add to a vocabulary. Otherwise, you might
add words to a vocabulary unintentionally.

The Vocabulary Tool: Enable word frequency counting

The Enable word frequency counting option only displays when you select Add new words from doc-
uments.

You use the Enable word frequency counting option to let Dragon count how many times a new word
appears in your documents and display that number in the Vocabulary Tool after Dragon analyzes the doc-
uments. The maximum number Dragon displays is 100.

Note: If you are analyzing a large set of text, you should disable frequency counting to improve performance.

The Vocabulary Tool: Preview the list of unknown words

You use the Preview the list of unknown words option to make the Vocabulary Tool open the Preview
New Words page and display unknown words and known words with unique capitalization. A Preview New
Words page appears where you can modify the list and select specific words that the Vocabulary Tool found.

The Vocabulary Tool: Add all unknown words without previewing them

You use the Add all unknown words without previewing them option to have the Vocabulary Tool skip
the Preview New Words page. The Vocabulary Tool then adds all the unknown words and the known words
with unique capitalization to the vocabulary without letting you modify the list.

Voctool: Analyzing Files

You use the Analyzing Files page of the Vocabulary Tool to analyze the documents and word list files you
choose in the Choose Documents page or the Choose Word Lists page.

The Analyzing Files page contains the following information and controls:

The File list

The file list is a scrollable list that displays the files or documents that the Vocabulary Tool is processing.

■ A check mark next to a file name indicates that the Vocabulary Tool is done its analysis of a file.

■ An Xmark next to a file name indicates that the Vocabulary Tool did not successfully complete its analysis
of a file. Reasons why the analysis did not complete include a user pressing the Stop button or an error occur-
ring while the Vocabulary Tool read the contents of the file.

■ An hourglass symbol next to a file name indicates that the Vocabulary Tool is currently analyzing the file.

When the Vocabulary Tool finishes analyzing all the files in the file list, a message displays below the file list
with information about the number of documents the Vocabulary Tool analyzed.

The Stop button and the Resume button

You click Stop to stop the Vocabulary Tool from processing a file.

You click Resume to have the Vocabulary Tool restart the analysis of a file.

The Progress bar

As the Vocabulary Tool performs analysis of a file, the progress bar displays information about how much of
the file the Vocabulary Tool has analyzed.



Voctool: Preview New Words

You can use the Preview New Words page of the Vocabulary Tool to view the list of words that the Vocab-
ulary Tool identifies as either not in the current vocabulary or as having a unique capitalization.

The following information and buttons appear on this page:

Word

You can scroll the Word list and use the check box to the left of a word to tell the Vocabulary Tool to add or
not add the word to the vocabulary. Check this option to add a word to a vocabulary. Uncheck this option to not
add a word to a vocabulary.

Frequency

Frequency indicates how many times a word appears in the documents the Vocabulary Tool analyzes. This
information appears only if you select the Enable word frequency counting option on the Introduction
page of the Vocabulary Tool. The maximum number the Vocabulary Tool displays is 100.

Check All

Click the Check All button to check all the words in the Word list.

Clear All

Click the Clear All button to clear all the words in the Word list.

Edit

You can select a word in the list and click the Edit button to open the Edit Word dialog box and change the
written form and spoken form of a word. The Edit Word dialog box also displays the context and frequency
with which the word appears in the document the Vocabulary Tool analyzes.

Save

You can click the Save button to open the Windows Save As dialog box and save the contents of the Word list
as a file. Use the dialog box to provide a name and a location for the file. You can use this file with the Vocab-
ulary Tool at a later time to modify the vocabulary of other user profiles.

Train added words

You can select the Train added words option to open the Train Added Words page of the Vocabulary Tool
and train selected words and fine tune Dragon's recognition of your pronunciation.

The Train added words feature is only available when you run the Vocabulary Tool as part of a normal
installation of Dragon. You cannot use the Vocabulary Tool to train words if you are running the DSS SDK edi-
tion of Dragon.

Voctool: Training Added Words

You can use the Training Added Words page of the Vocabulary Tool wizard to train Dragon to better rec-
ognize your pronunciation.

This feature is available only when you run the Vocabulary Tool as part of a normal installation of Dragon.
You cannot use the Vocabulary Tool to train words if you are running the Dragon SDK Server Edition (DSS) .

The following information and buttons appear on this screen:



Word

The Word list contains the words you selected on the Preview New Words screen. Select the words you want to
train from this list. A check mark in the box to the left of the word indicates that you want to train that word.

Check All

Click the Check All button to select all the words in the Word list.

Clear All

Click the Clear All button to deselect all the words in the Word list.

Train

You can click the Train button to open the Train dialog box where you can train Dragon to recognize your pro-
nunciation of the words you selected. If you have selected more than one word to train, the Train dialog box dis-
play the words in the order that they appear in the list.

Note

Only the person that will dictate with the user profile you are modifying can perform the training. If that person
is unavailable for this Vocabulary Tool session, then training can also occur during a Dragon session. See
"Training individual words and phrases" in the Dragon Help for more information.

Voctool: Language Model Build Settings

You can use the Language Model Build Settings page of the Vocabulary Tool wizard to build a new lan-
guage model with the information the tool gathers. You also use this page to provide Dragon with the location
and maximum size of the new vocabulary.

The following settings appear on this page:

Build language model

You can use the Build language model option to have the Vocabulary Tool build a new language model that
contains the words and other information you provide to the tool in other pages of the Vocabulary Tool.

Language Model locator

If you are building a language model for a Solution Series version of Dragon, you can select either the Middle or
the User slot as a location for a language model. If you are building a language model for a Preferred version of
Dragon, select the User slot as the location of the language model.

Language model size limit (Solution Series or SDK Server Edition only)

If you build the Language Model into the Middle slot, you can use the Language model size limit list to limit
the size of the model. You can specify a size limit between 0.5 MB and 5 MB. If you do not want to set a limit,
select Unspecified from the list.

Existing Model built by:

You can use the Existing Model built by option to specify the version of the Vocabulary Builder that
created the previous Language Model. This information only appears if the user profile you are building a lan-
guage model for has an existing language model.



Preserve existing model

This option only appears if the user profile you are building a language model for has an existing language
model. Selecting Yes merges the new language model with the current one. Selecting No builds a new lan-
guage model to replace the existing one. Normally, you should accept the recommended value, which can vary
depending on the location of the language model and the version of Dragon. The recommendations for the Solu-
tion Series and Preferred editions of Dragon are:

■ For Dragon NaturallySpeaking Solution Series, middle slot, the recommendation is No.

■ For Dragon NaturallySpeaking Solution Series, user slot, the recommendation is Yes.

■ For Dragon NaturallySpeaking Preferred, user slot, the recommendation is Yes.

You cannot build a language model in the middle slot of Dragon NaturallySpeaking Preferred edition.

Voctool: Summary page

The Summary page of the Vocabulary Tool wizard displays information about the newly built language
model. After you review the information on this page, click Finish to exit the wizard.

The following information appears on this page:

Details

The details box contains the following information:

User

The name of the user profile the Vocabulary Tool modifies.

Vocabulary

The base vocabulary type of the user profile.

Language

The language of the vocabulary, including any specific variation of that language, such as United States Eng-
lish.

Additional information

The following information may also appear:

■ The number of documents the Vocabulary Tool analyzed.

■ The names of the documents or word lists that the Vocabulary Tool processed.

■ The number of unknown words that the Vocabulary Tool found.

■ The number of words the Vocabulary Tool added.

■ Whether the Vocabulary Tool saved the previous language model or built a new language model, and if
it did, which language model location was used.

■ Any warnings or any non-critical errors that might have occurred during processing

Save speech files

You can select the Save speech files option to save the new user profile and make it available for future
Dragon sessions.



Voctool command line switches

When you start the Voctool from the command line, you must first switch to the follow directory:

C:\Program Files\Nuance\NaturallySpeaking11\Program

Then type the following syntax:

voctool.exe switches

where switches is one or more (or a combination of) the following:

Switch Required with /S Purpose

/S NA Silent mode - do not display a GUI and do not
display messages on the screen when you run
voctool.

/U <user> Yes. User name - indicate the user profile whose
vocabulary you are running the voctool on.

voctool requires that you use this switch when
you use /S.

/V <vocabulary> Yes, for an existing

vocabulary.
Vocabulary name - voctool requires that you use

this switch if the vocabulary exists; otherwise

use you must use /VN to create a new vocab-

ulary.

/VN <vocabulary> Yes, if vocabulary does

not yet exist.
Create a new vocabulary if one doesn't yet exist
for this user profile. voctool uses the empty
new vocabulary as the base vocabulary.

voctool requires that you use this switch if the
vocabulary does not yet exist; otherwise, if the
vocabulary exists, use /V to use the current
vocabulary name.

If you are using a version of Dragon that does
not have base vocabularies, you must include
/VB to indicate the base vocabulary alongside
/VN.

/VB <base vocabulary>  No. Use in conjunction with /VN to indicate the name
of the base vocabulary.

<doc file> Yes, either this doc,/WI

with a word list, or /WLI

with a list of word lists.

Input document.

/DI <doc list file> No. A list of input documents - a list of documents to

retrieve words from for the vocabulary.

/DO <doc list file> No. A list of output documents - a list of documents to

export words from the vocabulary to.



/WI <word list file> Yes, either this option,

<doc file>, or /WLI with

a list of word lists.

An input predefined word list.

/WLI <wordlists list file> Yes, either this option,

<doc file>, or /WI with

a list of words.

An input file that lists predefined word lists.

/WO <word list file> No. An output list of added /new words in the vocab-

ulary to the file indicated.

/WLO <word list file> No. Output list of added words from both predefined

word lists and documents along with word

frequency.

/AW[C][<n>] No. Add unknown words to a vocabulary:

■ C=add known words with unknown cap-
italization.

■ n=the minimum number of times that a word
must appear in a document. If a word
appears the minimum number of times, add
the word to the vocabulary.

/LM- No. Do not build language model - include the minus

sign at the end of /LM.

/LM[M|U][N|I] No. The Build language model:

■ M=Middle Slot* (default)

■ U=User Slot*

■ N=Non-incremental (default)

■ I=Incremental

/LMSIZE <size> No. The size of the Middle Slot language model - one

of (0.5, 1, 2, 3[default], 4, or 5).*

/NS No. Do not save changes to the vocabulary. Applies

only in Silent mode.

/Summary <file> No. Write summary of session actions to a file.

/? No. Displays this list of options.

*For more information on language model slots, see Storing language model information.

To see some examples of running voctool.exe on the command line, see Voctool command line examples.



Voctool command line examples

The following are examples of how to use the Voctool from the command line:

Example 1

To use Voctool to add a set of new words to the General vocabulary of a user profile named Katarina Phelps, you
would first copy the file that contains the words (NewWords.txt) to the Program Files\N-
uance\NaturallySpeaking11\Program directory, then type the following on the command line:

voctool.exe /S /U "Katarina Phelps" /V "General - Large" /WI NewWords.txt
/AW /Summary voc_actions.txt

The /AW option is required to add the new "unknown" words to the vocabulary.

The voc_actions.txt file contains a summary of the actions that Voctool performs.

Dragon Vocabulary Tool Version x.xx

User:______________Katarina Phelps
Vocabulary:________General - Large
Language:__________0x409 - English (United States)

Processed 1 word list file(s):
________NewWords.txt

7 unknown word(s) found.
7 word(s) added.

Language model was not built.
No errors occurred.
No warnings occurred.

Example 2

In this example, we perform all of the actions from Example 1 and also build the language model using the new
words. On the command line, we include the /LM option to build the language model. To have Voctool store the
language model in the Middle slot, you would addM after /LM; to store the language model in the User slot,
you would add U after /LM.

You can instruct Voctool to have the language model include all previous changes (called non-incremental) by
adding an N after /LM or have the language model include only the most recent changes (called incremental)
by adding an I after /LM.

If you include /LM on the command line and do not specify a particular slot to build the language model in or do
not specify the type of build to do, Voctool builds the language model non-incrementally and stores it in the
Middle slot.

To build the language model in an incremental fashion and store it in the User slot, type the following on the
command line:

voctool.exe /S /U "Katarina Phelps" /V "General - Large" /WI NewWords.txt
/AW /LM U I /Summary voc_actions.txt



Example 3

To use Voctool to add a list of drug names to the vocabulary of a medical provider named Jackson Stone, you
would first copy the file that contains the drug names (DrugNames.txt) to the Program Files\N-
uance\NaturallySpeaking11\Program directory, then type the following on the command line:

voctool.exe /S /U "Jackson Stone" /V "Internal Medicine - Large"
/WI DrugNames.txt /AW /Summary actions.txt

Be sure to use the full name of the vocabulary, including "- Large" in this case.

The actions.txt file contains a summary of the actions that Voctool performs :

Dragon Vocabulary Tool Version x.xx

User:______________Jackson Stone
Vocabulary:________Internal Medicine - Large
Language:__________0x409 - English (United States)

Processed 1 word list file(s):
________DrugNames.txt

7 unknown word(s) found.
7 word(s) added.

Language model was not built.
No errors occurred.
No warnings occurred.

Definition: The language model

In addition to a word list, a vocabulary has a language model that contains statistical information. The statistics
help predict which words are most likely to occur in the context of a user's speech. This information includes:

■ unigram probability: The likelihood that a word occurs in text compared to other words in the same vocab-
ulary. For example, if the verb �write� is more likely to occur in text compared with the name �Wright,� then �
write� will have a higher unigram probability.

■ bigram and trigram probabilities: The likelihood that a two-word or three-word sequence occurs in text. For
example, if the bigram �Mr. Wright� is more likely than Mr. write,� the language model should favor Mr.
Wright even though �write� has a higher unigram probability than �Wright.� In this context the bigram/trigram
probability outweighs the unigram probability.

Storing language model information

A vocabulary stores language model information in three slots. Not every vocabulary contains information in
each slot.

Slot Description

base Stores the base language model that ships with Dragon. You cannot modify the information in the base
slot.



middle Can contain a custom language model based on a significant amount of data, developed for a target

group of users. The only way you can modify the custom slot is by using the Vocabulary Tool.

user Can contain a language model based on a relatively small amount of data for use by at most a few

users. Individual users can modify the user slot using the Vocabulary Builder feature of Dragon. You

can also modify the user slot using the Vocabulary Tool.

With the Professional editions of Dragon NaturallySpeaking, you can use vocabularies with a middle slot lan-
guage model that you modify with the Vocabulary Tool.

In the SDK Client and SDK Server editions of Dragon, you can use the Vocabulary Tool to modify middle slot
language models.

Return to previous topic



Adding words, commands, or vocabularies to User Profiles

You use the nsadmin utility or the Data Distribution Tool to make new words, customized vocabularies, or
new commands available to all User Profiles on a particular installation of Dragon. Both the nsadmin utility and
Data Distribution Tool can work across a network. Dragon Medical Small Practice Edition does not support
the nsadmin utility or the Data Distribution Tool.

The nsadmin utility lets you use the command line to make new words, commands, and vocabularies available
to users. The nsadmin utility can perform only one action at a time. However, you can create a batch file or
script that can perform multiple nsadmin operations on a computer.

The Data Distribution Tool lets you use a GUI to interact with the nsadmin utility and make new words, com-
mands, and vocabularies available to users.

Note: You can use the Voctool to customize a vocabulary by adding new words or optimizing the language
model for a particular user profile. For more information, see the Voctool Help.

Using the Data Distribution Tool

With the Dragon Professional, Legal, and Medical editions, you can use the Data Distribution Tool to inter-
actively make new words, customized vocabularies, or custom commands available to all users on a particular
installation of Dragon.

You run the Data Distribution Tool on each installation of Dragon where you want the new words or vocab-
ularies to be available to Dragon users.

This section describes:

■ Creating the Data Distribution Directory

■ Starting the Data Distribution Tool

■ Adding and removing custom words

■ Adding and removing vocabularies

■ Adding and removing custom commands

You can also run the nsadmin utility from the command line. For more information, see The Nsadmin utility for
new words, vocabularies, and commands.

Creating the Data Distribution Directory

You create a data distribution directory to store word lists, commands, or both, that you plan to distribute to
multiple users of Dragon NaturallySpeaking or Dragon Medical.

When word lists and commands are in the data distribution directory, as soon as a person opens their user pro-
files, Dragon automatically imports words and commands from the data distribution directory into the user pro-
files. This occurs regardless of the location of the computer the user dictates on.

You can use the Data Distribution Tool to put words and commands into a data distribution directory. For
more information, see Starting the Data Distribution Tool.



Note: The default installation of Dragon places custom words for existing Dragon user profiles in:
C: \Documents and Settings\All Users\Application Data\Nuance\Dragon Nat-
urallySpeaking11\custom.

Create a data distribution directory in a location other than the default location

Repeat the following steps for each workstation that should share the distributed words or commands.

1. In Dragon, close all open user profiles.

2. On the network, create a directory and give all users that dictate with Dragon access to the directory. Grant
read access to providers that dictate. Grant write access only to administrators.

3. If Dragon is running, on the DragonBar, select Tools > Administrative Settings. When the Admin-
istrative Settings dialog box opens, proceed to Step 6.

4. If Dragon is not running, select Start > Run. When the Run dialog box opens, in the Open text box, type the
following, making sure to put a space between natspeak.exe and the /SetDefaultAdministrativeOptions
option:

“c:\Program Files\Nuance\NaturallySpeaking11\Program\natspeak.exe” /Se-

tDefaultAdministrativeOptions

(The quotation marks are required because Program Files contains a space. Your path might not require
quotation marks.)

5. Click OK.

6. When the Administrative Settings dialog box opens, if the user profile opens automatically, click Cancel
to close the user profile or go to the DragonBar and select Profile > Close User Profile.

7. Click the Miscellaneous tab.

8. In the Data distribution location text box, click Change... and browse to a location where you want
Dragon to store custom words and commands.

9. Click OK.

10. Click Apply to save the changes.

11. Click OK to close the dialog box.

You can now use the Data Distribution Tool or the nsadmin command line utility to put new words and com-
mands into the data distribution directory. For more information, see Starting the Data Distribution Tool or Start-
ing the nsadmin command line utility.

Starting the Data Distribution Tool

You can use the Data Distribution Tool to make new words, customized vocabularies, or new commands
available to all Dragon users on a particular installation of Dragon.

You can run the Data Distribution Tool on a local machine or through a network connection. The tool supports
both mapped drives and UNC paths.

Before you use the Data Distribution Tool, you must create a data distribution directory. For more infor-
mation, see Creating Data Distribution Directory.



Start the Data Distribution Tool

A default installation of Dragon stores custom commands for Dragon user profiles in:

■ Windows XP:
\Documents and Settings\All Users\Application Data\Nuance\Dragon Nat-
urallySpeaking11\Custom\<language>.

■ Windows Vista and Windows 7:
\ProgramData\Nuance\NaturallySpeaking11\Data\enx\Custom\<language>

1. Select Start > All Programs > Dragon NaturallySpeaking 11> Dragon NaturallySpeaking Tools >
Data Distribution Tool. Dragon displays the first page of the Data Distributionwizard.

2. Select one of the following options:

■ Add or remove base vocabularies

■ Add or remove shared commands

■ Add or remove word to share across vocabularies

3. Click Next.

4. Click the Advanced button to set the location where the local installation of Dragon stores customized words
and commands.

Adding and removing custom words

You can use the Data Distribution Tool to make new words available to all users on a particular installation of
Dragon.

Before you use the Data Distribution Tool, you must create a data distribution directory. For more infor-
mation, see Creating Data Distribution Directory.

You must first either create a text file or export words from an existing user's installation of Dragon before you
can distribute the words (for example, a list of new drug names) to a different installation of Dragon.

After you use the nsadmin utility to import the custom words, you must close your user profiles, re-open the
user profiles, and save them for the changes to become available.

Create a text file that contains custom words

Perform one of the following two actions before you distribute a set of custom words to a particular installation of

Dragon:

Create a text file that contains custom words

1. Create a text file.

2. In the text file, add each word or phrase that you want to add to the vocabulary. Make sure each word or
phrase uses correct spelling and is a on a separate line.

■ To add a multiple-word phrase, such as "Mayberry Tribune", type it on one line.

■ To include a spoken form of a word, type the word followed by a backslash (\) and the spoken form of a
word. For example, to have Dragon enter "Robert F. Kennedy"when you say "RFK," type Robert F. Ken-
nedy\RFK in the text file.



Create a text file that contains custom words

1. If you have Dragon available on another machine, you can use it to create custom words and export the
words to a .txt file. For more information, see the main Dragon Help file.

Add custom words to a shared location

When you use nsadmin, you can enter paths as complete local paths, relative paths, mapped network drives, a
UNC path, or the path to removable media such as a CD-ROM or ZIP drive. For more information, see Using
paths with nsadmin.

You must create .txt file (newwords.txt in the following examples) that contains custom words before you per-
form the following steps. For more information, see Create a text file that contains custom words.

1. If you have not already created it, create the data distribution directory. For more information, see Creating
Data Distribution Directory.

2. On each computer that a user uses for dictation, map a network drive to the location of the data distribution
directory. As an alternative, you may reference the network UNC address of the location of the nsadmin util-
ity.

3. Start the Data Distribution Tool. For more information, see Starting the Data Distribution Tool.

4. In the Data Distribution Tool, make the appropriate selections to add the list of words to the data dis-
tribution directory. For more information, see Use the Data Distribution Tool to add custom words.

Use the Data Distribution Tool to add custom words

If you add custom words to a Commands Only vocabulary,when you upgrade a user profile, the upgrade proc-
ess does not retain the custom words. In general, you should not add custom words to a Commands Only
vocabulary.

1. On the Data Distribution Tool, select Add or remove words to share across vocabularies.

2. (optional) To choose a location for the custom words on the local machine, click Advanced. In the Custom
directory text box of the Advanced Settings dialog box, type the path to the new location for the custom
words. If you do not take this step, Dragon copies the files to the following default location:
\Documents and Settings\All Users\Application Data\Nuance\Dragon NaturallySpeaking11\Custom\enx

3. Click Next.

4. Associate a language with the custom words.

5. Click Next.

6. When the list of files appears, use the Import button to select the .txt files that contain custom words. To
view the content of a file, select the file and click View. To remove a file from the list of files, select the file
and click Remove. To remove all files from the list, click Remove All.

Note: Once you add a text file that contains custom words to the data distribution directory, and a user opens
the profile, you cannot use the Remove and Remove All buttons to remove the custom words.

7. Click Next. The Data Distribution Tool displays a log of the operations it performs.

8. Click Finish to re-display the first page of the Data Distribution Tool or click Cancel to exit.



Adding and removing custom vocabularies

You can use the Data Distribution Tool to make a customized vocabulary available to all users on a particular
installation of Dragon. For example, you can use the Data Distribution Tool to copy a user profile's vocab-
ulary and set it as the base vocabulary on any installation of Dragon. After you add a base vocabulary to an
installation of Dragon, new user profiles you create can use that vocabulary.

Notes

■ The default installation of Dragon places vocabularies for existing Dragon user profiles here:
\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking11\users\<user_name>\c-
urrent

■ Vocabulary files end with the *.voc extension.

■ If you create a user profile on a dual core machine that uses a custom vocabulary, make sure that the user
profile uses the BestMatch IV speech model (BestMatch IV has the greatest recognition accuracy on dual-core
systems with more than 2 GB of RAM). To check this, select the Advance button on the Create User Profile
screen of the Creating a Profile wizard and make sure that BestMatch IV is selected.

Prepare to use the Data Distribution Tool to add a vocabulary

1. If you have not already created it, create the data distribution directory. For more information, see Creating
Data Distribution Directory.

2. On each computer that a user uses for dictation, map a network drive to the network location of the data dis-
tribution directory.

3. Start the Data Distribution Tool. For more information, see Starting the Data Distribution Tool.

4. In the Data Distribution Tool, add the vocabulary to the data distribution directory. For more information,
see Adding a vocabulary.

Use the Data Distribution Tool to add a vocabulary

1. In the Data Distribution Tool, select Add or remove base vocabulary.

2. Click Next.

3. Click Add to add a Base Vocabulary. Dragon displays the Add Base Vocabulary dialog.

4. In the Add Base Vocabulary dialog box:

■ Give the vocabulary a name. The name should describe the content of the vocabulary, such as Astron-
omy or Marketing.

■ Select the location of the vocabulary, either a mapped drive or a UNC address.

■ Give the vocabulary an unique numeric ID. Use a value greater than 9000 for the topic ID parameter.

5. Click OK.

The next time you open a user profile, Dragon automatically updates the user profile's vocabulary.

Use the Data Distribution Tool to add an exported vocabulary

You can use the Data Distribution Tool to distribute a vocabulary that you create using a separate installation
of Dragon. A Dragon vocabulary that you export saves as a group of files.

One of the exported files has a .top file extension, the other files have .to* file extensions, where * is an
integer.



1. In a command prompt, provide the path to the file with the .top file extension as an argument to the nsad-
min utility. Do NOT include the .top file extension on the command line.

The following command adds the myvoc exported topic (myvoc.top) as a new base vocabulary:

<PATH>\nsadmin /vocabulary D:\MyDocuments\myvoc "US English | Large | Nuance" 9005

Use the Data Distribution Tool to remove a base vocabulary

1. In the Data Distribution Tool, select Add or remove base vocabulary.

2. Click Next. Dragon displays the existing base vocabularies by ID and username.

3. Select the vocabulary to delete.

4. Click Remove and then click Next. The Data Distribution Tool displays a message when the vocabulary is
deleted.

5. Click Finish to close the Data Distribution Tool or click your browser's back button to re-display the
screen.

Adding and removing custom commands

Custom commands are voice commands that you can create and modify to enter text, insert graphics, or acti-
vate menus and keystrokes in any application. You can use the MyCommands Editor to create custom com-
mands or the Command Browser to modify custom commands. 

You can use the Data Distribution Tool to copy a set of custom commands to the data distribution directory
and make the set of custom commands available to all users at a particular installation of Dragon.

Before you use the Data Distribution Tool, you must have already created a data distribution directory, as
explained in Creating Data Distribution Directory.

Notes:

■ The default installation of Dragon places custom commands for existing Dragon user profiles here:
\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking11\Custom\<language>

■ After you import the custom commands to Dragon, for the changes to become available to those user profiles,
you must close your user profiles, then re-open and save the user profiles.

■ You can enter a path as a complete local path, a relative path, a mapped network drive, a UNC path, or the
path to removable media, such as a DVD, CD, or ZIP drive. For more information, see Using paths with nsad-
min.

Prepare to use the Data Distribution Tool to export custom commands

1. In Dragon, create custom commands.

2. Use the Command Browser to export the custom commands to a .dat file, for example, New-
Commands.dat.

3. If you have not already created it, create the data distribution directory. For more information, see Creating
Data Distribution Directory.

4. On each computer that a user uses for dictation, use the Data Distribution Tool to add the .dat file to the
data distribution directory. For more information, see Adding custom commands.



Use the Data Distribution Tool to add custom commands

1. Start the Data Distribution Tool. For more information, see Starting the Data Distribution Tool.

2. In the Data Distribution Tool, select Add or remove shared commands .

3. Click Next.

4. Select the languages for the user profiles that you will add custom words to.

5. Click Next.

6. Use the Import button to select the .dat files that contain the custom commands to add. Place the .dat files
into the New shared commands list in the upper half of the dialog box. You can modify the list by selecting
particular file names and using the Remove and Remove All buttons.

7. Click Next. The Data Distribution Tool displays a log of all the operations it performs.

8. Click Finish to re-display the Data Distribution Tool main screen or click Cancel to exit.

The next time you open a user profile, Dragon updates the commands in the associated user profiles. 

Use the Data Distribution Tool to remove shared commands

1. In the Data Distribution Tool, select Add or remove shared commands.

2. Click Next.

3. Select the languages for the user profiles that you will remove words from.

4. Click Next.

5. In the Existing shared commands list, select the command.

6. Click Remove.

7. Click Next. The Data Distribution Tool displays a log of all operations it performs.

8. Click Finish to re-display the Data Distribution Tool main screen or click Cancel to exit.

The Nsadmin utility for new words, vocabularies, and commands

Dragon Professional, DragonLegal, and Dragon Medical include the nsadmin utility. The nsadmin utility is a
command line utility that lets you make new words, customized vocabularies, and new commands available to
all users on a particular installation of Dragon.

The nsadmin utility performs only one operation at a time. You can write a batch file or script to execute mul-
tiple nsadmin operations on each computer.

For step-by-step instructions on using the nsadmin utility, see the following topics:

■ Creating the Data Distribution Directory

■ Starting the nsadmin command line utility

■ Adding custom words from a command line

■ Adding and removing custom vocabularies from a command line

■ Adding custom commands from a command line



You can use the Data Distribution Tool to run the nsadmin utility from a GUI. For more information, see
Starting the Data Distribution Tool.

Creating the Data Distribution Directory

You create a data distribution directory to store word lists, commands, or both, that you plan to distribute to
multiple users of Dragon NaturallySpeaking or Dragon Medical.

When word lists and commands are in the data distribution directory, as soon as a person opens their user pro-
files, Dragon automatically imports words and commands from the data distribution directory into the user pro-
files. This occurs regardless of the location of the computer the user dictates on.

You can use the Data Distribution Tool to put words and commands into a data distribution directory. For
more information, see Starting the Data Distribution Tool.

Note: The default installation of Dragon places custom words for existing Dragon user profiles in:
C: \Documents and Settings\All Users\Application Data\Nuance\Dragon Nat-
urallySpeaking11\custom.

Create a data distribution directory in a location other than the default location

Repeat the following steps for each workstation that should share the distributed words or commands.

1. In Dragon, close all open user profiles.

2. On the network, create a directory and give all users that dictate with Dragon access to the directory. Grant
read access to providers that dictate. Grant write access only to administrators.

3. If Dragon is running, on the DragonBar, select Tools > Administrative Settings. When the Admin-
istrative Settings dialog box opens, proceed to Step 6.

4. If Dragon is not running, select Start > Run. When the Run dialog box opens, in the Open text box, type the
following, making sure to put a space between natspeak.exe and the /SetDefaultAdministrativeOptions
option:

“c:\Program Files\Nuance\NaturallySpeaking11\Program\natspeak.exe” /Se-

tDefaultAdministrativeOptions

(The quotation marks are required because Program Files contains a space. Your path might not require
quotation marks.)

5. Click OK.

6. When the Administrative Settings dialog box opens, if the user profile opens automatically, click Cancel
to close the user profile or go to the DragonBar and select Profile > Close User Profile.

7. Click the Miscellaneous tab.

8. In the Data distribution location text box, click Change... and browse to a location where you want
Dragon to store custom words and commands.

9. Click OK.

10. Click Apply to save the changes.

11. Click OK to close the dialog box.

You can now use the Data Distribution Tool or the nsadmin command line utility to put new words and com-
mands into the data distribution directory. For more information, see Starting the Data Distribution Tool or Start-
ing the nsadmin command line utility.



Starting the nsadmin command line utility

You can use the nsadmin utility on a command line to make new words, vocabularies, or commands available
to users.

The nsadmin utility performs only one operation at a time. However, you can write a batch file or script to
execute multiple nsadmin operations on a computer. You can place the network location of new words or vocab-
ularies in a script and run the script from a client machine to copy the new functionality to the machine.

You can find the nsadmin.exe file in the \Program directory under the parent Dragon installation directory.
The default installation directory for Dragon is C:\Program Files\Nuance\NaturallySpeaking11\Program.

The nsadmin utility supports both mapped drives and UNC paths. For more information, see Using paths with
nsadmin.

Before you can use the nsadmin utility, you must create a data distribution directory. For more information,
see Creating Data Distribution Directory.

Start the nsadmin utility

1. Select Start > All Programs > Dragon NaturallySpeaking 11 > Dragon NaturallySpeaking Tools >
NSAdmin

nsadmin utility starts in a DOS window and lists the nsadmin syntax.

Display help information for the nsadmin utility

1. From a command prompt, type nsadmin/?

Command line syntax for the nsadmin utility

The nsadmin.exe utility uses the following syntax.

nsadmin <operation> <parameters> [options]

Commands and parameters Description

/commands <src_filename> Adds a command file to the local installation of Dragon.

/words <src_filename> Adds a list of new words to the local installation of Dragon.

/vocabulary <src_directory> "<lan-

guage or dialect> | <model name> |

<category>" <topic ID>

Adds a vocabulary from <src_directory> or an exported .top file to

the NaturallySpeaking <language> using the specified <model

name>, <category> and <topic ID>.

/vocabulary delete <topic ID> Deletes the base vocabulary specified by <topic ID>.

Options

/language enx | fra | deu | ita | esp | nld Specifies an installed language that you want to add words, com-

mands, or a vocabulary to. The default value is "enx."



/overwrite yes | no | ask Specifies overwrite rules if a file exists with the same name as the fie

you are adding. The default value is ask.

/? Displays the command syntax.

Adding custom words from a command line

You can use the nsadmin utility to make new words available to all user profiles on a particular installation of
Dragon.

You must first either create a text file or export words from an existing user profile's installation of Dragon
before you can distribute the words (for example, a list of new drug names) to a different installation of Dragon
.

After you use the nsadmin utility to import the custom words, for the changes to become available, you must
close your user profiles, re-open the user profiles, and save them.

Create a text file that contains custom words

Perform one of the following two actions before you distribute a set of custom words to a particular installation
of Dragon:

Create a text file that contains custom words

1. Create a text file.

2. In the text file, add each word of phrase that you want to add to the vocabulary. Make sure each word or
phrase uses correct spelling and is a on a separate line.

■ To add a multiple-word phrase, such "Mayberry Tribune," type it on one line.

■ To include a spoken form of a word, type the word followed by a backslash (\) and the spoken form of a
word. For example, to have Dragon enter "Robert F. Kennedy"when you say "RFK," type Robert F. Ken-
nedy\RFK in the text file.

Export words from a Dragon installation

If you have Dragon available on another machine, you can use it to create custom words and export the words
to a .txt file. For more information, see the main Dragon Help file.

Add custom words to a shared location

When you use nsadmin utility, you can enter paths as complete local paths, relative paths, mapped network
drives, a UNC path, or the path to removable media such as a CD-ROM or ZIP drive. For more information, see
Using paths with nsadmin.

Perform the following steps after you create a text file that contains custom words or after you export words
from an installation of Dragon:

1. If you have not already created it, create the data distribution directory. For more information, see Creating
the Data Distribution Directory.

2. On each computer that a user uses for dictation, map a network drive to the location of the data distribution
directory. As an alternative, you may reference the network UNC address of the location of the nsadmin util-
ity.



3. In a command prompt, type a command to add the custom words from the .txt file. The following command
copies the NewWords.txt file to the C:\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking11\Custom\enx\NewWords.txt directory:

<PATH>\nsadmin /words G:\NsAdmin\NewWords.txt

The next time you open a user profile, Dragon automatically updates the user profile's words to include the
words from the .txt file.

Use the command line to overwrite a custom word file

1. Use the /overwrite option to overwrite an existing custom word file. If the custom word file already exists
in the \Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking11\Custom\enx directory, Dragon overwrites it without prompting you.

The following command overwrites the NewWords.txt custom word file:

<PATH>\nsadmin /words G:\NsAdmin\NewWords.txt /overwrite=yes

Note:

If you add custom words to a Commands Only vocabulary, Dragon does not retain those words if you
upgrade the user profile at a later date. In general, you should not add custom words to a Commands Only
vocabulary.

Adding and removing custom vocabularies from a command line

You can use the nsadmin to make a customized vocabulary available to all users on a particular installation of
Dragon. For example, you can use the nsadmin utility to copy a user profile's vocabulary and set it as the base
vocabulary on any installation of Dragon. After you add a base vocabulary to an installation of Dragon, new user
profiles you create can use that vocabulary.

The nsadmin command uses the following syntax:

<PATH>\nsadmin /vocabulary <directory> "<language or dialect> | <model name> | <category>" <topic_
ID>

Parameters Description

<language or

dialect>

Links a vocabulary to a language. For example, US English or UK English for an Eng-
lish install

The language or dialect must exist in the version of Dragon on the computer.

<model_name> Specifies the size of the vocabulary you are importing.

<category> Describes the content of the vocabulary, for example, Astronomy or Marketing.

<topic_ID> Sets an ID for a topic.

The following nsadmin command copies the model name (Large), the category (Nuance), and the topic ID
(9005) to the models.ini file and copies the contents of the myvoc directory to
\Documents and Settings\All Users\Application Data\Nuance\Dragon Nat-
urallySpeaking11\Custom\enx\Custom9005\.



<PATH>\nsadmin /vocabulary G:\NsAdmin\myvoc "US English | Large | Nuance" 9005

Notes:

■ The default installation of Dragon installs vocabularies for existing Dragon user profiles in the following direc-
tory:
\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking11\users\<user_
name>\current

■ Vocabulary files have a *.voc file extension.

■ You can use Voctool to customize a vocabulary. For more information on Voctool, see Customizing Vocab-
ularies with the Dragon Vocabulary Tool (Voctool).

■ If you create a user profile on a dual core machine that uses a custom vocabulary, make sure that the user
profile uses the BestMatch IV speech model (BestMatch IV has the greatest recognition accuracy on dual-core
systems with more than 2 GB of RAM). To check this, select the Advance button on the Create User Profile
screen of the Creating a Profile wizard and make sure that BestMatch IV is selected.

Prepare to use the command line to add a vocabulary

1. If you have not already created it, create the data distribution directory. For more information, see Creating
the Data Distribution Directory.

2. On each computer that a user uses for dictation, in a command prompt, start the nsadmin utility and use it to
add the vocabulary to the data distribution directory. Make sure to reference the network UNC address of the
computer in the command. Use the following syntax for the command:

<PATH>\nsadmin /vocabulary <directory> "<language or dialect> | <model name> | <category>" <topic_ID>

The next time you open a user profile, Dragon automatically updates the user profile's vocabularies. For more
information on using the nsadmin utility, see Starting the nsadmin command line utility.

Use the command line to overwrite a vocabulary

1. Use the /overwrite option to overwrite an existing vocabulary file. If the vocabulary file already exists in
\Documents and Settings\All Users\Application Data\Nuance\Dragon Nat-
urallySpeaking11\Custom\enx\Custom9005\, Dragon overwrites it without prompting you.

The following command overwrites the myvoc topic:

<PATH>\nsadmin /vocabulary G:\NsAdmin\myvoc "US English | Large | Nuance" 9005 /overwrite=yes

Use the command line to add an exported vocabulary

You can use the nsadmin utility to distribute a vocabulary that you create using a separate installation of
Dragon. A Dragon vocabulary that you export saves as a group of files.

One of the exported files has a .top file extension, the other files have .to* file extensions, where * is an
integer.

1. In a command prompt, provide the path to the file with the .top file extension as an argument to the nsad-
min utility. Do NOT include the .top file extension on the command line.



The following command adds the myvoc exported topic (myvoc.top) as a new base vocabulary:

<PATH>\nsadmin /vocabulary D:\MyDocuments\myvoc "US English | Large | Nuance" 9005

Use the command line to remove a base vocabulary

1. On each client computer, in a command prompt, enter a command to delete the vocabulary and the cor-
responding entry inmodels.ini. You cannot use vocabularies that are based on a base vocabulary you delete.
Use the following syntax:

<PATH>\nsadmin /vocabulary delete <topic_ID>

The following nsadmin utility command deletes a vocabulary with a topic id of 9005:

<PATH>\nsadmin /vocabulary delete 9005

Adding custom commands from a command line

Custom commands are voice commands that you can create and modify to enter text, insert graphics, or acti-
vate menus and keystrokes in any application. You can use the MyCommands Editor to create custom com-
mands or the Command Browser to modify custom commands. 

You can use the nsadmin utility to copy a set of custom commands to the data distribution directory and make
the set of custom commands available to all users of a particular installation of Dragon

Before you use the nsadmin utility, you must have already created a data distribution directory, as explained
in Creating the Data Distribution Directory.

Notes:

■ The default installation of Dragon places custom commands for existing Dragon user profiles here:
\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking11\Custom\<language>

■ After you import the custom commands to Dragon, for the changes to become available to those user profiles,
you must close your user profiles, then re-open the user profiles, and save the user profiles.

■ You can enter a path as a complete local path, a relative path, a mapped network drive, a UNC path, or the
path to removable media, such as a DVD, CD, or ZIP drive. For more information, see Using paths with nsad-
min.

Use the command line to add custom commands

1. In Dragon, create custom commands.

2. Use the Command Browser to export the custom commands to a .dat file, for example, New-
Commands.dat.

3. If you have not already created it, create the data distribution directory. For more information, see Creating
the Data Distribution Directory.

4. On each computer that a user uses for dictation, in a command prompt, type a command line using the fol-
lowing syntax, to add the custom commands from the .dat file. In the command, reference the network
address of the data distribution directory in the command:



<PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat

The next time you open a user profile, Dragon updates the commands in the user profiles for the user.

Use the command line to add custom commands to a language other than English

Use the /language option to associate commands with a non-English language.

The following command associates the NewCommands.dat file with the language of French.

<PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat /language=fra

Use the command line to overwrite a custom command file

Use the /overwrite option to overwrite an existing command file.

The following command overwrites the NewCommands.dat file if it already exists in the G:\NsAdmin direc-
tory. Dragon overwrites the file without prompting you.

<PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat /overwrite=yes

Using paths with the nsadmin utility

When you use the nsadmin utility, you can use a path that is a complete local path, a relative path, a mapped
network drive, a UNC path, or the path to removable media, such as a DVD, CD, or ZIP drive. If a path name
includes spaces, you must enclose the path name in quotation marks.

When you are running the nsadmin utilityfrom a directory other than the one nsadmin resides in, you must
provide the full path to the nsadmin.exe program on the command line.

The following command copies the NewCommands.dat file to the <drive>:\Documents and Settings\All
Users\Application Data\Nuance\NaturallySpeaking11\Custom\enx\NewCommands.dat directory.

 <PATH>\nsadmin /commands \\HostComputer\NsAdmin\NewCommands.dat



Maintaining Installations

There are several actions you can take to maintain your Dragon installations:

■ Run the Acoustic and Language Model Optimizer and schedule the Optimizer to run automatically (see
Using Acoustic and Language Model Optimizer and Scheduler Tools ).

■ Export user profiles from one machine and import them to another as outlined in Exporting and Importing
User Profiles.

■ Work with the Dragon.log file to determine the cause of error messages (see Handling Dragon Error Mes-
sages).

■ Work with a Usability log file—create a usability log (DgnUsability.log) by pressing the Advanced button
on the Data tab of the Options dialog box. For more information, see Working with the Usability Log.

■ Work with the Dragon knowledge base as outlined under Accessing Dragon Knowledge Database.

■ Work with the hardware compatibility list (see Hardware Compatibility List)

■ Manage who has administrative privileges (see Managing Who Has Administrative Privileges).

Using Acoustic and Language Model Optimizer and Scheduler Tools

You run Acoustic and Language Model Optimizer Scheduler to:

■ Choose to optimize the acoustic files for the user profile

■ Choose to optimize the language model for the user profile

■ Schedule one or both types of optimization to occur on a particular day or time at particular intervals

■ Enable or disable the scheduled optimizations

■ Separate procedures exist for running the optimization on a Non-Roaming User Profile (see Running Acoustic
and Language Model Optimizer on Non-Roaming User Profiles) or a Roaming User Profile (see Running Acous-
tic and Language Model Optimizer on Roaming User ProfilesRunning Acoustic and Language Model Optimizer
on Roaming User Profiles).

Running Acoustic and Language Model Optimizer on Non-Roaming User Profiles

An open local user cannot run the optimizer tools on user profiles. Only an administrator can run the Acoustic
and Language Model Optimizer or the associated Scheduler tools. You must have Windows Administrator
privileges (at the operating system level) on the machine where you are running the Scheduler. If you want to
optimize a Roaming User Profile on the machine where you are running the Acoustic and Language Model Opti-
mizer, disable roaming and browse to the Master Roaming User Profile location as if it were local.

As system administrator, you are responsible for running the Acoustic and Language Model Optimizer on
the network location of the Master Roaming User Profiles. You can install Dragon on the machine where the
Master Roaming User Profiles are located or on any machine that has network access to the Master Roaming
User Profiles, then run the Scheduler. Later, any optimizations that result from running these tools are copied
to the Local Roaming User Profile when Dragon synchronizes it with the Master Roaming User Profile. You can
run the Acoustic and Language Model Optimizer from the Windows Start menu (Select Start > All Pro-
grams > Dragon NaturallySpeaking 11 > Dragon NaturallySpeaking Tools > Acoustic and Language



Tools DragonBar using the Tools menu when a user profile is open as indicated here.

Running the Acoustic and Language Model Optimizer on a multi-core machine

If a non-Roaming User Profile with a BestMatch IV speech model is created and used on a multi-core machine, if
an administrator runs the Acoustic and Language Model Optimizer on that profile on a single-core machine, all
accuracy improvements may not be applied to the profile. The Acoustic model will revert to a single model.
When a user opens the profile on a multi-core machine, only the first acoustic model will load.

To increase the accuracy of the user profile, select Audio > Launch Accuracy Tuning from the DragonBar.

To make sure that corrections and accuracy improvements that users make are applied to their non-Roaming
User Profile, a user should run the Acoustic and Language Model Optimizer on non-Roaming User Profiles only
on a multi-core machine.

To run the acoustic and language model optimizers on non-Roaming User Profiles:

1. On the DragonBar, select Profile > Open User Profile.

2. In the Open User Profile dialog box, select a user profile to run the optimization on and click Open.

3. On the DragonBar, select Help > Improve my accuracy. The Accuracy Center opens.

4. Click Launch Accuracy Tuning now. The Acoustic and Language Model Optimizer dialog box opens.

5. If the user has not dictated and corrected recognized text since the last time the optimizer was run, you
receive this message: There is no new data in the acoustic archive. Acoustic Optimizer does not
need to be rerun. Click OK and the Acoustic and Language Model Optimizer opens with the
Perform Acoustic Optimization option grayed out.

6. Check the types of optimization you want to perform, Perform Acoustic Optimization (to optimize the
acoustic files of the user profile), Perform Language Model Optimization (to optimize the language
model of the user profile), or both.

7. Click Go to start the process. The process may take some time to complete. When the process completes,
you receive a message notifying you that it has completed.

8. Click Done.

9. When asked if you would like to save your user profiles click Yes to return to the Accuracy Center. Click
Exit in the Accuracy Center dialog box.

Running Acoustic and Language Model Optimizer on Roaming User Profiles

To run the Acoustic and Language Model Optimizer on Roaming User Profiles:

1. Be sure that a copy of Dragon is installed on the computer where you plan to run the Acoustic and Lan-
guage Model Optimizer.

2. Select Start > All Programs > Dragon NaturallySpeaking 11 > Dragon NaturallySpeaking Tools >
Acoustic and Language Model Optimizer Scheduler. The Acoustic and Language Model Optimizer
Scheduler dialog box opens.

3. To access the master directory of the Roaming User Profiles you want to optimize, in the Acoustic and Lan-
guage Model Optimizer Scheduler dialog box, select File > Set User Directory. The Set a Directory
Containing User Files dialog box opens.



4. On the Set a Directory Containing User Files dialog box, either enter the path to the directory or click the
Browse button and browse to the location of the Master Roaming User Profiles, then click OK. If the user
profiles you want to optimize are located in multiple directories, you can later repeat the steps outlined here
and change this directory to locate the additional user profiles.

5. In the tree of user profiles, select the user profile you want to optimize. Notice that if you expand that user
profile in the tree, you see one or more dictation sources under the Acoustic Optimization tasks in the tree.
You also see the vocabulary of the user profile under the Language Model Optimization tasks.

OR

Select File > New Task. The Windows user name and password dialog box opens. To set a schedule for run-
ning the Acoustic and Language Model Optimizer, either double-click on the dictation source or the lan-
guage model under that user profile.

6. Before you proceed, enter your Windows user name and password. If you are logged in to a domain, you
must insert the domain name in front of your user name; for example, HospitalDB\RSessions for the Hos-
pitalDB domain.

7. Click OK. The Select Frequency dialog box opens.

8. Under Optimization, select Perform Acoustic Optimization, Perform Language Model Optimization,
or both.

9. Under User Information, you can either select another user profile from the User Name drop-down list or,
to select multiple user profiles, click the Multiple Users button to open the Select User Profiles dialog
box.

a. In the Select User Profiles dialog box, use the Add> and <Remove buttons to put the user profiles
you want to run optimization on in the Selected users in this task list to the right. Or you can click Add
All>> or <<Remove All to add or remove all user profiles from the list.

b. You can also move a user profile up and down in the list by selecting a name and clicking the Move Up
or Move Down button. When you are satisfied with the list, click OK to proceed.

10. If you selected multiple user profiles in the previous step, skip this step. Otherwise, in the Dictation Source
text box, select an audio input device from the drop-down list and in the Vocabulary text box, select a vocab-
ulary from the drop-down list.

11. Under Select Frequency and Start Date & Time, select how often and at what time you want the opti-
mization to run, as well as the first date it should run.

12. At the bottom of the dialog, click the Enabled (schedule task runs at specified time) check box to enable the
optimization.

13. Click Apply to apply the changes.

14. Click OK to close the Select Frequency dialog box. The Acoustic and Language Model Optimizer
Scheduler dialog box displays a list of the events scheduled in the right pane of its dialog box. You can create
more than one optimization schedule for a single user profile. When you do, both optimization events appear
in the schedule list.

15. Click Files > Exit to close the acoustic and language model optimizer scheduler

Removing One or More Optimization Schedules

To remove one or more scheduled optimizations from the scheduler:



1. Select the schedule you want to remove. You can select multiple schedules by holding the CTRL key while
clicking a schedule.

2. Press the Delete key on your keyboard or select Options > Delete Selected Tasks on the toolbar.

3. Click OK when you are asked to confirm the deletion.

OR

1. To remove all scheduled optimization events in the Acoustic and Language Model Optimizer Scheduler
select Options > Delete Displayed Tasks.

2. Click OK when you are asked to confirm the deletion.

Alternatively, you can optimize multiple user profiles on the same schedule by selecting all the user profiles you
want to share one schedule in the Select User Profiles dialog box.

Exporting and Importing user profiles

You can export user profiles on one machine and import them for use on another.

When you export a user profile to a new location, any custom words added to a Local Roaming User Profile do
not accompany the user profiles unless you first run the Learn from specific documents wizard in the Accu-
racy Center .

Exporting User Profiles

To export user profiles from Dragon:

1. On the DragonBar, select Profile > Manage User Profiles.

2. The Manage User Profiles dialog box opens.

3. Select the user profile in the list that you want to export.

4. Click the Advanced button and select Export from the menu that appears.

5. When the Browse For Folder dialog box opens, navigate to the folder where you want to store the exported
user profile (or create a new folder by clicking the Make New Folder button) and click OK.

6. When a dialog box opens displaying a message indicating the export was successful, click OK.

7. Repeat steps 3 through 6 for each set of user profiles you want to export.

8. Click Close to close the Manage User Profiles dialog box.

9. In the operating system, navigate to the directory where you exported the user profiles. In that directory you
find a separate folder for each exported user profile, labeled with the user name.

Importing User Profiles

To import user profiles into Dragon that you previously exported on a different machine:

1. On the DragonBar, select Profile > Manage User Profiles. The Manage User Profiles dialog box
opens.

2. Click the Advanced button and select Import from the menu.

3. When the Browse For Folder dialog box opens, navigate to the folder to retrieve a set of exported user pro-
files from.

4. Select the folder in that directory that has the name of the user profile to import and click OK.



5. If the user profile already exists a User already exists dialog box opens and asks you to choose how to
proceed: Overwrite the existing user or Import the user with an alternate name. If you choose to
import the user profile and assign it another name, enter the name in the text box provided and click OK.

6. Repeat steps 2 through 5 for each user whose user profiles you want to import.

7. Click Close to close the Manage User Profiles dialog box.

Handling Dragon Error Messages

When Dragon displays an error message:

1. Read the message carefully. It may give you enough information to determine what to do.

2. If you dictated text into your document, click Close to close the error message box and then save your doc-
ument.

3. Do not save your user profiles.

4. Copy the error message log file (Dragon.log) to a safe place. To locate this file, click Start > Programs >
Dragon NaturallySpeaking 11 > Show Dragon Log. This file is normally located in the C:\Documents
and Settings\<username>\Application Data\Nuance\NaturallySpeaking11 folder. Technical Support
may ask you to send this file for further study.

5. Exit Dragon and start it again. In some cases it may be necessary to restart your computer.

6. Insert your Dragon DVD into your DVD reader, run the installation program again, and choose the Repair
option on the first screen of the Dragon setup program. After setup finishes, reinstall any Dragon patches that
were previously installed.

7. If the error message does not provide enough information to determine what to do, search our Web site for
information on the error message. You may find a solution that can save you time and trouble:
http://www.nuance.com/product-support/default.asp?lang=us&prod=dn

For more help

If you are unable to resolve your problem or if it occurs again, contact technical support.

Working with the Usability Log

You can set up Dragon to create a usability log that logs all menu commands, toolbar buttons, and voice com-
mands that you use during a dictation session.

To set up a usability log:

1. With a user profile open, on the DragonBar, select Tools > Options.

2. Click the Data tab.

3. Click the Advanced button.

4. When the Advanced dialog box opens, check the Create usability log check box and click OK to return to
the Data tab.

5. Click Applyand then click OK to close the Data tab of the Options dialog box.

Later, you can find the log under C:\Documents and Settings\ <username>\Application Data\N-
uance\NaturallySpeaking11.

techsupp.chm::/contact_techsupport.htm
techsupp.chm::/contact_techsupport.htm


Accessing the Dragon Knowledge Database

Solutions to known problems with Dragon are provided at the Nuance Knowledge Base, located at http://kn-
owledgebase.Nuance.com/.

If you have problems using Dragon with Microsoft Word on Windows XP (for example if the program freezes or
commands stop working in a Microsoft Office XP application), it may be that the Microsoft Word XP’s built-in
speech recognition is interfering with Dragon.

To locate and use the Dragon Knowledge Database:

Navigate to http://knowledgebase.Nuance.com/.

1. In the product drop-down list, select Dragon NaturallySpeaking and click Continue.

2. In the Dragon NaturallySpeaking TechNotes-Basic search section you can search using:

■ Product version — Select the version you are using.

■ Search Criteria — Type the words that would be expected to be found in the pages that con-
tain the answer. Do not use words such as how, why, the, in, or on.

■ Using:

o Any of the words — Show pages that contain any of the words

o All of the words — Show pages that contain all of the words.

o Exact phrase entered — Show pages that contain all of the words in
the exact order typed.

1. Click Search, to begin the search.

Hardware Compatibility List

You can find a list of headsets and microphones compatible with Dragon at the Nuance Communications web
site.

To find the hardware compatibility list:

1. Navigate to http://support.nuance.com/compatibility/default.asp

2. At the site, under Select a Product click on the product drop-down list and select Dragon NaturallySpeaking.

3. Click Continue to proceed.

4. Under Select a Device Category click on the device category drop-down list and select the type of micro-
phone or recorder. For instance, you can selectWireless Microphones to see the various types of bluetooth
microphones that are compatible. A list of compatible hardware displays, along with a model, manufacturer,
and accuracy scale Dragon Score.

5. Click on the device name to open an Evaluation Report on the device that provides more detail. Each device is
either Nuance Certified (meets highest standard), Nuance Authorized (provides satisfactory per-
formance), or Reseller Endorsed (not necessarily tested by Nuance, but reported by resellers/VARs to pro-
vide satisfactory performance).

http://knowledgebase.nuance.com/
http://knowledgebase.nuance.com/
http://knowledgebase.nuance.com/
http://knowledgebase.nuance.com/
http://support.nuance.com/compatibility/default.asp


Managing user administrative privileges

Before You Give Windows Administrator Privileges

Before you decide to give a Dragon user Windows Administrator privileges on a laptop computer, note that you
are giving that person access to the Administrative Settings dialog box on that machine.

Determining Logged In User Has Admin Privileges

If the logged in user has Windows Administrator privileges, the following line appears in the Dragon.log file
after he or she logs in:

09:33:10 LOG (MainWin): Windows user has administrative access to NatSpeak



Managing and Securing Custom Commands

You can make your custom commands more secure in two ways:

To make the tool available only in Dragon, convert any XML files of commands to DAT format. For details see
Using the Convert XML to DAT tool.

To prevent any Dragon users from editing the commands, you can lock access to the file. For details see Using
the MyCommands Protection Utility.

Using the Convert XML to DAT tool

You can use a text editor to open commands that are in XML format. To allow only Dragon users to access those
command files, you can convert them from XML format to DAT format. Dragon uses .dat files to store com-
mands.

You can use the XML to DAT tool (mycmdsxml2dat.exe) to extract user-defined Dragon commands from an
XML file. The tool writes the commands to a .dat file. Use the nsadmin utility or the Data Distribution Tool
to make the new.dat files available to those other users.

Note: If you are using the SDK Client Edition of Dragon, you can use the DgnEng-
ingControl::ImportMyCommands method to programmatically import Dragon commands from an XML or
DAT file into a Dragon user profile.

Starting the Convert XML to DAT tool

■ In Dragon:

Start > All Programs > Dragon NaturallySpeaking 11 > Dragon NaturallySpeaking Tools >Convert
XML to DAT

■ In Dragon SDK Client Edition:

Start > All Programs > Dragon SDK Client Edition 9 > Dragon SDK Client Tools > Convert XML to
DAT

The Convert XML to DAT tool starts in an MS-DOS window, listing the tool's syntax.

Displaying syntax information for the Convert XML to DAT tool

1. From a command line, navigate to the \Program directory in the installation directory of the Dragon
SDK Client. For example, C:\Program Files\Nuance\NaturallySpeaking11\Program>.

2. From a command line, enter mycmdsxml2dat

Convert XML to DAT syntax

Convert XML to DAT (mycmdsxml2dat.exe) uses the following syntax:

mycmdsxml2dat.exe <dat-file-path> <xml-file-path> [options]



Required

parameters : Description

<dat-file-path> The full path to the local copy of the current user's .DAT file

<xml-file-path> The full path to the .XML file

Optional

parameters :

-v Validates the specified .xml file over the Internet with a Nuance DTD (Document
Type Definition) file. Disabled by default

Use the XML to DAT tool to convert data in an XML file

1. Create an XML file that contains the commands to use with Dragon.

2. On a command line, use mycmdsXML2DAT.exe to convert the XML file to DAT format.

3. Use the nsadmin utility or the Data Distribution Tool to copy the .dat file to the data distribution direc-
tory.

The next time you open a user profile, Dragon incorporates the new commands from the .dat file into the user
profile.

For more information, see:

● Adding custom commands (nsadmin)

■ Adding and removing custom commands (Data Distribution Tool)

Using the MyCommands Protection Utility

In Dragon Medical and Dragon Legal, when you export a set of custom Text-and-Graphics, Step-by-Step,
Custom Command, and/or Advanced Scripting commands into a .dat file, you can set the permissions on
that file so that after a user imports them, that user can dictate the commands but cannot view their source
code, edit their source code, or re-export the commands. As a result, the integrity of the commands remains
intact.

To set the permissions on the .dat file of commands to protect the commands in this way:

1. Make a backup copy of the unprotected .dat file and store it in a secure location. You later use that file to edit
the commands, because once you protect the .dat file that you are distributing, you cannot make the file avail-
able for editing again.

2. Select Start > Run and enter cmd into the Run dialog box.

3. Change directories to <drive letter>:\Documents and Settings\<user name>\Application Data\N-
uance\NaturallySpeaking11\Custom\<language>

4. Enter the following on the command line:

protectcmds.exe <dat-file-path> <vendor-name> [<vendor-contact-info>]

5. Once you press return, after a user imports these commands, if that user attempts to edit any of them, the fol-
lowing message indicates that the commands cannot be edited:



The command was protected by <vendor-name>.
Please contact <vendor-contact-info> for more information.

In the Command Browser, the same message appears as the Preview Content in Script mode.

Once you have protected the file, you can put it into the Data Distribution directory for distribution to multiple
user profiles. For more on distributing saved commands, refer to Creating Data Distribution Directory, then
refer to a topic about distributing commands to multiple user profiles by either:

■ Using the Data Distribution Tool (Data Distribution Tool: Adding and removing custom commands)

OR

■ Using the nsadmin command line tool (nsadmin: Adding custom commands)



Using Structured Commands

Dragon NaturallySpeaking Professional, Dragon Medical, and Dragon Legal include an extension to Text-and-
Graphics commands that let you to set the values of variables in text blocks based on voice input.

You can create simple Text-and-Graphics commands with variables in the My Commands Editor without hav-
ing to do extensive programming in Microsoft® VBA.

Application states

Structured commands let you control the action of a command based on the state of the application. For exam-
ple, if you assign a state to each field in a form, the same command can perform different actions depending on
which field is activated.

You can use Advanced Scripting methods to control the states within structured commands or to set the initial
state from a non-structured command. You can also create structured commands that prompt the user to select
values from a predefined list.

When the user speaks a command, the user is presented with a list of pre-defined values for the command.
Once the user selects a value, the value is inserted into the correct location in the custom command.

Samples

Dragon includes several sample Text-and-Graphics commands with variables and sample structured com-
mands. You can import the samples into Dragon to use them as templates for your own commands. The sample
commands are fully commented.

For more information, see:

■ Structured Commands Samples

■ Importing Sample Commands

Methods

For more information on the methods used by the sample commands, refer to the following topics in the Main
Help file:

■ Global Methods

SetState

GetState

■ EngineControl Methods

MyCommandsActiveState

PromptValue

Structured Command Samples

Dragon includes several sample Text-and-Graphics commands with variables and sample structured
Advanced Scripting commands. You can import the samples into Dragon to use them as templates for your
own commands. The sample commands are fully commented.



Sample location

The sample commands are installed in:

\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking11\Data\Enx\samplecommands

A shortcut to this directory is available on the Windows Start menu. To open this directory, click Start > Pro-
grams > Dragon NaturallySpeaking 11 >MyCommands Samples.

Importing Sample Commands

You can import the samples into Dragon to use them as templates for your own commands. For information,
see Importing Sample Commands

Samples

The following samples are included with Dragon:

GroceryListSample_DragonPad

GroceryListSample_DragonPad.xml contains Advanced Scripting commands that simulate an on-line
grocery order form in DragonPad. It demonstrates how to set and change command states, activating and
deactivating various state structured commands, and how to use the command prompt. The "Prepare
Grocery List" voice command displays the first section of a grocery list in DragonPad and sets a com-
mand state. Each section of the grocery list is designed to have a separate state. The "What's Available"
voice command prompts the user with a set of grocery list commands that are active in the given section.

GroceryListSample_WordPad

GroceryListSample_WordPad.xml contains Advanced Scripting commands similar to those of Groce-
ryListSample_DragonPad.xml. It demonstrates how to set and change command states and to use the
command prompt in WordPad and uses a different coding style. The "Prepare Grocery List" voice com-
mand starts the grocery list in WordPad, activate the initial grocery list state, and prompt the user with a set
of grocery list commands that are active in the given state. To read more about this sample and its com-
mands, refer to the code comments in the XML file.

SampleBoilerPlate_ColonCancer

SampleBoilerPlate_ColonCancer.xml contains Advanced Scripting commands that demonstrate how
to use structured commands and the command prompt for boilerplate text. This sample is modeled after a
colon cancer checklist and is designed to work in Microsoft Word 2003. The "Colon Cancer Checklist"
voice command displays the boilerplate text and takes the user, field by field, through the checklist.

SampleBoilerPlate_EndoBiopsy

SampleBoilerPlate_EndoBiopsy.xml contains a single Advanced Scripting custom command that dem-
onstrates how to set up boilerplate text and use the command prompt to guide users in filling the boilerplate
text without using states. This sample is modeled after an endoscopic biopsy report and is designed to work
in Microsoft Word 2003. The "Prepare Endoscopic Biopsy Gross Template" voice command displays
the boilerplate text and takes the user, field by field, through the report.

SampleTGV_Restaurant

SampleTGV_Restaurant.xml contains Text-and-Graphics and Advanced Scripting commands that
are used in DragonPad to simulate an ordering system for a Chinese and Japanese restaurant. This sample
demonstrates how to set states for structured commands as well as how the same commands can be used to



produce different results in different states. Either the "Chinese Restaurant" or "Japanese Restaurant"
voice command starts the ordering system and activates the structured commands created for the given
state. The "Exit Ordering System" voice command ends the ordering session.

SetStateSample

SetStateSample.xml contains simple Text-and-Graphics commands that demonstrate how to use var-
iables and text formats and Advanced Scripting commands to set and unset a command state. This sam-
ple is designed to work in DragonPad with the initial command "Sample Set State." When the command
executes, a command state is set for DragonPad and a simple exchange of greetings is simulated between
the user and the system. The user speaks the greeting, such as. "Good Morning," and the system
responds in bold red text. When the user says "Good-bye," the exchange is terminated and the command
state is unset.

SampleInjuryReport

SampleInjuryReport.xml together with SampleInjuryReport.dot demonstrates how structured com-
mands and Microsoft Word templates can be used together to create a voice-enabled form filling envi-
ronment. The template is a mock injury report with several text and checkbox fields can be filled using the
commands included in the XML file. You start a form filling session by speaking the "Edit Report" voice
command in a new document based on the sample template. Both the template and the commands are
designed to work in Microsoft Word 2003.

Importing Sample Structured Commands

You can import existing structured commands, such as the Structured Commands Samples, into Dragon to use
as templates for your own commands. Use the following procedure to import the sample structured commands
that are supplied with Dragon:

To import the sample structured commands:

1. On the DragonBar , select Tools > Command Browser to open the Command Browser window.

2. Click the Manage button on the Command Browser toolbar.

3. In the Manage area, click the Import button, and in the Import Commands window choose MyCom-
mands XML files from the Files of type list.

4. Use the Import Commands window to browse to the Documents and Settings\All Users\Application
Data\Nuance\NaturallySpeaking11\Data\Enx\samplecommands directory.

5. Select one of the sample .XML files (for example, sampletgv_restaurant.xml) and click Open.

6. Click OK on the Import Commands validation dialog box and then click Import on the Import Commands
window to import the commands contained in the file.

Note: The syntax of XML command files is defined by a document type definition (DTD) file that resides on
the Nuance web site. When you import an XML command file, the application gives you the option of val-
idating the syntax of the XML file against the DTD. The validation step is useful if you receive a XML com-
mand file from another person and want to check it for syntax errors prior to importing it.

7. Click OK on the success message and return to the Manage area of the Command Browser.

To examine the sample code

1. Open the Command Browser and click the Manage button.

2. Expand and select the appropriate item (for example, “<restaurant_type> Menu”)

3. Click the To Script button and then click the Edit button.



The MyCommands Editor dialog box opens with the command you selected entered into it. You can examine
and modify the command with the MyCommands Editor.



Summaries of Administrative Settings Dialog Boxes

The tabs in the Administrative Settings dialog box are:

■ Roaming

■ Miscellaneous

■ Scheduled Tasks

For more on each tab, see the corresponding topic below:

■ Administrative Settings: Roaming tab

■ Administrative Settings: Miscellaneous tab

■ Administrative Settings: Scheduled Tasks tab

Administrative Settings: Roaming tab

You use the Roaming tab of the Administrative Settings dialog box to set up the Roaming feature. You must
set up the Roaming feature on each computer where you want users to dictate with a Roaming User Profile.

When Roaming is enabled in Administrative Settings, by default the Open User Profiles dialog box displays large
numbers of User Profiles quickly. They can also be organized into subfolders. See "Creating subfolders for
Roaming User Profiles" in the Dragon Help for more information.

Enable

SelectEnable to activate the Roaming feature and the Roaming User Profile options.

Network Directories

To set the location of the master Roaming User Profile(s):

1. Click the Add button. You use the Roaming User Network Location dialog box to define the network loca-
tion of the master Roaming User Profiles. The location you pick must be accessible to all computers on the net-
work that you want available for dictation with Dragon.

2. Set the Display Name and the Address under Network Location. The Roaming feature supports the fol-
lowing types of locations:

■ Mapped Drive—the format is: <drive letter>:\<folder name>. For example, y:\roaming.

■ UNC Path—the format is: \\servername\sharename\path\filename.

■ HTTP (http:)—the format is: http://myserver.com/webDAV. For HTTP locations, click the HTTP Set-
tings button to set information specific to your HTTP connection. You can also test your connection to the
HTTP server from HTTP Settings dialog box.

■ HTTP with SSL (https:)—the format is: https://myserver.com/WebDAV. For HTTP with SSL locations,
click the SSL Settings button to set information specific to your HTTP with SSL connection. You can also
test your connection to the HTTP with SSL server from SSL Settings dialog box.



Local directory (for cache)

When a user opens a Master Roaming User Profile, Dragon transfers a copy of that user profile to the local
machine. The local copy is called the Local Roaming User Profile.

You can change the setting of this location, always called <Roaming Local>.

The default location of <Roaming Local> on Windows XP is:
Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking11\RoamingUsers\<display name>\<username>

See Dragon version 11 file structure for information on the default location of the RoamingUsers directory for
Dragon 11 on Windows Vista and Windows 7.

The <display name> is a name you assigned as a Master Roaming User Profiles location. You can have multiple
network storage locations for your Master Roaming User Profiles.

The <username> is the name of an individual Master Roaming User Profile. There is a separate directory for
each user profile.

Click the Browse button to find or create a new location.

Check Boxes for Roaming User options

The check boxes and other components below the Local directory are the Roaming User options. You can
also configure the Open User Profiles dialog box to display the Classic Open User Profiles dialog if desired. See
Selecting Roaming User Profile options. for details.

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first installed Dragon. Note that
the default is to have the Roaming feature turned off.

Notes: For use of WebDAV

■ After you install Internet Information Services and WebDAV, you need to use the Internet Information Serv-
ices Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom Properties”, and “Allow Property
Queries with Infinite Depth” settings to true. For example, in IIS 7:



■ For more information, see Configuring Internet Information Services and WebDAV for HTTP Roaming.

■ If you connected to your Roaming User Profile Master Directory over HTTP and you find that not all your User
Profiles are listed in the Open User Profile dialog box, or after creating a Roaming User Profile you cannot
open it again, or the Open User Profile dialog box does not display all the vocabularies and acoustic models
for your user profiles, make sure that you:

■ Add all file extensions within your Master Roaming User Profile directories and sub-directories to the Reg-
istered MIME types list of your IIS server. You could also add a wildcard ( .*) MIME-type. For more infor-
mation on adding a wildcard ( .*) MIME-type, see
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-

b497-4b8c-b552-83a2c180cd32.mspx?mfr=true.

■ Check that no files in your user profile directory are locked, password protected, or otherwise access-
restricted by your server permissions.

Administrative Settings: Roaming User Network Location

You use the Roaming User Network Location dialog box to define the network location of the master Roam-
ing User Profiles.

The location you pick must be accessible to all computers where users will dictate using a Roaming User Profile.



Display Name

Sets the directory name displayed in the following locations:

■ The Roaming tab of the Administrative Settings dialog box

■ The Location of user profile drop-down list in the Open User Profile dialog box.

Note:With the Roaming feature enabled, the Open User Profile dialog box displays only user profiles in the
Roaming User Profile locations. To let the users open both local (non-roaming) and Roaming User Profiles,
select the Allow non-roaming user profiles to be opened option on the Administrative Settings
dialog box. Clearing this option prevents users from dictating with a non-roaming (local) user profile by acci-
dent. For more information, see Enabling the Roaming feature on each machine where a user will dictate.

■ The Location of user profile drop-down list in the Manage User Profiles dialog box.

Network Location—Address

On each computer where you plan to have users dictating as a Roaming User Profiles, you must tell that instal-
lation of Dragon where the Master Roaming User Profiles are located.

The Roaming feature supports the following types of locations:

Mapped Drives and UNC Paths

Mapped drives connect to a shared network folder that has a drive letter assigned to it.

UNC paths connect to a shared network folder using the Universal Naming Convention (UNC) to locate a user
profile. The UNC is a way to identify a shared file on a computer or network without having to know the storage
device it is on. The UNC path format is:
\\servername\sharename\path\filename.

To use a mapped drive or UNC path:

1. Under Network Location, enter the address of the mapped drive or UNC path.

You can click Browse to browse for the location of the mapped drive or UNC path. This displays the Browse for
Folder dialog box. You can also create a new directory on the mapped drive or UNC path by clicking the Make
New Folder button.

2. Click OK when you are done.

Intranet/Internet connections

The Intranet/Internet connection supports both HTTP and HTTP over an encrypted Secure Sockets Layer (SSL).

To use an Intranet/Internet connection:

1. Under Network Location, enter the URL address of your HTTP or HTTPS server where your master Roaming
User Profiles are located.

2. Click

■ HTTP Settings...to display the HTTP Settings dialog box, where you can set information specific to
your HTTP connection like Authentication, Firewall, and Proxy Server information. You can also test your
connection to the HTTP server from this dialog box. For more information, see HTTP Settings.

■ SSL Settings...to display the SSL Settings dialog box, where you can set information specific to your
HTTPS (SSL) connection. You can also test your connection to the HTTPS server from this dialog box. For
more information, see HTTPS Settings.



Note: You cannot create a non-Roaming User Profile on an HTTP or HTTPS connection. You can create only
Roaming User Profiles on an HTTP or HTTPS connection and only when the Roaming feature is enabled.

Administrative Settings: Miscellaneous tab

The Miscellaneous tab of the Administrative settings dialog box contains the following options:

Check for product updates at startup

Automatically looks on the Nuance Web site for updates to Dragon every time you start the program. Any
change to this option does not take effect until you restart Dragon.

Backup location for User Profiles

Shows the location where Dragon will save backup user profiles.

■ Click the Change button to open a dialog box where you can specify a new location.

■ Click the Use Default button if you want Dragon to use each Windows user's My Documents folder.

You can change the Backup Location for User Profiles to any directory where Windows has both read and
write permissions, including portable devices such as Zip drives and CD/DVD burners. If you change the loca-
tion, backups for all user profiles will be located in the same directory.

Note: On Windows XP, Windows Vista, and Windows 7, you must have administrator privileges to change the
Backup Location for User Profiles and Data Distribution location. These fields are grayed out for
restricted users. Dragon will not let restricted users create backup files in directories reserved for the operating
system (for example, the \Windows directory). When specifying a backup location, make sure that directory
can be accessed by all users.

Data Distribution location

Shows the location where the local installation of Dragon stores customized words and commands.

■ Click the Change button to open a dialog box where you can specify the location for this directory.

■ Click the Use Default button to set the location to this default path:
C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking11\custom

You can change the Data Distribution location to any directory where Windows has both read and write per-
missions, including portable devices such as Zip drives and CD/DVD burners.

For a default installation, custom words and commands are located in:

■ Windows Vista and Windows 7:
C:\ProgramData\Nuance\NaturallySpeaking11\custom\<language>

■ Windows XP:
C:\Documents and Settings\All Users\Application Data\Nuance\Dragon11\Custom\<language>

Do not allow restricted users to add or modify commands

Select this check box to prevent restricted Windows users from adding or modifying Dragon commands. Select-
ing this option allows only users logged on with administrator privileges to add or modify commands. (Windows
XP Professional).

Disable use of Macro Recorder Commands

Select this box to prevent users from using macro recorder commands. Users can still run the commands.



Disable use of Step-by-Step Commands

Select this box to prevent User Profiles from using step-by-step commands. Users can still run the commands.

Disable use of Advanced Scripting Commands 

Select this box to prevent User Profiles from using advanced scripting commands. Users can still run the com-
mands.

Do not allow restricted users to modify Vocabularies

Select this box to prevent restricted Windows users from modifying Dragon Vocabularies. Selecting this option
allows only users logged on with administrator privileges to modify Vocabularies. (Windows XP Professional)

Record wave data between utterances

Select this option to capture all dictation, preserving all audio including any pauses, filler speech like "ums" and
"ahs," extraneous noises, and anything else the speaker may do like cough or laugh.

Correction Only Mode (no dictation available)

Select this option to enable Correction Only Mode.

Correction Only Mode allows transcriptionists to play back a speaker's dictation without having their User Profile
loaded. Note that dictation is disabled if you select this option.

Note: You must disable Correction Only mode before running the Acoustic and Language Model Optimizer.

Disable Windows Advanced Text Services

Select this option to disable the Microsoft Alternative User Input Text Input Processor (CTFMon) to eliminate
potential conflicts with Dragon.

Dragon installs an add-in to Microsoft Word that can conflict with add-ins installed by other applications. After
installing Dragon on a Windows XP system, errors may start appearing when using Microsoft Word if the Micro-
soft Alternate User Input application (CTFMON.EXE) is also installed and running. The Microsoft Alternate User
Input application supports advanced text services in Microsoft Office XP. These advanced text services include
Microsoft speech, handwriting, and East Asian keyboard input services. You can disable the Microsoft Alternate
User Input application during installation or later in the Administrative Settings dialog box.

Note: This option does not appear on systems running Windows Vista.

Disable automatic acoustic model selection in the Acoustic Optimizer

Running the Acoustic Optimizer updates your user profiles with accumulated acoustic data from any cor-
rections and additional training users may have done. Running Acoustic Optimization increases your overall
accuracy. In the process of increasing your accuracy, Acoustic Optimization may select a different acoustic
model for your user profile. For example, if you chose a General accent during User Profile setup, Dragon may
change it if your speech more closely matches another accent. For more information, see "About speech and
acoustic models" in the Dragon Help.

Select this option to disable the Acoustic Optimizer from selecting a different acoustic model when run.

If you are using Dragon 11, see Using multiple acoustic models with a user profile for information on acoustic
model selection and user profile's that use two acoustic models.

Restore Defaults



Returns the Administrative Settings dialog box to the state it had when you first installed Dragon. Note that
the default is to have the Roaming feature turned off.

Notes

■ When the User Profile is closed, you cannot use Dragon to dictate or to perform actions by voice.

■ On Windows XP you must have administrator privileges to change the Backup Location. Dragon will not let
restricted users create backup files in directories reserved for the operating system (for example, the \Wi-
ndows directory). When specifying a backup location, make sure that directory can be accessed by all users

■ In some versions of Windows, such as Windows XP Pro, you must be logged on as the administrator before
you can access this dialog box.

■ In some situations, a user who does not have administrator privileges may have access to options on this
dialog that they would not normally have.

■ Dragon allows you to use the Universal Naming Convention (UNC) to locate a user profile. The UNC is a way
to identify a shared file on a computer or network without having to know the storage device it is on. The for-
mat is: \\servername\sharename\path\filename.

Administrative Settings: Scheduled Tasks tab

The Scheduled Tasks tab of the Administrative settings dialog box allows you to schedule Accuracy Tuning
and Data Collection for all User Profiles created with this installation of Dragon NaturallySpeaking.

Accuracy Tuning

Schedule Accuracy Tuning to help Dragon to learn from you and make your dictation more accurate. Accuracy
Tuning runs the Acoustic and Language Model Optimizer to update your User Profile with

■ frequently dictated word sequences

■ acoustic data from any corrections you make, including with the keyboard

■ trained words

■ commands used

■ any additional training you perform

Enabled scheduled Accuracy Tuning

Check to turn on periodic scheduled acoustic model tuning for all users. 

Clear this checkbox if you want to disable Accuracy Tuning for the User Profile. The setting is enabled by
default.

Configure 

Click Configure to to open the Select Frequency, Data Collection tab and set the Data Collection schedule.
You are immediately asked to log in with your Windows Administrator password to make a schedule change.
After you log in, you can set one schedule for Acoustic model tuning and another for Language Model tuning
by clicking the appropriate tab and choosing Daily, Weekly, or Monthly and the start date and time.

Data Collection

Enable Scheduled Data Collection—Check to allow Nuance to collect up to 500 MB of acoustic data and text
from your dictation sessions. Once the data is collected, you have the option of sending it to Nuance to help



improve the accuracy of future versions of Dragon Professional. No personal information is ever sent to Nuance
and participation is voluntary.

■ Click Configure to set the schedule for data collection. You are immediately asked to log in with your Win-
dows Administrator password to make a schedule change. After you log in, you can choose Daily, Weekly
, or Monthly and the start date and time.

Let the user choose when to run Accuracy Tuning and Data Collection—Check to give users access to
this tab, effectively allowing them to change the schedules for Accuracy Tuning and Data Collection.

Restore Defaults

Click this button to restore the default values for Data Collection and Periodic Optimization.

Notes:

■ When the User Profile is closed, you cannot use Dragon to dictate or to perform actions by voice.

■ Scheduled Accuracy Tuning and Data Collection cannot run if Dragon is open, including if Dragon is running in
QuickStart mode, if Dragon is left open with no User Profile loaded, or if Dragon is left open by another user
in a separate Windows session on the same computer.

■ Since Dragon uses a local system account to schedule periodic tasks, User Profiles placed on network shares
will not be available for scheduled Accuracy Tuning and Data Collection unless special arrangements are
made with the network administrator.

For more information, see the following topics in the Dragon Help:

■ "About the Acoustic and Language Model Optimizer" for information about Accuracy Tuning.

■ "About Data Collection" for more information about Data Collection.

■ The "Options dialog box Data tab" for more information on scheduling Scheduled Accuracy Tuning and Data
Collection for the current Dragon User Profile.

Glossary

.DRA files (definition)

Dragon Recorded Audio (DRA) files. By default, Dragon automatically saves audio and text transcripts of your
dictation in the DRA files.

Accuracy Center (definition)

Offers a central location for tools and information you can use to ensure recognition. The link in the description
of each feature opens a topic describing that feature more completely. Say “display Accuracy Center” or click
Accuracy Center on the DragonBar Tools menu.

Accuracy Tuning (definition)

A process Dragon can use to adapt to your usage. Once you have been dictating for a period of time, Dragon
uses Accuracy Tuning to automatically refine your User Profile, analyzing your dictation, corrections, and any
other acoustic training you have done. Accuracy Tuning uses two of Dragon's accuracy tools, the Acoustic Opti-
mizer and the Language Model Optimizer.



Acoustic Optimizer (definition)

Looks for any corrections you have made or additional training you may have performed. Optimization
enhances recognition accuracy and helps predict words most likely spoken in a given context by a speaker (the
language model).

Advanced Scripting (definition)

Supports using programming languages such as Microsoft® VBA to create commands that can perform virtually
any function on the computer with voice commands.

Commands-only Vocabulary (definition)

A restricted Vocabulary containing only words and phrases that Dragon recognizes as commands. Choose this
way of dictation if you want to use Dragon only for command and control of programs and not for dictation.

Command Browser (definition)

A window showing voice commands that Dragon recognizes, including commands that are provided with the soft-
ware as well as any commands that you or your system administrator might have added (custom commands).
The Command Browser is the most comprehensive place to see the commands that are available in each appli-
cation.

Correction menu (definition)

Shows Dragon’s best guess for alternatives to words you dictated and selected. Choose the correct word from
the Correction menu by saying “Choose” and the number next to your choice.

Command Mode (definition)

A restricted recognition mode that causes Dragon to interpret everything you say as a command and nothing is
interpreted as dictated text. Say "Start Command Mode" or "Command Mode On."

Correction-only mode (definition)

Enables transcriptionists to play back a Dragon user's dictation without having their User Profile loaded. Note
that dictation is disabled if you select this option.

Data Distribution Tool (definition)

Enables developers to interactively create new words, customized Vocabularies or commands, and to make
them available to all User Profiles on a particular Dragon NaturallySpeaking installation.

Dictation Box (definition)

Provides full support for dictating and editing text in non-standard windows. The DictationIBox supports voice
commands like Delete, Correct, and Insert, and custom commands as well. When you are finished, the content
is transferred to the non-standard window where your cursor was positioned when you opened the Dictation
Box. The Dictation Box can operate in Hidden Mode (Medical, only), and can be anchored or unanchored.

Dictation Mode (definition)

A restricted recognition mode that causes Dragon to interpret everything you say as dictation and nothing is
interpreted as a command. Dictation Mode can be helpful if you want to dictate as quickly as possible, or dictate
without looking at the words Dragon transcribes. Say "Start Dictation Mode" or "Dictation Mode On".



Dictation Source (definition)

An audio input device or multiple devices associated with a User Profile. A user can select a headset microphone
at one computer, an array microphone at another, and a portable recorder for transcription at several com-
puters. This way, Dragon supports users who need to move, or “roam”, from computer to computer regardless
of the microphone type or differences in ambient noise.

DragonPad (definition)

Dragon’s built-in word processor, optimized for dictation and includes basic text formatting features as well as
the ability to save and print documents.

Hidden Mode (definition)

A recognition mode that causes Dragon to send all recognized text to the Dictation Box, which is active but does
not display. All recognized text is added to the Dictation Box, regardless of the cursor location. Hidden Mode is
often used by healthcare providers who are dictating medical reports to be sent to a medical tran-
scriptionist/editor. Say "Start Hidden Mode" or "Start Hidden Mode".

Language Model optimization (definition)

Updates the language model of the current Vocabulary. Language Model Optimization uses text Dragon extracts
from the .DRA files that are created when you correct words. Based on the speech data collected, Language
Model Optimization applies modifications to the language model to reflect your word usage.

Language Model Optimizer (definition)

Performs Language Model Optimization from the Accuracy Center. Any Dragon user with administrator priv-
ileges can schedule Dragon to perform optimization periodically.

Normal Mode (definition)

Dragon's default mode of dictation. In Normal Mode, Dragon distinguishes dictation from words, numbers, and
commands by analyzing what you say between pauses. Say "Start Normal Mode" or "Normal Mode On".

Numbers mode (definition)

A restricted recognition mode that causes Dragon to recognize only numbers, commands, and punctuation. If
you are dictating only numbers (including currencies), working in this mode increases recognition accuracy. Say
"Start Numbers Mode" or "Numbers Mode On".

QuickStart (definition)

Allows Dragon to load in the background when you start your computer or log in to your operating system,
depending on your version of Windows. When Dragon is launched in QuickStart mode, Dragon is available for
use more quickly than when you start in normal mode. The microphone icon appears in the system tray.

Recognition Modes (definition)

By default, Dragon functions in Normal Mode, distinguishing dictation from words, numbers, and commands,
and analyzing what it hears between pauses. Dragon also offers restricted recognition modes for dictating only
commands (Command Mode), numbers (Numbers Mode), characters (Spell Mode), or words (Dictation Mode).
You can also use Hidden Mode to have Dragon hide the DictationBox as you dictate into it.



Roaming User (definition)

Enables you to dictate with Dragon from different network locations and on different machines without having to
create and train individual User Profiles at each location. User Profiles are stored in a network location available
to all computers on the network, so that the information Dragon learns from a user dictating on one machine is
also available to the same user when they log in on other machines.

Spell Mode (definition)

A restricted recognition mode that causes Dragon to recognize only letters, numbers, commands, and punc-
tuation. Spell mode is useful for dictating unpronounceable alphanumeric strings, such as part numbers and
license plate numbers, and other terms you anticipate Dragon won’t know, such as Web addresses, words in a
foreign language, or unusual product names. Say "Start Spell Mode" or "Spell Mode On." You can still use com-
mands while in Spell Mode.

User Profile (definition)

A set of files created the first time you use Dragon, which is subsequently used to reflect your characteristics
and adapt to your usage. Each person who uses Dragon must have a User Profile, which the software stores in a
set of files containing, among other things, acoustic and lexical data. These data contain information about how
you sound, and the words you use, and how often you use them. When you add a word to your Dragon Vocab-
ulary, correct a misrecognition, read a training text, or change a setting in the Options dialog, Dragon can save
these refinements in your User Profile. If your edition of Dragon supports custom commands, these are also
saved in the User Profile.
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